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About This Manual
Chapters in this manual fit into three categories:

1. Concepts
2. Controls
3. Step-by-Step Guides

Concepts explain how things work in Embird Studio, the principes of digitizing and building an embroidery design.

Controls describe the tools based on above concepts and where to find them.

Guides provide detailed step-by-step procedures to create and/or edit various embroidery designs or their parts,
according to above concepts and with use of above controls.

Order of chapters is chosen so that you can create your first simple embroidery design as soon as possible and then add
other pieces of knowledge to master everything else that Studio provides to the user. Chapters are organized into 3
levels with increasing detail and complexity degree.

About Studio NEXT
Studio NEXT is an additional plug-in for Embird embroidery software. It allows user to digitize her/his own, custom
designs for machine embroidery.

Studio contains two parts: Digitizing Tools and Sfumato Stitch . Both Sfumato and Digitizing Tools parts are optional,
which means that it is not necessary to purchase them both.

1. Digitizing Tools
Digitizing Tools serve to digitize fancy embroidery designs, lettering and company logos. Design is digitized so that
user creates outline (vector) objects either on a blank background or on an image used as a template. Vector objects
are then filled with stitches. Vector objects are created manually node-by-node, with free-hand or trace tool, or
imported from vector graphic files (SVG format). All these approaches can be combined one with another.



Use Digitizing Tools to digitize fancy designs, lettering and company logos like above example

2. Sfumato Stitch
Sfumato Stitch allows user to create photo-realistic designs from digital images. It can be combined with Digitizing Tools
to add lettering, borders, etc. Sfumato uses similar vector objects like the Digitizing Tools, but they are filled with different
type of stitches. Sfumato stitches form meanders with various density to approximate the underlying picture while leaving
the fabric show through.

Use Sfumato Stitch to digitize photo-realistic designs from photos
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What is New?

Studio NEXT



Build 2.5, 4 April 2024

New category of Mesh plant fill - Curly Plant fills with flowers, leaves, symmetry and mirror options. It can be used
as fill or as generator of ornaments and monograms.

Tutorial Curly Plant Mesh - Essential Guide
Tutorial Curly Plant Mesh - Advanced Techniques
Single-layer option added to many existing mesh fills. Unlike current mesh fills which use two or more layers of
stitching, the new single-layer fills use just one run of thread and connecting stitches are placed on edges of the
object. Single-layer mesh fill can be used as is (single stitching), or it can be converted to outlines and then any
outline style can be applied, for example satin stitch, tripple bean stitch, etc.
Added new type of mesh fill called FSL Grid (Free Standing Lace Grid) . It allows both single-layer and multi-
layer stitching. It is located in Net category of Mesh tool.

Single-layer option added to existing Fractal mesh fills (Net category of Mesh tool).



Single-layer option added to existing Shapes mesh fills (Net category of Mesh tool).
Single-layer option added to some of existing Blackwork mesh fills (Tiles category of Mesh tool). About 40 % of
current Blackwork samples allow single layer stitching

Single-layer option added to existing Maze mesh fills (Stippling category of Mesh tool).
Single-layer option added to existing Necklace mesh fills (Stippling category of Mesh tool). This options is not
available for Font and Glyph necklace fills.
Enhancement to stitching of all mesh categories
New mode of Outline tool - Overlock . Allows to create overlock-like borders, even with corners. Adjustable
overlock parameters provide many visual combinations. Overlock can be split into individual segments (main menu
> Convert) if needed.



New flower samples added to Mesh tool, Plant fills
New samples added to Mesh tool, Tiles > Blackwork
New feature introduced to mesh fills - origin point . Origin point is now used as a starting point for some mesh fills
like plant and radial maze. Before introducing the origin point, the effect focus point was used both as a fill starting
point and as center for effects. This functionality is now divided between origin point and effect focus point.
New individual underlay controls for solid objects like Fill (plain and autocolumn mode), Column, Column with
Pattern, Applique, Outline (satin, border, applique mode). These new controls allow individual overriding of overall
(global) underlay settings like min. stitch, max. stitch and offset for given object.
New command for conversion of mesh objects into outlines: main menu > Convert > Fill, Mesh & Sfumato >
Create Separate Outline Elements from Mesh . This command converts mesh into outline elements that have no
backward paths and are not arranged into continous sequence. This command is intended for those who need to
do deeper editing of generated mesh fill.
New command for conversion of outline objects into carvings: main menu > Convert > Outline > Outline to
Carving
Sfumato Stitch: Pick Color mode and Shade Preview mode now available also from Parameters window (not just
while editing nodes).
Faster GUI (graphic user interface)
Thread catalog window - threads can be sorted by clicking the columns header
New shortcut Ctrl+Shift+K for picking color for selected object(s) from thread catalog
Help window - option to merge all pages from index into a single file for conversion into the PDF file . Select Index
page from tab at the left side of Help window (if it is displayed) and tap Merge All button at the bottom of this tab.
Merge All option is not available if there is only a single page in the index, i.e. index is not even displayed. When
merged file is created, use Print command of Windows File Explorer to print/convert file into PDF.
Mesh tool - separate options to include outer contours and inner contours (for holes) into stitching. These
settings have no effect for new single-layer fills.
Enhancement to selection of outline objects in the work area with mouse click
Pop-up windows can be closed with key on keyboard now. Esc is for Cancel, Enter is for Ok, Done or Apply
Fix to splitting applique objects into layers
Fix to creating holes in mesh objects
Fix to Alphabets lettering, plain fill of small letters
Fix to installation of color catalogs

Build 2.4, 18 Januray 2024

Faster GUI (graphic user interface)
Enhancement to Open/Save dialog windows - file or folder path can be pasted from clipboard into edit box and
program browses the file or folder
Enhancement to Open/Save dialog windows - button to clear the file name edit box
Fix to picking colors from thread catalog
Fix to storing actual set of object parameters as default
Fix to displaying user samples and user motifs preview in combo box
Fix to slicing mesh objects with guide lines

Build 2.3, 14 December 2023

New effects for mesh
New snowflake blackwork mesh samples
Faster preview of blackwork samples in the combo box drop-down panel



Progress window for long stitch compilation with option to cancel the compilation
Fix to merging designs
Fix to import of shapes from library
Fix to opening dialog windows

Build 2.2, 4 December 2023

New features in open/save dialog windows: share file(s), add folder to archive (zip), share archive, favourite
folders, select/deselect files on extension, file list modes: simple and detailed
New Search feature added to manual (main menu > Help > User Guide)
New Print feature added to manual (main menu > Help > User Guide)
New option Snap to Grid added to custom motif editor
New option Flip Vertically added to custom motif editor
New Lace motifs
New Blackwork Mesh fills
Fix to saving designs containing satin outlines in old file format for regular Studio
Fix to moving contraint line in custom motif editor at close zoom

Build 2.1, 4 October 2023

Faster GUI (graphic user interface)
Several new fractal and Blackwork Mesh fills
Larger range of lettering size for Font Engine and Alphabets
Fix to rendering font samples and glyphs tables in Settings / Lettering Preferences
Fix to font archive folders browsing
Fix to Parameters window: storing mesh parameters as default
Fix to very small controls on large displays
Fix to Paste command
Fix to misplaced carving lines in Sfumato designs
Fix to occasional screen flickering in sew simulator mode

Build 2.0, 8 August 2023

Several new mesh fills in Net / Fractal category and Tiles / Blackwork category
Smoothed #1 and #2 mesh fills in Tiles / Blackwork category
Fix to typing numeric value of parameters into text box
Fix to envelope tool applied to straight line edges
Sfumato Stitch: fix to losing additional shade parameters when saving and opening files
Sfumato Stitch: harmonized density icons
Sfumato Stitch: faster stitches generation for objects with highest density style
Fix to stitches generation for large plain Fill objects
Enlarged range for short stitches length on Mesh objects
Fix to displaying Sew Simulator gauge
Lettering mode: added buttons to clear font folder names
Lettering mode: edited pre-defined font size values on shortcut buttons
Fix to functionality of Cancel button in Parameters window
Fix to loading older .eof files with tiff background image into 64-bit Studio Next

Build 1.9, 18 July 2023

Multiple enhancements and some fixes to import of SVG files
Fix to scanning and usage of uninstalled fonts in folders and archives
Faster rendering of work area
Fix to typing space character into text boxes while in node-editing mode
Shortcut keys for zooming and scrolling work area now work also in node editing, lettering, envelope and other
modes
Fix to hairline alphabet lettering not showing in the work area during the text creation/editing
Fix to rendering hidden objects in 3D, Flat, Density Map and X-ray display mode

Build 1.8, 9 May 2023

Faster start of Studio Next (does not apply to the first start)



Autorepeat feature added to zoom-in and zoom-out buttons for faster and more comfortable zooming with buttons
(intended mainly for touch screens). Press and hold zoom-in or zoom-out button for continous zooming. These
buttons are located in the vertical button panel which serves also as a work space splitter.
Autorepeat feature added to scroll bars for faster and more comfortable scrolling.
Fix to labyrinth mesh fill
Larger range of scrolling in work area to allow more comfortable zooming and editing near edges of the work space
Semitransparent sub-grid in work area
New mesh effect - saw

New mesh tile blackwork sample - horizontal lines. This simple linear sample #47 is supposed to be used in
combination with ripple, swirl or other offect.

Fix to zoomig in and out with + and - keys on num pad
More vivid highlight colors for selected inspector items and button switches
Removed captions in move/scale and rotate/skew modes
Enlarged range for minimum stitch length of mesh objects
Fixed issue in open/save dialog windows with file name edit box overflowing the screen edge when file path is long
Save As dialog window now offers name of recently open design as default file name
Fixed issue with use of predefined styles to autocolumn objects
More predefined color boxes in color dialog window
Fix to applying rotation angle to Mesh fill
Warning panel appearing when trying to save new Mesh objects in old file format for regular Studio, which is not
supporting them. Saving these Mesh objects as plain fills instead.
Font Engine lettering: fix to flattening of composite glyphs with a hole (like o,O,8, etc.)
Edit text - fix to editing text saved to design eof file and then loaded back
Fix to freezing in lettering mode

Build 1.7, 21 Apr 2023

Fixed open/save dialog windows freezing when applying mouse scroll wheel on dropped-down menu panels
Fixed font selection for Mesh objects not working
Fixed missing icon in Delete Folder confirmation window

Build 1.6, 18 Apr 2023

New object type - Mesh - for stippling, blackwork, crosses, celtic knots and other loose fills that leave fabric
showing through stitches.

New Mesh fill available for lettering, both predefined Alphabets and common system fonts. Lettering must be large
enough.



Designs created in Studio Next are more advanced than designs from regular Studio. Therefore, new *.eof design
files cannot be opened in regular Studio. If you need to move design from Studio Next to regular Studio, use main
menu in Studio Next > Design and select Save in Regular Studio compatible format .
Commands to convert objects to and from Mesh type.
Buttons and menu items in Sew Simulator mode to show/hide hoop, grid and guidelines.
Dynamic vertical scrolling of scroll box content with mouse wheel.
Window for setting column width when converting outlines to columns.
Buttons in lettering mode to clear whole text or to insert pre-defined set of glyphs. These buttons are located on the
tab with text box.
Option in lettering mode to flatten composite glyphs. This option allows to correctly process rare TrueType and
OpenType fonts made from piled-up blocks instead of common contours.

Several new overlock stitches (samples) added to outline tool. They allow to create patch edges.

Access to color dialog in palette via long tap instead of right mouse button click
Freehand and Trace tools indicate last selected option on their button icon
More zoom levels for work area - smoother zooming
Switch that allows to change handling of overlong stitches. This switch is available in Parameters window in the
Overall parameters panel. Available options are: 1. overlong stitches are replaced with series of floating stitches, 2.
needle points are inserted into overlong stitches.
Increased speed of auto-outliner tool
7 new hoops added:

Janome SQ10d Hoop for Janome Continental M17 100 x 100 mm
Janome SQ28d Hoop for Janome Continental M17 280 x 280 mm
Janome ASQ27d Hoop for Janome Continental M17 270 x 270 mm
Janome RE46d Hoop for Janome Continental M17 280 x 460 mm
Bernina Bernette L 160 x 260 mm
Bernina Bernette M 120 x 180 mm
Bernina Bernette S 50 x 70 mm

New option in Custom Samples editor - Snap to Grid
New option in Custom Samples editor - Flip Vertically
New option in lettering mode - Outline kind. Allows to choose between single-pass and double-pass outline. Single-
pass outline can be used with samples, borders and other fancy stitch types
New option in lettering mode - Parameters button. Allows to launch window with fill and outline parameters for
lettering
Fix to zooming with selection box
Fix to dragging multiple items in Object Inspector
Fix to plain and motif fill ocassionally not covering the whole object
Faster rendering of Studio design icons in Open/Save dialog windows
Faster rendering of Studio user interface



Faster loading of design files with background image
New stitching mode for columns - multilayer. Allows to create thick, raised columns
New icons in Object Inspector list to distinguish between regular column, strips and multilayer column
New option for columns with pattern - pattern adaptivity, which means stretching pattern to fit the width of the
column. This helps to create lace-like columns.

More responsive text editing when renaming folders
Smoother autorepeat (spin editing) for parameter value controls
Fix to 'Save Selected As' command
Fix to zooming-in and zooming-out screen painting during the sew simulation process
Fix to continuity of cyclic columns with pattern
Fix to 'Edit Text' command when loading .eof file from regular Studio
Fix to repeated 'Save Border' and 'Save Border As' command
Fix to repeated editing of object with user motif fill
Fix to occasional wrong connection between letters when using predigitized alphabets
Fix to tie_up stitches on lettering outlines
Smoother move and rotation of lettering in text editing/creation mode
Vector objects are displayed with semi-transparent color inside until the stitches are generated.
Filled lettering in text editing/creation mode for better lettering visibility
Image color reduction tool: access to color mixer changed from double click to long click (long tap)

Build 1.5, 2 Mar 2022

Folders table in open/save/import/export dialog windows for faster folder browsing
Import of SVG files in real size (if provided in the file)
Enhancement to compatibility with SVG files
Fix to Font Engine leaving some letters empty
New pop-up menu in 'Parameters Window' to allow storage of current parameters as a new default parameters or
to hold them for newly created objects
Enhanced rendering of text (captions, labels) on controls
Fix to drawing icons of border files in open/save dialog windows
Update to Help files
Fix to issue with selecting default font or alphabet in 'Settings > Lettering Preferences' window
Fix to loosing changed parameter values when switching between sections in 'Parameters Window'
Faster rendering of dialog and settings windows
Supressed flicker when resizing panels with splitter
Fix to carvings following the fill with autocolumn mode
Enhacement to rendering of control borders during resizing

Build 1.4, 4 Feb 2022

Multiple enhancements to Font Engine. Enhanced stitching of serifs, complex letters, etc.
Multiple enhancements to Auto Column
Multiple enhancements to import and stitching of SVG files
Icons and previews of SVG files in 'Import' and 'Export' dialogs windows
New tool for reduction of color number in template raster image for easier digitizing of complex designs. This tool is
accessible via main menu > Image > Tools > Reduce Colors.
New tool for posterization of template raster image for easier digitizing of complex designs. This tool is accessible
via main menu > Image > Tools > Posterize.
Fix to blurry or enlarged rendering when using enlargement in Windows 'Ease of Access' settings
Enhanced color contrast and text readability of drop-down panels in 'Parameters' windows
Fix to Envelope function
Transformations Window: controls to switch between transform, align and distribute mode moved to vertical tool
box
Update to help files



Button for access to respective help chapter in 'Parameters' window
Partial translation into multiple languages. Full translation not finished yet.
Options to export and import translation files in .csv format editable in MS Excel or other spreadsheet program
Switching between inches and millimeters (imperial / metric unit system)
Illustrations explaining meaning of settings added to main 'Parameters' panel
Slightly faster rendering of whole graphic user interface
Fix to aligning controls in panels
Dismissing dialog windows with 'Escape' key
Confirming dialog windows with 'Enter' key
Fix to creating new subfolder in 'Open' and 'Save' dialog windows
Faster compilation of lettering
Fix to program freezing when closing dialog windows
Fix to occasional freezing when opening file
Fix to conversion of objects into other type of objects
Fix to rendering holes in object icons
Fix to shortcut keys '3' and '4' for placing start points of column-like objects
Fix to shortcut key 'x', which acts like a secondary mouse button to invoke pop-up menus in work area, color
palette and object inspector list
Reduced size of 'Parameters' window to allow design in the work area to be visible

Build 1.3, 13 Dec 2021

Fix to stability of 'Settings' and 'Parameters' windows
Fix to enabling/disabling groups of controls
Fix to rendering of group boxes
'Enter' and 'Space' shortcut keys enabled to finish editing of object

Build 1.2, 7 Dec 2021

Centering design in hoop when sending it to Embird Editor
Fix to occasional freezing at start
Fix to rendering of very short stitches in 3D
Fix to generating stitches when sending design to Embird Editor
Splash screen at start

Build 1.1, 6 Dec 2021

Fix to leaving connections behind when moving design to center of the hoop
Color scheme switched to grey
New main menu item in creation/editing mode - Edge. Change to menu items layout in this mode.
Fix to export of design into .SVG file format
Fix to outline parameters reverting to default values when re-opening the parameters window
Added missing implementation of TAB key function in node editing mode.
Button for fast access to the Parameters window added to vertical splitter panel.
Enabled double click action on icons in Object Inspector for fast access to show/hide objects, generate stitches,
launch Parameters window and launch Color Mixer window. These actions were enabled only for regular Inspector
mode (i.e. mode without check boxes), now they are enabled also for the tap mode (mode with check boxes).
Enhancement of the 'Reduce Node Number' function
Thread catalogs updated from main Embird program
Faster start of Studio
Faster GUI
Update to User Guide (Help files)
Erasing of pixels in 'User Pattern Editor' moved from secondary mouse button to Ctrl keyboard button. Secondary
mouse button is now used to pan the work area.
Fix to rendering of group boxes
Fix to rendering of 'User Pattern Editor'
Fix to numpad '+' and '-' key functionality for zoom-in and zoom-out
Fix to Alt + arrow keys to moved selected objects
Fix to Shift + arrow keys to scroll Work Area
Help files are now accessible also from 'Fragment Editors' window.

Build 1.0, 17 Nov 2021

First official release of Studio NEXT generation



Our NEXT generation technology brings a leap in a graphical user interface design, a full multi-core CPU support and
readiness for future multi-platform deployment. New graphical user interface was made so that it adapts smoothly to any
common screen resolution and provides large enough and legible text and icons.

Besides release for Windows, Embird and its plug-ins will be gradually released also for Android, Mac OS and iOS, using
the same look and feel on all platforms.

Studio NEXT may look to users of previous versions as a totally different program, but in fact it is not. Studio NEXT has
almost all functions of the previous version, but many of them have been renamed or moved to other menus or panels
for the sake of clarity, controls accessibility on small and large screens and compatibility with operating systems which
are going to be supported by future releases of Studio NEXT.

Features of NEXT Generation Technology

Adaptive optimum GUI rendering for wide range of screen resolutions
Full support for multi-core CPUs, faster applications
Touch screen support
Enhanced readability of text
Readiness for multi-platform deployment to Mac OS X, iOS, Android (already under the development)

Studio NEXT - Enhancements

Faster than previous Studio versions. Speed depends on number of CPU cores, more cores means higher speed
X-Ray mode in Sew Simulator
Enhanced 3D mode
Long and short stitches indication in X-Ray mode
Export of designs, raster images, stitches and stitch animations to SVG (Scalable Vector Graphics)
.EOF design files backward compatible with Embird Studio 2021 and older
User interface adjusted for single mouse button or finger tap control
Adjustable size of key controls
Support of OneDrive cloud in open and save dialog windows
Highlighted contours of stitches and objects when zoomed-in
Adjustable colors of selection box, nodes, highlights, text baseline, text spider controls etc.
HTML5 compliant help files with adjustable text size

Studio NEXT - Discontinued Functionality

Few features have been discontinued in Studio NEXT, mostly because of lack of their support in operating systems
where deployment of Studio is planned.

Scanner support
CMX, EMF and WMF files import - replaced by SVG files support

(C) BALARAD, s.r.o.
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Get Started

What is Embroidery Digitizing?
Stitch Files - Embroidery Designs

Computerized embroidery machines use special input files that instruct them how to sew out the embroidery on a fabric.
These input files are digital stitch files, called embroidery designs . Stitch file is basically a list of stitch positions, colors
and trims. Process of creating of such a stitch file is called embroidery digitizing . Designs may be created from a
photo, artwork, lettering or just from imagination.

Digitizing Application



Of course, a software application is required to do machine embroidery digitizing. Such application does most of the
labour to produce all individual stitches. User's work is to define objects and let program to fill them with chosen stitch
styles. While the end product of digitizing is always of the same kind - the stitch file, the digitizing process itself and its
resources may vary. There are various digitizing applications that allow specific kind of embroidery digitizing.

Left: outline of object made with few nodes and curves. Right: stitches generated to fill the object

Drawing of Objects - Manual or Automatic Vectorization

When digitizing a design, you may draw individual stitches if you wish, but most often you draw outlines of objects that
are filled with stitches by program, or auto-trace objects from raster pictures with magic wand tool and use automatic
digitizing. Drawing or tracing the outlines of objects is called vectorization. If you have a ready-made vector file
from other source, a graphic program for example, you can convert it into embroidery design with use of automatic
digitizing and skip the manual vectorization.

Compilation to Stitches

Composing embroidery design from objects has an intermediate product - a source file that contains vector outlines of
objects which are later filled with stitches and saved into appropriate stich file format for respective embroidery machine.
In Embird we call this process compilation . Intermediate source file is not a final product, but it should be kept for
eventual future editing of the design. Vector files are scalable, which means that compilation of design from vector file
adjusts stitch count and layout to fit chosen size dimensions of design.

From raster image through vectorized outlines to stitches. Source file stores them in layers
stacked one upon another.

Embird provides several digitizing applications:

1. Digitizing Tools for digitizing logos and fancy designs. Input (optional) is photo or artwork
2. Sfumato Stitch for photo-like designs, portraits, landscapes, etc. Input (required) is photo
3. Cross Stitch for cross stitch designs. Input (optional) is photo or artwork
4. Embird Basic provides additional options for digitizing fills and outlines of empty areas around design
5. Font Engine converts computer TrueType and OpenType fonts into emroidery lettering. It also converts other

graphic vector files like SVG files into embroidery designs

Digitizing Tools and Sfumato Stitch share the same application called Studio.



Basic Concept - Vector Objects
While basic Embird program works mostly with stitch files , Studio uses vector objects for easier creation of design.
Therefore, Studio uses other tools than the basic Embird program. Stitch files are the end product of embroidery
software, because stitch files are used by embroidery machines as a list of commands to produce embroidery. Stitch files
contain coordinates of each stitch and some color and trim commands. However, creation of design with stitch-by-stitch
method would be very tedious and time consuming process.

Fortunately, most objects in design can be filled with more or less uniform type of stitches. It is sufficient to draw vector
outlines of the object and fill it with stitches in a similar way as you fill object with color in a graphic program. Tools
available in Studio are very similar to those used in vector graphic programs.

Vector outline drawn with few control points (left) filled with stitches (right).

There is a big difference between embroidery design and vector graphic, however. This difference is that order of objects
and their overlapping is much more important in embroidery than in graphics. Moreover, objects in embroidery design
should be connected one to another so that there is as low number of trims as possible.

Vector files created in Studio are kind of "source files". When compiled and send to basic Embird, they produce stitch
files ready for saving in appropriate file format compatible with your embroidery machine.

Vector objects can be easily resized, because stitches are re-generated automatically to conform to the new size.

Designs (patterns) are digitized in Studio as outline (vector) objects with stitches layout based on the object type and
parameters. The finished design is compiled and put into Embird Editor for final adjustment and save in appropriate

embroidery format. Compilation involves generation of stitches for all vector objects, including those that were not filled
with stitches by user.



General Rules

To make embroidery design that looks good and sews out smoothly, follow these general rules:

Create objects so that jumps occur only where you want to have them. Remember to use connections to connect
objects with running stitch paths.
The order of objects in an embroidery design is very important to minimize number of jumps and color changes.
Good designs have as few color changes and trims as possible.
When making design composed of several neighboring areas, it is useful to make zig-zag underlay under whole
design first, to stabilize the fabric. Use Fill object without cover stitches for this purpose.
Thread tension always causes the real stitches to be a little bit shorter than how they look on the screen. Use pull
compensation to prolong the stitches. Design for elastic fabric needs more pull compensation.
When doing complex design, digitize it from center out if possible, to prevent fabric puckering.
Edge underlay for broad objects and center-walk underlay for thin objects helps to avoid edge distortion on elastic
fabric. Zig-Zag underlay adds 3D effect. Underlay should be used only for objects that are large enough to hide the
underlay stitches.
Neighboring areas should overlap one another slightly to prevent gaps caused by pull effect of thread.

Specific Rules

There are also some rules specific for the Embird Studio:

Do all resizing of designs digitized in Studio directly in Studio, not in Embird Editor. While in Studio, design is in
outline format that resizes with much higher quality than stitch files in Editor.
Studio allows to put imageinto background of work area and digitize objects on it. If you do not scale image
to fit into hoop, Studio handles images so that 100 pixels corresponds to 1 centimeter of design size (254 pixels
corresponds to 1 inch). It is useful to make an empty border around your image, so that you will not have to work
near the edge of image.

Basic Tutorials (recommended order)
To get started, please read the tutorials included in this help file. They are accessible from the left panel of this window.
Tutorials are sorted in a recommended order of reading. Also, this help file contains other chapters like description of a
main menu items and object parameters. Please refer to the index at the left side of this window for a specific topic.



Understanding the stitch files and vector files
Embird works with embroidery designs stored in two types of files: 1. stitch files, which can be loaded to embroidery
machine but they are hard to edit and scale, 2. outline files, which are easy to edit and scale but they cannot be loaded
directly into embroidery machine.

Difference between stitch and outline files can be compared to difference between raster (pixel) pictures, which cannot
be enlarged very much because of decreasing quality, and vector graphic, which can be easily resized and edited.

Outline files are used to create and edit design. Then these outline files are converted (compiled) into stitch files for use
with embroidery machine. There are many stitch file formats (with various file extensions) supported by Embird, because
many embroidery machines use their own, native stitch file format. Basic Embird works mostly with the stitch files.
Outline files are created and edited mostly in Embird Studio. These files have *.eof extension.

1. Stitch files contain list of individual stitches and optional commands like trims and color changes. These files are
actual input data for all embroidery machines. However, designs in such format are hard to edit and resize, because only
individual stitches are available and there is no information about what objects they form. If such design is displayed on a
screen, the human brain easily identifies the parts of design like outlines, fills, etc. However, it is not so easy to identify
these objects automatically with use of software program. Therefore, many editing functions and resizing may not work
with 100% reliability on stitch files. Although the stitch file is the end product of embroidery software, designs are not
created directly in this format.

2. Outline files are easy to edit and resize, because design in this format contains outlines of all objects with information
for the software program how to generate stitches for each object. Design in this format does not necessarily contain
stitches. The most important part are the outlines and parameters for filling the objects with stitches.

Understanding the thread flow
Embroidery designs should be created so that number of thread trims is minimal. To achieve this when working with
vector objects, user must keep 3 basic rules on her/his mind:

1. Create objects in proper order (to allow their connection).
2. Add connections between objects whenever possible (where they are hidden under other objects or where they do

not spoil the look of design).
3. Define start and end points of objects properly (to allow continuous flow of the thread).

There are 2 objects in above example. The first one (left) is column. The second one (right) is plain fill object. They are
connected by connection, which is in fact an object too, and must be inserted between the column and the fill.

Column has start point A. Each column ends on the opposite side, which is point B, in this case. To avoid thread trim,
connection was added from point B to C - the start point of the fill. End point of the plain fill can be defined anywhere on
the fill boundary, even in hole (if the fill has any). It is point D, in this case.

When stitches are generated for above objects, thread fills continuously all objects. It starts in point 1. Then it fills whole
column with zig-zags and ends in point 2. Then it fills connection with series of running stitches (3) until it reaches point
4, which is start point of the plain fill objects. To cover complete area of the object, the thread must start filling in point 6,
in this case. Therefore, connection (5) is automatically generated from point 4 to 6. After filling the whole object, thread
stops in the end point 7.



Running and jump stitches
Running stitches are 'normal' stitches embroidered by machine. They form continuous series of stitches, usually 0.5 mm
~ 5 mm long. Some objects in design are separate and machine must move needle to a new position. To define such
move (without stitching), the jump 'stitch' is used.

The jump can be regarded as a very long and loose stitch. Although it is just move of the needle, we call it 'stitch',
because needle penetrates the fabric at the end of previous running stitch, i.e. at beginning of the jump, and at beginning
of the next running stitch, i.e. at the end of the jump. From this point of view, the jump is the same stitch like the 'normal'
stitches, but usually much longer. This fact is used for embroidering very broad satin stitches (see below).

Longest stitch
Most embroidery machines have 12.7 mm limit for longest possible running stitch. Some machines have even shorter
limit ~ 12.1 mm. It is possible to use satin stitches longer than this limit. Such stitches Embird codes as series of short
starting running stitch and single or multiple jump stitches. Please note that such stitches look queer on the screen,
because of the jump stitches in the middle (displayed with dashed line). However, stitches on the actual sew-out are all
right.

Embroidered design with long satin stitches (longer than 8~10 mm) may be easily damaged by washing because of the
loose stitches. We recommend to use pattern (texture), which splits long stitches into shorter ones.

Arrow (1) marks the normal running stitch, i.e. running stitch shorter than limit.

Longer stitches are automatically divided into short running stitch (green arrow (3)) and series of jump stitches (red arrow
(2)). When embroidered on a fabric, all stitches look the same. There are no needle points in the series of jump stitches.

Smallest needle step



The shortest possible move of needle on most embroidery machines is 0.1 mm in both axes. Stitches in stitch files are
coded with use of 0.1 mm grid. Therefore, if you open stitch file in Embird Editor and zoom-in the stitches sufficiently, you
will discover very small steps on edges which seemed to be smooth at a small zoom. These little steps are caused by
0.1 mm grid.

Stitch density
The stitch density in Embird is defined as distance between needle points in above mentioned 0.1 mm grid. Density 4.0
means four steps of 0.1 mm, i.e. 0.4 mm. The commonly used density of satin and fill stitches is approximately 3.0 - 4.0,
according to weight of thread used for actual embroidering. 0.1 mm step cannot be further divided into smaller steps.
Therefore, density 3.5 does not mean that distance of all needle point pairs is 0.35 mm. It means that some pairs have
0.3 mm distance and some pairs have 0.4 mm distance. The average distance is 0.35 mm.

Studio uses the same density definition as basic Embird, but the 0.1 mm grid affects only exported stitch files. Outline file
format allows to put stitches anywhere, not just to 0.1 mm grid. However, when you compile outline file into stitch file in
Embird Editor, above mentioned effects appear. It is not an error. This is the way how it is supposed to work.
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Vector Objects
Digitizing in Embird Studio means drawing of objects, which are filled with stitches according to parameters set
individually for each object. This approach was chosen because embroidery design usually contains areas of the same
type of stitches - plain fill (2) , satin stitches (3) , outline (1) , etc. Such areas can be digitized as a separate objects of
respective type and color. Program fills them with appropriate stitch type and user does not need to care about each
individual stitch.

Stitches order within object is controlled by program, with a single exception: object's beginning and end point, which are
defined by user. Stitching starts at beginning point and stops at the end point of the object. Definition of these points is
important for correct connection to previous and next object.



Objects are listed in Object Inspector list. They are listed in the actual sewing order from top
to bottom.

Objects have vector (curve or straight line) edges, which means that they can be resized without loss of quality. Edges
are defined by points called nodes. Straight line edge has two nodes - start and end node. Curves in Studio have three
nodes - start, middle and end point. Node in the middle of curve defines arch of the curve.



Straight line (left) is defined by 2 points. Curve (right) is defined by 3 points.

Object usually contains several line and/or curve elements.

Studio uses these types of objects:

Fill
Sfumato
Column
Column with Pattern
Connection
Manual Stitch
Outline
Applique

Each type has specific stitches layout (described below) and adjustable parameters like density, angle, etc. (see
Parameters chapter).

Object Types

Fill Object

The edge of a fill object is composed of lines and curves. Small rectangles are end points of lines and curves. Small
circles are middle points of curves. The cross at the top is beginning of the edge. Diagonal lines at the bottom indicates
the place of last fill stitch and angles of cover stitches (longest line) and zig-zag underlays (short and medium length
line). Small star inside the object is the 'Focus point' for effects like Circular fill. Focus point can be placed or moved in
the node editing mode with use of command from pop-up menu.

Studio automatically generates edge underlay and two zig-zag underlays as well as overlays and connections. Fill object
can contain openings. User can adjust various parameters of Fill object, including stitch density at beginning and end of
object and effects like the wave, contour or circular fill. Fill objects may be filled also with automatic column (satin)
stitches. Fill object may be followed with Carving object.



Fill object with opening (left) and carving lines (right). Single fill object can have multiple
openings and/or carvings

Plain fill (left) and automatic column fill (right)

Left: Plain fill with density gradient. Right: Fill with wave and gradient

Left: Fill with circular stitches and gradient. Right: Contour fill with gradient.

Direction of stitches in automatic column fill can be controlled to some degree with direction lines. Click here to find out
more.

Most common error message: "Compilation Failed. The sequence is probably not correct. Adjust sequence outlines."

Solutions:

1. Do not use too many nodes. The curves allow you to create smooth edges even with small number of nodes.
2. Make sure that all edge element are correctly drawn and that middle points of curves are placed correctly. No edge

element should cross other elements.

Sfumato Object

Sfumato objects are used for creation of photo-like embroidery designs. Sfumato object is drawn exactly like the Fill
object, but the stitches inside of object are generated in other way. Thread creates meanders of various size to



approximate the picture/photo under object.

Sfumato is an optional part of the Studio. It is included in the installation file of the Studio (no separate download
needed), but it must be purchased and registered separately.

Column Object

Satin stitch object is called column in the Studio. Column is composed of two edges. Each edge can have different
number of parts (lines and curves). Dashed line indicated the End of Segment inserted by user. Segments ends define
direction of stitches. Beginning and end of Column are automatically Segment Ends. Program generates small gap at
beginning and end of Column to prevent stitches bulging.

Too long cover stitches are replaced by jump stitches ended with short running stitch. Program generates center walk,
edge and zig-zag underlays and it also automatically shorts stitches in curved parts. Too sharp corners of Column object
are automatically replaced by roof, folded or split corner.



Column object may be followed with Carving object.

Most common error message: "Unable to compile so twisted object. Please insert some segment end into object or
adjust edges.

Solution:

1. Do not use too many nodes. The curves allow you to create smooth edges even with small number of nodes.
2. Make sure that two sides of column do not cross each other.
3. Use Segment Ends inside of column now and then to define direction of stitches. When making circle or rectangle

border with column object, there should be about 4 or more segments inside of column.

Column with Pattern Object

Column with Pattern is the same object as Column, but user can define also the pattern, according to which stitches are
split. User can define also her/his own patterns.

Both Column and Column with Pattern can be used with Envelope.

Column with Pattern object may be followed with Carving object.

Connection Object



Objects that do not touch each other are automatically connected by jump stitches, when compiling the finished design.
If you do not want jump stitch between objects, use Connection Object to make running stitches path between
objects.

Manual Stitches Object

Manual Stitches are composed of series of lines. Use them to produce fine details.

Outline Object

Outline is composed of one edge that may or may not be closed. User can use various stitch samples for the outline.
Typically, this object is used for running stitch outlines added on top of fill or column. Outline may be turned to sketch,
satin stitches, border or to applique and vice versa.



Various samples projected on outline object

Outline with Overlock mode can be used to create a patch edge, even with corners



Another example of outline with Overlock mode

Applique Object

Applique object is similar to Column object, but it must be closed. It serves for stitching down the piece of fabric instead
of filling the area with stitches. Applique Object automatically generates marking, tack-down and cover stitches. Tack-
down stitches have separate color in order to stop machine and allow user to cut off the fabric.

Applique can also have openings. Marking stitches, tack-down and cover stitches of main applique and its openings are
automatically arranged so that they sew all at once: all marking stitches first, all tack-down stitches next, and all cover
stitches at end.



Mesh Object

Mesh object is similar to Fill object, but it is stitched very loose to let the fabric show through. Mesh is suitable for
stippling and other low density ornamental fills.

Mesh object is drawn in the same way as the Fill object, including optional holes and carvings.

Mesh stitches form a continuous embelished path made of blackwork tiles, crosses, font glyphs, celtic knots, fractals,
etc.. The fill can be further modified with transformation (rotation, offset, slanting and perspective projection) and effect
(fish eye, black hole, ripple, swirl, etc.).

Small star inside the object is the 'Focus point' for effects like Fish Eye or Swirl. Focus point can be placed or moved in
the node editing mode with use of command from pop-up menu.

Examples of various mesh fills



Carvings

Carvings are paths that can be drawn immediately after some objects (just like holes). Their meaning differs according to
type of their parent object:

1. they serve as a stitch splitting path for Fill and Column objects, adding them texture
2. additional stitch path for Sfumato objects
3. additional stitch path or base from which fill grows for Mesh objects

The Carving Tool is located in the Tool Box panel.
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Node-by-Node Vectorization
Embroidery design in Studio consists of objects in a vector form. Studio allows to create vector objects manually node-
by-node, or semi-automatically with Freehand Tool, Trace Tool and import them from a vector graphic files. This
chapter deals with node-by-node manual digitizing (vectorization) of objects.

Object with 1 edge (Fill, Mesh, Sfumato, Outline, Connection)
The simpliest object in Studio contains just one edge, which is series of straight line or curve elements. Some object
types require "closed" edge, which means that its first point and its last point must have identical position. To create
object with one edge (like Outline, for example), follow these steps:

1. Click the Outline Tool button in the toolbox at the side of the screen. This will switch Studio into creation/editing
mode.

2. Click on the work area to place the first node of the object. The first node is marked by a hairline cross.



3. Click on the other place to create second node. Element connecting the 1st and 2nd node is straight, but is is a curve,
because it has middle node (small circle). Arrow indicates the orientation of nodes.

4. Add another two nodes. If you need to edit position of any node, select it by clicking on it and drag it to a new position
with primary mouse button depressed. All elements between nodes are straight. Now we will arch them to create smooth
curve.

5. Click on the middle (circular) node of the first element to select it. Hold primary mouse button depressed and move
node to a new position. This will make a curve from the straight line.

6. Select and move rest of the middle nodes one-by-one until the whole object is smooth.

7. Now you can click the secondary mouse button (or tap a pop-up button) to invoke the pop-up menu for finishing
object and/or generating stitches. We have created an Outline object, which does not need to be closed. Objects like Fill,
Opening or Sfumato must be closed. To close object, use Close Edges command from the pop-up menu.

The pop-up menu contains also commands for insertion/deleting of nodes, conversion of elements to straight lines or
curves and several other commands specific for created object. Most of these functions are also accessible with buttons
in the horizontal button bar the top of the screen.

Another functions are accessible via ∎ main menu>Nodes . These functions include options to snap nodes to grid
lines, guide lines, other nodes, work area edges and other object edges.

Object with 2 edges (Column, Column with Pattern, Applique)
Objects with 2 edges are filled with stitches running from one edge to the other at variable angle. This type of objects is
used for satin stitch and applique. To create object with 2 edges, follow these steps:



1. Click on the Column Tool button in the toolbox at the side of the screen. This will switch Studio into creation/editing
mode.

2. Click on the work area to place the first node of the object. The first node is marked by a hairline cross.

3. Click on another place to create a base of the column object. The base is displayed as a dashed line. Both edges will
start in this base and end in another base at the opposite end of the column. Basis are always straight lines and they
define angle of stitches at beginning and end of the column. Angle of stitches in between is interpolated from these two
basis.

4. Create a new node by clicking on the work area. This is the first element of the edge. Arrow indicates the orientation of
nodes.

5. Create several other nodes of the first edge.

6. Now select the node at the other side of the base. This is an important step, because program now knows that the
next nodes will be added to the second side.



7. Repeated clicking on the work area will create nodes belonging to the second edge.

8. Both edges are composed of the straight lines elements. Middle nodes of curves (which are straight now) are
displayed as a small circles.

9. Select and move middle nodes to make both edges smooth. Hold primary mouse button depressed and move node to
a new position. This method can be used for adjustment of any node position, not just the middle node. Thread will start
filling the column on a place where the first node (with cross) is located. The sewing will end at the last node on the
second side. If you need to change sides of the column, use ∎ main menu>Edge>Swap Edges command.

10. Click secondary mouse button anywhere on the work area (or tap the pop-up menu button) to invoke the pop-up
menu. Select Generate Stitches from this menu. This will finish the creation/editing mode and fill new object with
stitches. If you do not want to fill it with stitches now, use the Finish Object command instead.

11. Finished column object has stitches running in a zig-zag way from the start base to the end base, which define range
of angles of the stitches. Basis may be not sufficient to define angle of stitches of a more complex column. In such a
case, use End of Segment command from the pop-up menu to define angle inside of column. This command will
connect selected node with a nearest node on the other side and thus define a stitch angle in this part of column.



Digitizing of Applique object is identical to that of column object, with only exception that Applique must form a closed
figure. Image depicts Applique before closing edges. There is a gap between start and end base.

Applique object with closed edges. To ensure precise alignment of start and end base, use pop-up menu from the step
10. and select Close Edges command.

When creating a new object, TAB key on hardware keyboard can be used to quick adjustment of the curve
elements. Create new curve element with TAB key instead of primary mouse button. Then move the mouse with
TAB key depressed to adjust the curve. Then release the TAB key. Please note: to use the TAB key for curves
adjustment, the edge mode must be set to 'curve'.

Insert New Nodes
Pop-up menu mentioned in above examples can be used to insert (or delete) new nodes on the vector edge. If you need
to add multiple nodes quickly, please use Insert Elements Mode.
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Connections
Embroidery design should contain as little thread trims as possible. Trims are time consuming and decrease the quality
of embroidery because of potential thread loosening. Therefore, use connections between objects whenever possible to
reduce the trims number. Connection is series of running stitches whose only purpose is to draw thread from one spot to
another. Otherwise, there would be a trim. Studio has special tool (button on the left-side picture) for creation of
connections. This tool is located in the tool bar at the left side of the Studio window.



Connections should be used between objects of the same color on places where they are not visible or where they do
not affect too much the overall looking of design. They are often placed beneath other objects or along the outlines. In
case of small lettering (or other small objects laying one near another) the connections are visible (because there are no
objects to hide them), but they are made as short as possible. This type of connecting objects is called a 'nearest point'
connection.

You should always select such sewing order of objects in design that there is a minimum number of trims required. In this
case, we can sew both objects of the blue color first and then the yellow object on top of them. To avoid trimming
between the blue objects, we will connect them with stitches. Connection can be hidden beneath the yellow object.

Define start and end point of each blue object so that inserted connection does not interrupt continuity of sewing. The
first blue object (the left one) should end on a spot where connection begins. The second blue object should begin on a
spot where connection ends.

There are two ways of how to create connection:

1. Use connection tool to digitize connection node-by node
2. Select second blue object and use secondary mouse button click to invoke a pop-up menu. Then select Create

Connection to Previous Objects from this pop-up menu. This will create a straight-line connection which can be
edited node-by-node. The same command is available from the ∎ main menu > Build

Note : to adjust straight-line connection by adding multiple nodes quickly, please use Insert Elements Mode.

In our example connection has 3 elements - straight line, curve and one more straight line. The curve element has little
circular node in the middle. The start point of connection is marked by cross.



Shape of connection was chosen so that connection runs mostly deep inside of the yellow object which will be sewn on
the top. This helps to prevent showing of connection on the sew-out in case of little displacement of yellow stitches,
which often happens as result of loose hooping of fabric or pull effect of the thread. If upper object is large enough, place
connection at least 2~3 mm inside of the upper object. If it is small, place connection into the middle.

Connection ensures that the thread path is continuous from beginning of the first object (1) to end of the second object
(4) .

Note that the first object is sewn from bottom up to point (2) and then from top down to point (2) . This type of
stitching is caused by location of the start point (1) and the end point (2) . It is not possible to fill object with a
single draw while preserving the start and end point and the fill type. However, program automatically inserts
connection stitches inside of this object. User has to create connections only between separate objects, not
within objects themselves where program makes all stitching automatically. This approach allows user to define
overall stitch order without having to care about each individual stitch.

Connections have adjustable Minimum and Maximum Stitch length. Maximum-length stitches are used on straight-line
connection segments. Curved segments are stitched with shorter stitches to form smooth curves. Minimum Stitch
defines the shortest allowed connection stitch.

On places where running stitches between objects are not desired, connection object allows to create 'controlled jump
stitch' for easier trimming.
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Tutorial - Manual Digitizing of Lettering
Studio includes lettering tool for quick and easy creation of text labels, but it requires Alphabet or font file containing
the lettering style you want to use. Users who digitize company logos may often encounter situation when no font
matches the logo and lettering must be digitized manually.

This tutorial deals with manual digitizing of small satin stitch lettering. If you need to digitize plain filled lettering (with
outline), please read How to digitize a logo tutorial.

The principle of lettering digitizing is explained on a case of simple character "A". Two approaches are presented here: 1.
manual digitizing with columns and connection . 2. digitizing with auto-column . The second approach is not fully
manual, in fact, and can use trace tool to vectorize character.

Both approaches assume that user has graphic template ( image) of logo with text to digitize.

Approach 1 - full control of stitches direction
In this case all objects will be drawn manually node-by-node in a specific order. Digitizing of satin stitch lettering
requires use of two tools: column (satin stitch) tool and connection tool. Each character contains one or more columns.
In case of multiple columns, connection must be used to ensure continuous sewing without jumps or trims.
Connections are often included between respective characters too, for the same reason.

Character "A" cannot be digitized with a single column object. Therefore, we will use several columns and connections.

Select Column tool

or Column with Pattern tool

which is the same as previous, but uses texture on wide parts. Make sure that column mode "A" is selected in the
column mode combo box in the top-right corner of the Studio window. This column mode allows to digitize columns with



different number of nodes on each side. Create first object by placing the first node (1), second node and then both
edges of the column object. (2) mark the center nodes of the curves. (3) marks the end point of the object. Thread will fill
the column object from start point to the end point. Please note that column object overlaps areas at left and right side to
avoid gaps in stitching caused by pull effect of the fabric.

Select Generate Stitches command from the pop-up menu that appears on the right mouse button click. After
generation of stitches the column object will look like this:

Note that this object is listed in the Object Inspector list at the right side of the screen. This list helps to select and
manage objects in the design.

Now we need to start a new column at the bottom part of "A", but we need to get thread to this point to avoid jump.
Select connection tool

and create connection path to the new start point. Use Generate Stitches or Finish command from the pop-up menu to
finish the object.



Now create second column object. The corner at top part of "A" is too sharp for a single continuous column object.
Therefore, stop column at the top of "A":

We will start a new column here. However, it is necessary to insert connection from the previous column object. To hide
connection under cover stitches of the next column, make connection of the "V" shape as illustrated below:

Now create the last column. Finished character contains 3 columns and 2 connections. These connections are marked
by (C). The order of objects creation (and also sewing, therefore) was chosen so that connections are hidden under the
cover stitches of columns.



Please note that the end point of last column (and whole character) is in the bottom left corner of the last column (E),
because start point is in the top right corner. Such location of the end point does not matter when thread between
respective characters is trimmed, but it is wrong in case of nearest point connection between characters. In such a case,
start last column on the other side (left). This will place the end point at the right side.

Object Inspector now contains all 5 objects from which character "A" is composed. Objects are listed in order of sewing
from top to bottom.

It is possible to select them all and group them into a single item in the list, for easier manipulations like moving,
scaling, etc. You can use "group 1" command that is intended for lowest level groups.

Approach 2 - faster, but with less control
In this case we will use automatic generation of stitches order (auto-column), which creates stitches in required order
automatically. This means that character does not need to be digitized as so many small parts in a specific order and
connected each to the other. However, user has less control over the stitches order.

Digitize outer side of letter with a plain fill tool

Start point is marked by small cross (bottom-left side). The end point is marked by spider legs (bottom-right) side.



Then digitize the hole with the fill opening tool .

In case of character with multiple holes (like "B", for example), use this tool for each hole separately.

If underlying graphic template is clear and sharp enough, you can use trace tool to vectorize character edges instead of
manual digitizing.

Now select "Auto-Column" option in the parameters window and generate the stitches. Program automatically fills
object with column stitches and connections. User cannot affect the order of sewing within character, except definition of
start and end point.
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Embroidery Digitizing - How to Digitize a Logo
We will learn how to digitize a company logo in this lesson. It is intended
for beginners and all steps are commented.
Studio fills vector objects drawn by user or imported from vector file with stitches and finished design is uploaded into
Embird Editor for final adjustments and save in desired format. When doing a real digitizing job, please note that if you
do already have logo vectorized in some graphic program and saved in SVG or other format compatible with Studio, you
can use the ∎ main menu > design > Import vector file function to convert vector graphics into design and
avoid manual redrawing of objects. However, we will use manual digitizing in this lesson to learn how to do it in Studio,
because lot of digitizing work must be done manually to achieve best result.

When digitizing design in Studio, user can import scanned picture or photo into the background of the work area to
use it as a template for digitizing. Digitizing itself is drawing of vector objects on top of the image and filling them with
stitches. To make vector objects more visible on the background, imported image can be brightened, darkened or
otherwise filtered.

The first step in digitizing logo or other design is usually import of the scanned image. Scan is usually rotated, deformed
or otherwise distorted.

Chapter 1 - Adjustment of the Image

Use the ∎ main menu > Image > Import command to load image into the background of the work area. When
importing image, Studio asks you whether you want to resize image so that it fits the current size of Hoop (Work Area) or
not. Select No in this case. We will set the image size later.

Studio can import image up to 5000 pixels width and height.



Fig.1. Import of Image.

This image needs to be rotated to a horizontal position. Use the ∎ main menu > Image > Tools > Edit Image
Window command to open window with image adjustment controls. There is a Rotate Image control on the first tab.
Use it to rotate image to desired position.

You can adjust angle in a several ways:

Primary button click on the angle value (number) to increase the angle.
Secondary button click on the angle value (number) to decrease the angle.
Primary button click on the clock face to set the angle directly.
Secondary button click on the clock face to open window with slider for angle adjustment.

When adjusting the angle, wait a moment for Studio to rotate the image. Change the angle until image is rotated to
desired position.

Do not click Apply button yet. We will make more operations before closing this window.



Fig. 2. Rotation with Rotate To Horizontal tool.

Fig. 3. Rectified image.

Now we will crop the image and set required size of the image (which means also required size of embroidery design).

Move the crop lines close to edges of the logo. Crop lines have square handle in the middle to allow user to seize and
move the crop line. You can use Transform and Zoom tools as well as the work area scroll bars to zoom in or out, and to
scroll the work area in order place the crop lines precisely. Area that will be cut off is grayed.

Select the second tab (image size) and set required size of the image. The third tab allows you to set width of empty
area border that will be added to the image after cropping and resizing. This empty border is useful for digitizing,
because user does not have to work too close to work area edges.



Fig. 4. Logo bounded by the crop lines.

Click Apply button. Image is rotated, cropped and resized. If you have skewed or otherwise deformed image, use
Straighten Image tool from the ∎ main menu > Image . We will not use it now as it is not needed in this case.

To make digitizing easier, we will brighten the image. All necessary image details will remain visible, but there will be
higher contrast between digitized vector objects and background image. Use the ∎ main menu > Image > Tools >
Background Filters to open the window for change of image brightness and color. Adjust brightness by moving the
Brightness slider. Then click Apply button.

Fig. 5. Effect of increased brightness on the image.

Chapter 2 - Digitizing of Filled Areas
Now we can start the actual digitizing. We will use the Fill objects for color areas like letters and nuts and we will add
thin black outline (Outline objects) later. Fill objects are filled with long parallel stitches (if basic 'plain fill' is used ) that are
split into shorter stitches to avoid too thread being too loose. Because of these split stitches and their constant angle, fill
objects used for digitizing of large objects. They are not proper for digitizing of small lettering or narrow objects. If you
use fill objects for lettering, it should be at least 1cm (1/2 inch) high to sew well.

Good embroidery design should have as low number of trims (jump stitches) as necessary, in order to speed-up the
sewing process and to make embroidery nicer. If there are no trims or color changes, design is sewn in a single 'draft'.
Sometimes it is not possible to avoid trim, but digitizer should minimize their number in the design. To avoid too many
trims, it is necessary to place start and end point of areas which are close one to the other so that they could be
connected with Connection objects. There should be minimum distance between end point of one object and start
point of the other, so that connection is as short as possible ('nearest point connection).



Fig. 6. Nearest point connection between two fill objects.

Note: it is not necessary to use always only the nearest point connections. The gap between connected objects
can be covered by object of another color. In such a case, connection should be hidden beneath this object,
even if it is not a nearest point connection.

Click on the red color in the palette (top right corner of the screen) to select red color for objects that we are going to
create.

Select the Fill tool and place the first node on a place of letter E that is nearest to the letter m. Now the Studio is in a
'creation/editing' mode. Letter E will have start point and fill end point on the same place, because it is a first letter in the
word. Digitize whole letter by placing nodes around the letter. Rectangular node is end of the curve. Circular node is
middle point of the curve. Move the middle points to the side to adjust the curves.

Fig. 7. Digitizing of letter E.

To place the last node on top of the first, you have to create it a little bit aside and then move it on top of the first node.
Otherwise, you will select the first node instead of creating a new node.

When whole object is drawn, click the secondary mouse button to invoke the pop-up menu. Choose Generate Stitches
to end the digitizing of the letter. Notice other commands in this menu that allows you to convert curves to straight lines
and vice versa, insert or delete elements and also change position of start and end point of the fill. Program fills the Fill
object with thread beginning in the start point and finishing in the end point. Correct placement of these two points are
very important if you want to connect several objects together and avoid trims.



Fig. 8. Draw curves along the contour of letter E, starting at the right side. Then Click secondary
mouse button to invoke the pop-up menu and select Generate Stitches . 3 lines sticking at

various angles from the first node are indicators of zig-zag underlay 1, zig-zag underlay 2 and
cover stitches angles.

Finished letter is filled with stitches all going at the same angle (0 degrees, in this case). Studio automatically generates
also the underlay stitches around the contour of the letter to prevent the cover stitches pull, and zig-zag underlay stitches
to strengthen the fabric before sewing of the cover stitches. The outer red outline is only object boundary displayed on
the screen, it is not stitches. Notice the tiny white dots on the horizontal stitches. They mark needle points - places where
long horizontal stitches are split into smaller stitches. Needle points are arranged according to pattern. User can choose
any of the predefined fill patterns from the parameters window or define her/his own patterns.

Notice that all finished objects are displayed in the Object Inspector (picture at right side).

Fig. 9. Finished letter E filled with underlay and cover stitches.



Fig. 10. Icon in the Object Inspector list .

Please note that character 'E' was digitized with plain fill tool. If you need to create satin stitch lettering, please read
"Manual digitizing of lettering" tutorial.

Digitize all letters in the same way as the first letter E. Please note that start point of letter m is at the left size (picture
below) and fill end point is at the right side. To achieve this, place the nodes around the letter starting and ending at the
left side. Then select node at the right side, click secondary mouse button and choose Place Fill End Point Here
command. Start and end points are placed this way because we want to create connection stitches between the letters
later.

Fig. 11. Digitized letter m. Start point is at the left side. Though the last point of the object is also
at the left side (as the object is closed), the stitching will end on the right side of the letter,

because Fill End Point has been assigned to the right-most node.

Letters b and d must be created in a little bit different way, because they have opening. Create the outer contour like on
the previous letters (with fill tool) and then create opening with the Opening tool. Notice that opening is not displayed in
the Object Inspector window. It is displayed in the parts inspector window where the parts of complex objects are
displayed.

Fig. 12. Finished letter b.



Fig. 13. Opening is displayed in the Parts Inspector list .

Digitize the blue part of one of the nuts with the fill tool. We will create the rest of objects with duplicating and rotation.
Select the object and click the ∎ main menu > Transform > Transformations Window .

Fig. 14. First object is digitized manually.

Set 120 degrees to angle control on the Rotation Tab. Click two times on Apply to Duplicate button to create 2 new
objects, each of them rotated 120 degrees from the previous object. Click Close button to hide the window. Select
new objects and move them to their position. Then select them all 3 objects by clicking on them while holding the shift
key depressed. Click secondary mouse button to open a pop-up menu and select Generate Stitches command.



Fig. 16. All blue areas on image are filled with red thread.

Now all blue parts of the image are digitized and filled with red thread. We have used red thread because it is well visible
on the background.

We will change color of all red objects to blue. Select all objects with use of any of the following methods:

You can use ∎ main menu > Select > Select All command.
Or you can select objects directly in the work area by dragging the marquee box around the object.
Or you can select objects in the Object Inspector list.

Depress primary mouse button on the blue color cell in the palette and drag cursor to selected items in the
Object Inspector list or to the selection box in the work area. Then release the left button to drop color on selected

objects. Color of selected objects will change to blue.

Fig. 17. Color was changed from red to blue.

Now we will digitize the yellow parts of nuts. In fact, we should have done this before digitizing of the blue areas,
because the yellow parts would look more natural if they are beneath of the blue areas.



Anyway, we can digitize the yellow areas now and change order of objects so that they will sew first. Select some color
from the palette (orange, for example). Use the Fill tool to digitize yellow area of the first nut. There must be an overlay
between yellow and blue area to prevent the fabric showing through the stitches, because tension in thread could pull
edges of objects away and cause the gap between the objects.

Fig. 18. Yellow area should be digitized with slight overlay into the blue area. We area going to
swap the areas sewing order. The blue area will be on the top.

Generate stitches for the new object and then use the ∎ main menu > Transform > Transformations Window to
create 2 duplicates of the object, rotated 120 degrees (or -120 degrees) each. Then close the Transformations window
and move new objects to their place.

Fig. 19. Apply to Duplicate button used to duplicate and rotate objects.

The orange objects are still on top of the blue objects. To change order of objects, use the Object Inspector. Select
the 3 orange objects in the Object Inspector list. Depress the secondary mouse button on the selection and drag cursor
to the first object in the list (letter E). Then release the secondary mouse button and choose Insert Before command
from the pop-up menu. The 3 orange objects will be moved to the top of the list, which means that they will be sewn
before the blue objects.



Fig. 20. Use drag-and-drop operation with primary mouse button to change sewing order of
objects. Chose Insert Before option from the pop-up menu that appears. Picture at the right side

shows the new order of objects.

Fig. 21. Use drag-and-drop operation with primary mouse button to change sewing order of
objects. Chose Insert Before option from the pop-up menu that appears. Picture at the right side

shows the new order of objects.

We will change the angle of stitches in the orange objects, because they have the same angle as the blue objects. If two
adjacent fill objects have same angle of stitches, stitches may interleave and the edge between the objects may be
distorted.

Select the 3 orange objects, click secondary mouse button on the selection and choose Parameters command from the
pop-up menu. When Parameters window appears, change the fill angle to 90 degrees. Then click OK button to close
the parameters window.



Fig. 22. Change of fill stitches angle.

As you may have noticed in fig. 20 and 21, there is a small red scissors icon displayed in the Object Inspector list next to
each object that we have created so far. This means that object is not connected to the previous object by thread and the
embroidery machine will insert trim on this place (it depends on the type of machine). On many places, the trims (or jump
stitches) are not desirable. As the letters in the Embird logo are close one to the other, we could connect them with
running stitch connections to avoid trims.

Fig. 23. Logo with all fill objects.

Select letters m b i r and d in the Object Inspector window . Do not select letter E, because we do not want to connect
it to previous object. Click secondary mouse button on the selection and use the Create Connection command from the
pop-up menu. Connection is created from each selected object to its preceding objects.

Fig. 24. Creation of connection for selected objects.

Program creates connection stitches between the objects. Notice tiny connections marked by orange arrows on the
below picture. If you you get long stitches going through the objects, it means that you have not placed the start and end



points of the fill objects correctly.

Connections created automatically by Studio are straight lines. In some cases, you may need to edit shape of connection
by inserting new nodes.

Fig. 25. Nearest point connections between the letters.

Chapter 3 - Digitizing of Outlines
For complete list of outlining methods please read Outlines - Overview chapter.

Now we will add thin running stitch outlines to the logo. We will create outline that has two layers of stitches. We will
draw the first layer and then use Studio functions to create the second layer of stitches automatically. Studio allows to
use many creative types of outlines, but the simple thin running stitch outline is probably the most useful for the digitizing
of company logos, because other types of outline (sample, border, sketch, etc.) require larger size to sew well.

Another type of outline that is frequently used is satin stitch outline. However, we do not need it for this logo.

Select the black color from the palette. Use the Outline tool to create first part of the nut outline. We will draw outline part
by part, because we will use ∎ main menu > Build > Outlines > Arrange Outline Parts function to reorder outlines
and add second layer of stitches (backward paths) automatically. This function requires the outline to be drawn by parts.
Each part should have start and/or end point near to the start or end point of other part, so that program knows which
parts to join together and where.

Notice that new outline object is displayed with red foot steps icon in the Object Inspector list. This means that the
outline object does not have the backward path (second layer of stitches).

Fig. 26. First part of the nut outline.

When creating the outline parts, we can use the ∎ main menu (node editing mode) > Nodes > Snap to Nodes
option. When moving the newly created nodes, they snap to existing nodes of blue and orange objects beneath. This
way we can easily create outline running exactly around the fill objects.



Create the second outline part as a separate object. Place the start point on top or near the end point of previous outline
object.

Fig. 27. Digitizing of second part of outline. Snap to Nodes option is on to simplify the nodes
placement.

Now we have 2 separate outline parts and we will join them together and create the second layer of stitches. Select the 2
outline objects and use ∎ main menu > Build > Outlines > Arrange Outline Parts command. Notice that Studio
creates object composed of 2 original parts and it adds 2 identical parts with reverse order of nodes (see the Parts
Inspector). They are so called 'backward paths'. Studio automatically reorders all outline parts so that they are sewn in a
single draft. Sewing starts in the start point of the first part and it ends in the same point. Program automatically creates
path along all outline parts and back to the start point.

Arranged parts are joined into single item in the Object Inspector list (see the object no. 18 in fig. 24).

Fig. 28. Complete outline of nut composed of 2 original parts and 2 automatically created parts.

Select the whole nut outline and duplicate and rotate it for the rest of the nuts. Use the ∎ main menu > Transform >
Transformations Window to accomplish this task. Then move rotated outlines to their position.

Fig. 29. Outlines on all 3 nuts.

Now we will create outlines for the lettering. As letters are close one to the other, the easiest way is to draw outline
around whole word and then create backward path for it. The first picture shows outline drawn to the half of the lettering
contour. The second picture shows the whole outline.



Fig. 30. Example of how to draw outline parts to use the Arrange Outline Parts function

Fig. 31. Creation of outline around lettering.

Select the outline and use the ∎ main menu > Build > Outlines > Create Backward Path command to create
object that is identical to the first outline, but it has reverse order of nodes. Notice that new object is displayed in the
Object Inspector list with black footsteps in the icon, which means that it is a backward path.

Fig. 32. Second layer of stitches (backward path) on lettering outline.

Note While there is only single layer of stitches on all letters in the original outline, there are already two layers
on the short connections between the letters. When we create the backward path, there will be two layers on
letters and four layers on connections. It should not harm the design, but if you want to create outline that has
really only two layers of stitches on all parts, you should use other, little bit more complicated approach: draw the
outline as many separate parts and then Arrange Outline Parts . Below picture illustrates how to draw separate



outline parts in this case. There are gaps between the parts in order to show the separate parts. The parts
should touch each other, in fact.

It is also possible to create above outlines automatically with Auto Outliner tool.

Design is almost finished. However, we need to create outlines also for openings in letters b and d. Draw outline for
opening in letter b (objects no. 23 in the Object Inspector) and then create the backward path for it (object no. 24). Do
the same for letter d. Notice there is are trims between lettering outline and openings outlines, because there is no way
of how to make connections between them so that they would be not visible.

Fig. 33. Digitized logo with fills and outlines.

Objects will be sewn in the order shown in the picture at the right side. There are 3 colors in this design and 13 trims. We
could spare 6 trims if we create connections between parts of nuts that are of the same color.

Chapter 4 - Additional Improvements
Design will look better if we convert some fill areas to zig-zag areas. This will add design relief and more interesting look.
Select the blue part of the nut, click secondary mouse button on selection and choose Parameters from the pop-up
menu. Select Auto Column option in the Fill tab of the Parameters window. Then click OK button to close the window.
Generate stitches for selected object anew. Object is now filled with stitches as if it was digitized as several Column
objects connected with connections.

Fig. 34. Change of the plain fill to the Auto Column fill.

The fill of the orange area on the nut has default predefined pattern. You can choose other pattern, define your own
pattern and/or add Carving objects on top of the fill object, which will cause additional needle points in the pattern and
add texture to the fill. Select the orange fill object and use Carving Tool to add curves like in the below example.



Fig. 35. Adding Carving objects to enhance the texture of the fill.

User Guide > ^Get Started > ^Outlines

Outlines - Overview
This chapter is an overview of various methods of creation of thin hairline outlines. These methods are described in more
detail in respective tutorials.



Complete outline in vector form (no stitches yet).

Thin outlines like shown on above picture are used very often for lettering, logos and cartoon-like motives. One of the
key rules in embroidery is to make lowest possible number of trims. Therefore, the best way of how to make such
outlines is to digitize it as a single, continuous path of stitches. To avoid trims, some parts have to be stitched two times:
there (forward path) and back (backward path). In fact, the whole outline, regardless of it complexity, can be created so
that each of its parts (elements) is stitched two times. The end point of outline is identical with the start point. Such
outline is called a double-layered outline in Studio.

Stitches (animation).
Each element has two layers of stitches to get there and back.

Backward paths are drawn in red color for clarity.

Outline elements in Object Inspector.
Backward Paths

are marked with foot prints.
Sewing is continuous, there are no trims.

Double-Layered Outline
There are several ways of how to create double-layered outline in Studio. They differ in amount of automation used in
each approach. Some digitizers prefer one particular way of outlining. The most convenient approach is to use fully



automatic outlines. In some cases, however, it is necessary to use manual or semi-automatic approach. For example,
when you want to combine thin outline with column (an eye with outline), it is necessary to use manual digitizing.

Method 1

Icon of Outline Tool.

Manual digitizing of all elements, including backward paths in proper order. Proper order is necessary to ensure
continuous sewing. This method is not recommended and is mentioned here only for sake of completeness.

Order of elements 1-4. Purple and red color denote current element.
Purple element is first layer of stitching. Red element is second layer.



Order of elements 5-8.
Please note that end point of element 8 is identical to start point of element 1.

Method 2

Manual digitizing with use of ∎ main menu > Build > Outlines > Create Backward Path command. Backward path
elements are identical with forward path, they are only sewn in reversed order. Therefore, they can be easily generated
by program. The proper order of elements is still necessary in this approach. Use this method if you need to create small
outlines combined with other objects.

Method 3

Semi-automatic method: manual digitizing of forward elements in any order and their automatic arrangement with use of
∎ main menu > Build > Outlines > Arrange Outline Parts command. Elements can intersect one another.

Elements can be digitizing in any order. For best accuracy, pay attention to places where elements connect one to
another. Program splits and sorts elements to achieve proper order and creates all the backward paths. The start point of
the first element remains the start point of the whole outline. As outline is double-layered, it is also the end point of the
outline. If some elements form separate object (like dot on i) or are too far from other elements, program creates
connection to such elements so that complete outline is a single object. If you want to preserve separate objects, use

Arrange Outline Parts (no Connections) command instead.



Elements 1-4. Order of elements is not significant in this case.
Start and and end point of the outline is identical with first node of the first element (blue circle).

It is important to avoid duplicate edges and to align end points of individual edges.

Arranged elements are combined into larger segments to optimize stitches layout. If you want to preserve original
elements for easier editing, switch off this feature in Parameters window > Whole Design > Main tab.

When compared to method 1, there is about 50% less elements to digitize (no backward paths). Order of elements is not
significant and there is no need to remember which part already has second layer of stitching.

Above illustrations depict the order and layout of outline elements. The actual elements are created with curves, lines
and nodes like shown on the left side picture.

Use this semi-automatic method for complex outlines when you cannot use automatic method 4.

Method 4

Automatic creation of outlines from fill and column objects. All that user has to do is to select objects to be outlined
and use the ∎ main menu > Build > Auto Outliner command. This approach is recommended to be used
whenever possible.

If there are fill or column objects with identical edges (adjoining areas without overlay), the automatic outlining can fail.
This case typically occurs when working with vector objects imported from graphic files (EMF, WMF, CMX). In such a
case, edit adjoining edges (move one edge to create an overlay) or use another method of outlining.

The most commonly used methods are 3 and 4.

Note: forward and backward paths are marked with special icons



and

in the object inspector. These icons help to identify respective elements for selection and editing. Also, there is a
special command in ∎ main menu > Select > Outlines > Backward Paths to select backward paths
quickly. Then it is possible to set satin stitches to these elements or make whatever editing is needed.

User Guide > ^Get Started > ^Arrange Outline Parts

Arrange Outline Parts
Arrange Outline Parts command is intended for making complex thin outlines with double stitching. Any running stitch
outline regardless on its complexity can be done in this way.

User has to draw separate outline objects in any order. Parts must approximately touch each other. This function works
so that it combines separate outlines, splits them if necessary, sorts them in a proper order and creates a backward path
(second layer of stitching) to them.

Result is a new object - grouped series of outlines with double stitching in a correct order. The order of outline parts is
adjusted automatically by Studio.

Only the first outline part remains on its place. As there is double stitching on the outline, the end of outline is identical to
its beginning. Therefore, place the first outline part on a place where you want whole outline to begin and end.

Drawing of outline parts for the Arrange Outline Parts function. Design contains 3 outlines.



Arrange Outline Parts function automatically splits original outlines on a proper places (points
marked with C), reorders them and creates the backward path (second layer of stitching).

Arranged elements are combined into larger segments to optimize stitches layout. If you want to preserve original
elements for easier editing instead, switch off this feature in ∎ Parameters window > Whole Design > Main tab .

Note: Arrange Outline Parts command does not work if there is already some backward path among selected
objects.

If there are separate outline parts that do not touch the rest of outline (like hole outline, for example), This function
creates connection to this separate object(s). if you do not want such connection, please use next command.

Arrange Outline Parts (no Connections) works exactly like above command, but it does not connect separate objects
to the main outline.

Other related topics are Automatic Outliner and overview of outline methods.

User Guide > ^Get Started > ^Colors

Colors, Color Picker and Thread Catalog
Control of colors in embroidery design is a crucial task not only to make design look good on the screen, but in the first
place to optimize number of thread changes and trims. Number and order of colors affect the quality and production time
of the final embroidery. Therefore, Studio provides tools to display the color layout and to edit respective colors.

Colors in Object Inspector



List of objects in the Object Inspector contains information about color of individual objects.

All vector objects in the design have the color property, but for some object types like carvings and openings (holes)
the color property is not applicable.

Small rectangular box in each row is a color sample from the object. If this row contains grouped objects, the box
displays color of the first object in the group.

The number marked with arrow indicates order number of color. Colors in this list are numbered in order of appearance.
In this example, the list contains 4 different colors. Objects #2,#3 and #4 have identical color. Sequence of colors allows
to optimize thread changes on embroidery machine.

Color Palette

The basic tool for work with colors in Studio is Palette in the top corner of the screen. Newly created objects take their
color from the highlighted cell (maroon, in this example).

Palette also allows the following operations:

Primary button click - highlight cell in the palette.
Secondary button click - invoke color picker menu (see below).
Long tap - invoke color mixer window to define a new color.
Drag-and-drop from one cell to another - copy color to the another cell.
Drag-and-drop from cell to object(s) in the work area or Object Inspector list - change color of target object(s)

Moreover, it is possible to store or load palette with use of ∎ main menu > Design > Export/Import > Color Palette
> Load and Save Palette commands.

Thread Catalog

Many users want to digitize with real thread colors to get best possible preview of embroidery and to speed-up creation
of color sheet (documentation) in basic Embird program. Studio provides a Thread Catalog tool that allows to select
from pre-defined colors close the thread colors.

Thread Catalog tool is accessible from ∎ main menu > Object and the pop-up menu. The pop-up menu appears
upon secondary mouse button click on selected objects in the Work Area or in the Object Inspector list. There is also a

Pop-Up button to access pop-up menu with primary mouse button click or with a finger tap.

By default, the Thread Catalog takes color of the first selected object as a reference color. Threads that are closest to
this color are displayed on top of the list.



Color Picker
Color Picker function is accessible from pop-up menu and can be used to pick color from the underlying

raster picture. Use of the 3x3 pixels or 5x5 pixels average sample may help in case of the noisy picture.

Color Mixer
Color Mixer is a panel with controls which allow to define your own color by RGB or HSL components or by picking it

from the color plane.

User Guide > ^Get Started > Thread Catalog

Thread Catalog
Many users want to use a real thread colors when working with embroidery designs. Embird provides a Thread Catalog
tool that contains pre-defined thread color palettes. It is even possible to define custom thread palette and include it into
Embird.

This window is used in 3 different situations:
1. to pick color to be used for some design area - table (A).
2. to manage set of preferred (marked) threads - column (K) and controls (F).
3. to choose primary catalog used when exporting and printing design documentation - combo box (D).

The meaning of controls is as follows:

A Table of threads from catalog chosen in box (D). Order of threads depends on a sorting criteria chosen either
in pop-up menu (H) or by tapping respective column header in row (C).

B Click any row in table (A) to select color from catalog. Selected color is displayed in box (G).

C
Columns with thread data: color sample, thread number, thread name, selection. Tap on any column header
cell to sort threads on criteria represented by this column (i.e. color match, number, name, marked). The
same sorting criteria can be accessed via pop-up button (H). Double tap on column header cell reverses the
sorting order (ascending versus descending).



D
Catalog filter - allows to display all catalogs or only the chosen one. The main table (A) contains threads from
catalog selected in this box. If Thread Catalog window was launched to chose a primary catalog for export
and print functions, the primary catalog is the one selected in this box.

E Search box that allows to type-in the thread name or number. Buttons to find next or previous match. They
are used with search box.

F Controls for marking chosen threads with option to display marked (selected) threads only. This is useful if
you want to use only the threads that you actually have.

G
Box with preview of color selected in table (A). If Thread Catalog window was launched to pick color for some
object, the previous (old) color of object is also displayed to allow to find a best match. In such a case, sort
threads in table (A) on color match.

H Button to access the pop-up menu. This menu allows to choose how thread samples are rendered (3D or flat)
a how they are sorted.

I Cancel and Apply buttons

J Horizontal splitter

K
Last column in table allows to mark preferred threads. Tapping cells in this column marks and unmarks
respective threads. Tap and dimultaneous pressing of key Shift on keyboard allows to mark multiple threads
with a single tap. Tap and simultaneous pressing of key Ctrl on keyboard allows to unmark multiple threads
with a single tap.

User Guide > ^Get Started > Color Mixer

Color Mixer
Color Mixer is a panel with controls which allow to define your own color by RGB or HSL components or by picking it
from the color plane.

There is also a quick-access palette with pre-defined colors in this panel. Palette can be customized by dragging
current color from large color box (D) on the left side to the palette cells, or from one palette cell to another one.



A Hue track bar

B Saturation-Lightness plane for hue set with track bar (A)

C Current color position in the plane

D Box with current color

E Adjustable components of current color in RGB (red green blue) color scheme

F Adjustable components of current color in HSL (hue saturation lightness) color scheme

G Quick-access palette with pre-defined colors. Current color from box (D) can be dragged to any of these
boxes to store it as pre-defined color.

H Horizontal splitter

I Reset, Cancel and Apply buttons

User Guide > ^Get Started > ^Groups

Groups of Objects
Group combines several objects into one for easier selection and manipulations.



Embroidery design in Studio is composed from many elementary parts like fills, connections, etc. These elementary
objects are used to digitize entities like letters, flowers, animals and everything else in the design.

It is useful to mark elementary parts which belong to the same entity (a letter, for example) so that program knows they
belong together and allows to select and manipulate them all at once. This process is called grouping of objects.

Commands for grouping and ungrouping of selected objects are accessible from ∎ main menu > Groups and also
from the pop-up menu in select/transform mode.

Digitized letter R consists of three parts: 1. column object, 2. connection, 3. column object

When digitizing a lettering, for example, the elementary parts of letters (columns and connections) may be joined with
Group 1 command, so that each letters is composed of parts grouped together. Letters may be joined into words with
Group 2 command and words may be joined into sentence with Group 3 command. The numbers 1,2 and 3 indicate the
level of the group. Many programs have just one group level. Several levels allow to ungroup and manage objects on
some level, while leaving other levels untouched. For example, you can ungroup parts of letter for editing, while
preserving words and whole sentence grouped.

Basic parts of letter 'R' are selected. These parts are colum, connection and another column, as
shown in object inpector list.

Use Group 1 to combine them into a single object. Repeat this process for each letter and its parts.



Each letter is composed of several parts, but these parts are grouped into objects now. There is
a small lock icon at right side of each object in the inspector list indicating that this object is

composed of parts grouped on level 1.

Select the letters in the word RED now a use Group 2 to combine then into a single object. Do the same with letters in
the second word. Each word will become a group with level 2.

Small double lock icon at right side of each object indicates that this object is composed of parts
grouped on both levels 1 and 2.

Select both words and use Group 3 to combine them into single object.

The fact that this object is composed of objects grouped on levels 1,2 and 3 is indicated by a
triple lock icon.

Use Ungroup 1, Ungroup 2 and Ungroup 3 commands to divide groups on respective levels (in this example, use
Ungroup 3 to split sentence into words, Ungroup 2 to split words into letters and Ungroup 3 to split letters into basic
objects).

User Guide > ^Main Window

Main Window
Main window of Studio contains large Work Area and several panels with context-sensitive content, which means that
they change according to actual work mode. Their layout is shown on the following diagram. Proportions of some panels
can be adjusted with splitters.



Work Area . Please read Work Area chapter to learn more about this control.1

Status Bar . The mouse cursor coordinates, zoom and tool hint or other information are
displayed here. When an object is selected, the status bar displays its size and number of
stitches. If editing/creating Fill object, the status bar displays angles of cover stitches and
underlays.

2

Main Control Panel . According to current work mode, this panel contains one or multiple
tabs with available controls and information. See next diagram for more detail.

3

Vertical Toolbox.4

Context-sensitive main menu and other controls.5

Palette of Colors . Click secondary mouse button on any color to adjust this color. To
change color of an existing object, press primary mouse button on color and drag and drop it
on the object icon in Objects Inspector window (see 11 below). To set color that will be used
for newly created objects click primary mouse button on any color.

6

Active Color . The Color that will be used for new objects is outlined in black and white.7

Vertical Splitter8

Magnifying window . This window displays enlarged area around mouse cursor. It aids
precise placement of nodes, allowing user to maintain view of design in the Work Area. To
hide this window, use View/Zoom Window; this will enlarge the Parts Inspector window.
When cursor moves over Object Inspector, this window displays enlarged object icon.

9

Splitter for adjustment of size of the main control panel. Space on this splitter is used for
quick-access buttons of most often used functions from main menu and pop-up menus.

10

Button for sending the finished design to Embird Editor.11

Most commonly used tab in the main control panel is Object Inspector Tab. Its layout is depicted on the following
diagram.



Object Inspector list . All objects created on work area are displayed here in order of
creation. It shows order of objects, their type, visibility and whether they are connected to
previous object by jump or not.

A

Part Inspector list . Openings (holes) of fill objects are displayed here as well as parts of
joined and grouped objects. This window serves to select holes and parts for further
manipulation, because they cannot be selected in work area and in Objects Inspector. When
in the nodes editing mode the Object Inspector and Part Inspector windows (B) are
replaced with basic parameters of the object.

B

User Guide > ^Main Window > ^Work Area

Work Area
Work Area is space on main Studio window where user digitizes design, makes editing to the design and where
design previews are displayed. Following diagram and comments explain Work Area components and their usage.



Viewport . It is a user's visible area of the design. It includes hoop area (2) and empty space
(3) which appears only when viewport is zoomed-out sufficiently.

1

Hoop area . When starting a new design, the hoop is blank. User can import image here
to be used as a template for digitizing.

2

Empty space around hoop or image template.3

Grid . Grid helps to size and align objects of the design. Objects and nodes may be snapped
to the grid if respective snap option is turned ON. This makes alignment easier in some
cases.

4

Rulers . When you move cursor within the viewport a thin hairlines are shown in rulers to
indicate position of the cursor. Besides positioning and size measurement the rulers are also
used to create guide lines. Press primary mouse button on vertical or horizontal ruler and
drag mouse to viewport to create a new guide line. If you do not need rulers and you prefer
more working space, use ∎ main menu > View > Layout to hide them. Ruler units are
set in regional settings accessible via ∎ main menu > Options > Settings .

5

Scroll bars . Besides using the scroll bars, the work area can be scrolled also by depressing
the secondary mouse button when cursor is on top of the hoop area and dragging it to a new
possition. This is identical to pan tool used in some programs.

6

Display mode tabs . Switch the way of how design is displayed in the viewport by
selecting any of these tabs. Active tab is highlighted.

7

Pop-Up Menu button allows to access menu. Commands in this menu allow to set thickness
of lines in the node-editing mode. This parameter is also accessible in

Settings > Preferences > Edit Mode.

8

Default colors of hoop and the grid lines are specified and can be changed in ∎ main menu > Options > Settings >
Preferences > Work Space .

User Guide > ^Main Window > ^Display Modes

Display Mode
Studio provides several different ways of how to render embroidery design on the screen during digitizing or editing.
They help to identify problematic places in design that require your attention and to keep control over the layout of
stitches, even if they are covered with upper layers.

Chose required Display mode with use of the tabs at the bottom of Work Area. Click the tab
to switch the display mode.



Normal, Image and Vector Tab

In Normal mode , all objects (background image and digitized vector objects) are displayed. In Image mode only the
background image is displayed. In Vector mode only the digitized objects are displayed.

3D Tab

In 3D mode embroidery design is displayed with use of realistic three dimensional simulation.

Flat Tab

In Flat mode embroidery design is displayed with plain colors (without shading and glittering), but preserving the thread
width. This mode is useful when working on detailed parts of design where thread shading and glittering may be
confusing.

D. Map Tab

D. Map (Density Map) displays design in a false color scale, with color gradient from blue through green and yellow to
red. Intense red color indicates areas of critical stitch density. This display mode is useful when converting graphic file
(like SVG) to embroidery design. Graphic files do often have number of hidden or overlapped layers, which must be



removed when used for embroidery. Density Map allows to discover places with too many layers (and consequently, high
stitch density).

Colors in Density Map mode: blue-violet means empty place, orange-red means high density
place.

X-Ray Tab

X-Ray mode displays stitches as semi-transparent, allowing to see through the cover stitches and check the underlay,
the tie-up stitches and overlays. This mode helps to check all layers of design at once and to identify areas of high stitch
density. It also helps to identify stitches that are too short or too long. Such stitches are rendered in intense colors.

Fill object in x-ray mode:
1 - tie-up stitches, 2 - connection path, 3 - edge underlay, 4 - overlay of fill sections, 5 - pattern of

cover stitches, 6 - very short stitch, 7 - very long stitch.

Note : ∎ main menu > Options > Settings > Rendering window allows to access options that affect the
display modes.

Zoom levels in Studio
Note for owners of Studio versions 2021 and older , the current version uses new zoom levels. Zoom 1 now means
that design is displayed on screen in its real size. Therefore, tabs with 1:1 view modes were removed.

User Guide > ^Main Window > ^Inspector



Object Inspector
Main Control Panel contains multiple tabs (1) that change according to the current work mode. In this chapter, we will
focus on Inspector Tab and More Tab, which allow to select and manipulate design objects.

Tabs

Many functions and options for these tabs are accesible via pop-up menus. If your device uses mouse,
you can invoke the pop-up menu with secondary mouse button click. If your device has a touch screen,
invoke the pop-up menus with tap on pop-up menu button (E).

Inspector tab and More tab.

A Object Inspector List . All objects created on work area are displayed here in sewing order. It shows order of
objects, their type, visibility and whether they are connected to previous object by jump or not.

B
Part Inspector List . Openings (holes) of fill objects are displayed here as well as parts of grouped objects.
This window serves to select holes and parts for further manipulation, because they cannot be selected in
work area and in Objects Inspector.

C
Buttons for browsing in Object Inspector list. Buttons with arrow icons serve to skip objects of the same color
or connected by connection. They help to browse the objects list faster when you need to find and select next
or previous group of objects.

D Switch to turn ON and OFF list items selection with check boxes. This option is usefull if your device has
touch screen.

E Button for access of list pop-up menu. This option is usefull if your device has touch screen or if you use
single-button mouse. Pop-up menus are also accessible with secondary mouse button click on respective list.

5 Magnifying window . This window displays enlarged area around mouse cursor. It aids precise placement of
nodes, allowing user to maintain view of design in the Work Area.

6 Splitter for adjustment of Object Inspector / Parts Inspector proportion.



7 Splitter for adjustment of size of the control panel. Useful when you need to enlarge the panel to see text
labels, for example.

List of objects and their parts
The hearth of the Object Inspector is list of design objects. Besides small thumbnail of each object, the list contains also
many usefull information. For example, sewing continuity info helps to locate undesired trims and fix them with placing

connection stitches.

When composing complex design, it is sometimes difficult to grab desired object in the Work Area. In such a case,
use Object Inspector to select and manipulate the object.

All vector objects forming an embroidery design are displayed here in the sewing order. Inspector lists show order of
objects, their type, visibility and whether they are connected to previous object with running stitches or jump.

For example, to change order of objects, select them in Object Inspector list and drag-and-drop them to their new
position.

To Hide/Show object click the eye icon to the left of each object.

To access menu to duplicate, delete, or change parameters, click secondary mouse button on selected objects in Object
Inspector window or use pop-up menu button (E).

To change color of object in Object Inspector, press primary mouse button on any color in Palette (2) and drag-and-drop
it on this object. Another way is to double click the object thumbnail to access the color dialog box, or use the Color
command from the pop-up menu.

To select non-contiguous subset of objects, depress the Ctrl key and click primary mouse button on each object.

Click secondary mouse button on selected object or objects in Object Inspector to access a pop-up menu for operations
with selected objects.

To select and manipulate parts of grouped objects, use the Part Inspector window (B) beneath the Object Inspector
window. It is not possible to select those parts directly on the Work Area.

To change sewing order of objects in Object Inspector, select an object and drag-and-drop it to its new position in the list.
From the menu that appears after the drop, choose whether the selection should be placed Before or After the item .
You can also choose the Set Identical Parameters to copy parameters from one object to another, or Set Identical
Color to copy color one object to another.

Note: When using touch screen, turn on (D) switch to display checkboxes in the list for a single-tap control.

A row in the Object Inspector list looks like this:

1 2 3 4 5 6 7 8 9



The meaning of respective columns is following:

1 - Visibility

Object is visible. Click primary button on the icon to hide the object.

Object is invisible. Click primary button on the icon to show the object.

List item is a group of objects with some objects visible and some not visible. Click primary button on the
icon to show/hide all objects in the group.

2 - Thumbnail

Double click on object icon to generate stitches. Small red dots indicate the end (ends) of object parts.

3 - Continuity

Indicator of jump stitch and/or color change before object. Scissors indicate that there is a jump stitch
(trim) before the object. Color tube indicates that object is of other color than previous object.

4 - Object Type

Double click on this icon allows to access the Parameters window. To copy parameters or color into other objects, select
item, depress primary mouse button and drag and drop on the other item.

Object is plain Fill.

Object is Fill with autocolumn.

Object is Fill with motifs.



Object is Sfumato. Sfumato is an optional part of the Digitizing Studio.

Object is a hole in Fill or Sfumato object.

Object is Carving.

Object is Outline.

Object is sketch Outline.

Object is Outline used as border.

Object is Manual Stitches sequence.

Object is Connection.

Object is Column.

Object is Column with Strips mode.

Object is Column with Multilayer mode.

Object is Column with Pattern. It is similar object like Column, but its cover stitches are divided according
to some pattern. This allows to use wider columns and to add texture to the cover stitches.

Object is Applique.

Object is a hole in Applique.



Object is Mesh.

Object is a hole in Mesh.

Item is composed of several other objects that are grouped together.

5 - Trim Indicator

Indicator of trims inside of grouped objects. Items composed of multiple objects may contain trims
inside them, which is indicated by this icon. There may be a color change, missing connection or missing
backward path inside of grouped object.

6 - Color

Double click on color box invokes a color mixer window.

7 - Object Number

# Double click on the text label (object and color number) to change object parameters.

8 - Color Number

Colors are numbered in order of appearance. This number helps to identify objects with the same
color, which is useful especially in a case of very similar colors.

9 - Comment

?
Comment contains additional information about some objects like name of outline sample or name of font
used for lettering. Studio also displays labels for objects belonging to lettering created with Alphabets
or with Font Engine. Label contains first line of respective text and 'Alphabets Text' or 'Font Engine Text'
attribute. If you want to edit lettering object, use secondary mouse click to open pop-up menu and select
Edit Text command.

User Guide > ^Main Window > ^ToolBox

Main Toolbox



Vertical toolbox panel.

All Modes
Control on the top of this panel is common to all working modes. It displays actual zoom factor of the Work Area. This
control can be clicked on, which sets zoom to real size (1:1).

Zoom Indicator

Zoom factor. This button has double functionality: 1. the current zoom ratio is displayed on its surface.
2. clicking this button sets the zoom ratio to 1:1, which means that design in the Work Area is rendered
in a real size, equal to actual sew-out of the design.

Zoom factor button looks like this in case of exact 1:1 scale.

Mode #1 - Select and Transform
The tools in the top section of the panel serve to select and manipulate the finished objects and to zoom the work area in
and out.

Next section contains tools for creation of new objects. A special category is a Measurement Tool.

Selection Tools

Select/Pointer Tool

Edit Edges Tool



Zoom Tool

Lasso Selection Tool

Panning is done with secondary mouse button depressed and cursor move over the work area. In contrast to previous
version of Studio, there is no special pan tool.

Creative Tools

Create Fill Object Tool

Create Sfumato Object Tool. Sfumato is an optional part of the Studio

Create Mesh Object Tool

Create Opening (hole) Tool. Opening can be created after Fill, Sfumato or Mesh object.

Create Carving Tool.Carvings can be created after Fill, Sfumato, Mesh and Column object.

Create Column Object Tool

Create Column with Pattern Tool

Create Outline Object Tool



Create Manual Stitches Tool

Create Applique Object Tool

Create Applique Hole Tool

Create Connection ObjectTool

Measurement Tool

Trace Tool

Freehand Tool

Use zoom tool to zoom in (left mouse button click) or zoom out (right mouse button click). If you want to zoom in a
specific area, depress the left mouse button and drag mouse to make selection. Then release the mouse button and
selected area will be enlarged so that it fits on the screen.

Create Opening can be used only after Create Fill or Sfumato object or previous Opening object. It does not appear in
Object Inspector window as a separate object and cannot be selected directly on the Work Area. To select the

Opening object for transformation, use the Part Inspector window. The same thing applies for Applique Opening object.

To add Opening to Fill or Sfumato, the Fill or Sfumato must be either selected or it must be the last object in the Object
Inspector list.

Create Carving has effect only if used after the Fill, Sfumato, Column, Column with Pattern or Opening object.



The Fill, Sfumato, Opening, Carving, Outline, Connection and Manual Stitches objects have just one side (edge). Fill,
Sfumato and Opening edge must form a closed loop, which means that their last point must be placed on top of their first
point.

The Column Object, Column with Pattern and Applique Object always have two sides (edges). If Finish Object or editing
functions are not available (grayed out) more than likely the second side of object has not been drawn.

When Applique Opening object is used after main Applique object, program generates stitches this way: 1. marking
stitches of both main object and hole, 2. tack-down stitches of both main object and hole, 3. cover stitches of both main
object and the hole. If there would be another Applique object instead of Applique Opening object, program would
generate all three layers for first object and then all three layers for second object. The opening would be covered by
fabric.

Measurement Tool measures distances and angles in design. It allows to create one or two measuring lines. If there are
two lines, tool measures also the angle between the two lines. Measured values are displayed on main control panel.

Mode #2 - Node-by-node Creation/Editing

Choose lines or curves to use for new edge elements.

Choose how curves are digitized: Approach no. 1: first click makes middle node, second click
makes end node. Approach no. 2: first click makes end node, the middle node is created
automatically and then can be moved to desired place

If checked, node is snapped to edge of work area if they are close enough

If checked, node is snapped to nearest node if it is close enough

If checked, node is snapped to guide lineif it is close enough



If checked, node is snapped to grid if it is close enough

If checked, node is snapped to object edge if it is close enough

Horizontal curvature (in %) of rounded rectangle corner. This setting is for rounded rectangle
shape

Vertical curvature (in %) of rounded rectangle corner. This setting is for rounded rectangle shape

Mode #3 - Lettering

Combo box with predefined baselines

Switch to overall editing of lettering

Switch to editing of individual characters

Switch to editing of baseline nodes

User Guide > ^Main Window > ^Menu Panel

Main Menu Panel



Main Menu panel.

Menu Panel contains combination of controls like menu, buttons and combo boxes. It is context-sensitive, which means
that its content changes according to the actual working mode.

For more information about the main menu see the ∎ Main Menu chapter.

User Guide > ^Main Window > ^Splitter Panel

Splitter Panel
Horizontal splitter in main Studio windowcontains buttons for quick access to frequently used operations. Most of
these buttons duplicate functionality of menu items or tools. Clicking the buttons may be faster, especially when using a
touch screen instead or along with mouse.

Splitter panel.

The set of buttons changes according to actual situation (working mode). For example, it is different when lettering
mode or node-editing mode is active.

Splitter Panel - Common Buttons for All Working Modes

Acces to Pop-Up menu. The same menu is invoked upon click on Work Area with secondary
mouse button depressed.



Zoom-In

Zoom-Out

Mode #1 - Select and Transform

Undo changes

Redo changes

Save design to disc

Generate Stitches for selected object(s).

Show or hide jumps stitches in the Work Area.

Run Sew Simulator.

Mode #2 - Node-by-node Creation/Editing
Buttons on the top are identical to Mode #1. The rest of buttons are:

Create Backward Path (second layer) to Outline object.



Align beginning to the previous object.

Align end to the next object.

Split edge.

Create segment partition in Column or Applique.

Mode #3 - Lettering
Buttons on the top are identical to Mode #1. The rest of buttons are:

Load Lettering.

Save Lettering.

Clear Text.

User Guide > ^Main Window > ^Pop-Up Menu

Pop-Up Menu
Pop-up menu is a small context-sensitive menu with handy commands and options applicable in the current working
mode. Pop-up menu is hidden and it appears only when you invoke it.



Click or tap this button to access a pop-up menu.

On devices with mouse the pop-up menus appear upon click of secondary mouse button.

There is a number of pop-up menu buttons in Studio's windows and panels. They are intended mostly for
use witch touch screen on devices without a mouse, but they can be used with mouse too if you preffer a
single-button work.

User Guide > ^Node Editing Mode > ^Direction Lines

Direction Lines in Auto Column
Auto Column uses advanced algorithms to fill object with satin stitches in a way as close to work of human digitizer as
possible. However, user may still want to change direction of stitches on some places. This can be achieved by direction
lines (marked by red arrow), which are lines drawn from any edge node across the filled area. If direction line does not
cross the filled area, it has no effect on the stitches direction.

Below example illustrates influence of direction line on the auto column stitches.

While in creation/editing mode, select node from which you want to draw direction line. This node will be the start
point of the line. Then click secondary mouse button on a place where the end of the line should be. Secondary mouse
button click marks this spot and invokes the pop-up menu at the same time. Select "Place Direction Node Here"
command to finish the direction line.

To delete direction line, simply delete the node at the end of this line.



User Guide > ^Node Editing Mode > ^Insert Elements Mode

Insert Elements Mode
While working in nodes creation/editing mode, you can only add new nodes after the last node on the edge. It is
possible to use Insert command from pop-up menu, or button with the same function to add nodes anywhere, but it can
be very cumbersome in case of multiple nodes insertion. Adding new node near existing node may interfere with
selection of that node instead of creation of a new one. The Insert Elements mode allows to bypass these two problems.
This mode has two main advantages:

1. Allows to add new nodes after any selected node, not just the last one.
2. Does not check if you click on existing node, so you can put new node on top or near existing node.

When using a keyboard, the Insert Elements mode is activated by depressing the "a" key on keyboard
and holding it depressed while clicking the primary mouse button on desired place in the work area.

In case of device without keyboard, use ∎ menu (creation/editing mode) > Edit > Insert Elements
Mode option or button in the menu panel to activate this mode.

Inserting new nodes is especially useful when adjusting automatically created connection between objects or for
creation and editing of special shading effects with manual stitches. If large number of manual stitches is created, it is
also helps to avoid selection of existing node instead of making a new node.

Below example illustrates insertion of new nodes. Polyline ends with point (E) . We want to insert some nodes after the
node (2) . Select point (2) by clicking it.

Activate the Insert Elements mode. Tap or click to places where you want to place new nodes. Create new nodes (3),(4),
(5),(6) and (7) . Then exit the Insert Elements mode. Please note that these new nodes were inserted into the middle of
the nodes sequence, after the node (2) . Dotted line on below illustration indicates previous stage of the polyline.



Note : while Insert Elements mode is active, you cannot select existing nodes. To do so, exit the Insert Elements
mode first (release the "a" key or uncheck respective option in menu).

User Guide > ^Node Editing Mode > ^Basic Shapes

Basic Shapes
Basic shapes like rectangle, ellipse, star etc. are available from ∎ main menu > Shape . These shapes are
accessible only in the creation/editing mode, when object's nodes are editable. This mode allows to use shapes for
any type of object and to combine several shapes (like ellipses) into a single object.

Example 1 - Star
Let's start with a simple example - a star shape used as a fill object.

1.
Click on the Fill Tool button in the tool bar at the left side of the screen. This will
start the creation/editing mode.

2.
Click on the work area to create the first node. Note that there is a spider leg
control on this node. This control indicates angles of underlay and cover stitches of
the fill.

3.

Use ∎ main menu >Shape >Star (5 points) to select the star shape.

4.

Click on the work area and draw shape with dragging cursor on the work area
with primary mouse button depressed. Release the button. Shape is not finished
yet. Its size and position is only approximate.

5.

Adjust the shape position and size with use of the nodes 1 and 2.



6. Click secondary mouse button anywhere on the work area to open the pop-up
menu. Select to Elements option.

7.

Shape is converted into the series of elements and nodes. The series begins and
end on a spot nearest to the first node created in step 2.

8.

Click secondary mouse button anywhere on the work area again. Select Generate
Stitches command from the pop-up menu that appears on the screen. Finished
object is plain fill object with shape of a 5 point star.

Note : on device without mouse, instead of a secondary button mouse click you can use a
pop-up menu button to invoke the pop-up menu.

Example 2 - Satin Stitch Ellipse
In creation/editing mode it is easy to combine several shapes into a single object. The most common case is drawing of
satin stitch ellipse.

1.
Click on the Column Tool button in the tool bar at the left side of the screen.
This will switch Studio into creation/editing mode.

2.
Click on the work area to place the first node of the object. The first node is
marked by a hairline cross.

3. Click on another place to create a base of the column object. Note that focused
node is displayed with thick border. The base is displayed as a dashed line. Both
edges will start in this base and end in another base at the opposite end of the
column. Basis are always straight lines and they define angle of stitches at
beginning and end of the column. Angle of stitches in between is interpolated from
these two basis.



4. Use main ∎ menu >Shape >Ellipse (8 Elements) to select the ellipse shape.
Lower number of elements is suitable for small ellipses, because it produces lower
number of nodes and is easier to edit. Higher number of elements in this case
means smoother shape closer to the ideal ellipse.

5.

Draw ellipse close to the focused point. Use nodes 1 and 2 to adjust ellipse size
and position accurately.

6. Click secondary mouse button anywhere on the work area and select to Elements
command from the pop-up menu.

7.

The first side of column is finished.

8.

Now click on the first node of the second side to focus it.

9.
Use ∎ menu >Shape >Ellipse (8 Elements) to select the ellipse shape
again.

10.

Draw second ellipse close to focused point.

11. Click secondary mouse button and select to Elements command from
the pop-up menu.

12.

Both sides of ellipse are drawn.



13.

Click secondary mouse button anywhere on the work area again. Select
Generate Stitches command from the pop-up menu that appears on the
screen. Finished object is plain column object with shape of ellipse.

Example 3 - Rounded Rectangle
The principle of rounded rectangle creation is the same as in previous examples. There is only one exception - this
shape uses additional controls for curvature of the corners. These controls are located in the tool box panel and they
look like this:

Use the first control to adjust the horizontal curvature of the rectangle corners. Second control affects the vertical
curvature. Adjustment of controls of this type is explained in the Parameters chapter.

Rounded rectangles with different amount of curvature.

User Guide > ^Menu - Select & Transform

Main Menu
Main Menu Panel contains combination of controls like menu items, buttons and combo boxes. It is context-sensitive,

which means that its content changes according to the actual working mode. The most important modes are described in
detail in this chapter. In other working modes, this panel contains only a few controls like Cancel button, Apply
button, etc., and its usage is intuitive.

Mode#1 - Select and Transform
This is the basic working mode. When you launch Studio, it enters this mode by default.



Menu panel in Select and Transform mode contains following menu items:

Design - Open/Save/Export/Merge designs
Select - Commands to select objects in the design
Options - Access to settings and parameters of objects
Image - Import/Export/Edit picture
Text - Lettering tools and functions
Objects - Commands to manipulate objects in design
Transform - Commands to transform objects in design
Groups - Commands to group and ungroup objects in design
Build - Commands to create complex objects
Convert - Conversion of objects to another type
View - Show/Hide objects, stitches, controls, etc.
Gadgets - Advanced tools like Sew Simulator, Pattern Editor, etc.
Help

User Guide > ^Menu - Select & Transform > ^Design

Main Menu - Design
The Design Menu is accessible only in select/transform mode.

The first command, Compile and Put into Embird Editor , compiles a design digitized in Studio and places it into
Editor so the design can be saved in desired embroidery format.

The next 6 commands are New, Open, Open Recent, Save, Save As, Merge . In all cases, the format is EOF. EOF
is native file format of the Embird Studio. It stores all design objects, lettering and background image in a single file.

Note: All open/save dialogs allow to paste path from clipboard into the file name edit box. Studio then
browses this file or folder. This function is intended for situations when you copy file or folder path into
clipboard in another program and you want to browse this file in Studio.

Save in Regular Studio compatible format ❏  Designs created in Studio Next are more advanced than
designs from regular Studio. Therefore, new *.eof design files cannot be opened in regular Studio. If you need to
move design from Studio Next to regular Studio, use this command to save design in older file format compatible
with regular Studio. Note: some Studio Next specific features like mesh objects and their parameters are not saved
when using this file format.

Merge ❏  adds selected design to the one already opened in Studio.

Export/Import ▶  sub-menu contains several commands:

Merge From Library ❏  command allows to import pre-digitized shapes from Studio's library folder.
Any design saved in compact format may be stored in the Library folder and used as a shape.



Shape from library - 2 color design.

Export ❏  command allows to convert vector design from Studio to other file formats. Current version
supports Scalable Vector Graphics *.SVG format and Embird Text Baseline *.ETB format.

Use export to SVG format if you need to transfer design from Studio to cutting software or graphic
programs like Corel Draw for further processing, or if you want to create vector illustration from the design.

SVG illustration of embroidery design can be exported with 3D effect, stitch or object animation, visualized
nodes and needle points, etc. All illustrations in this help file are SVG files exported from the Studio NEXT.
These illustrations are scalable without loss of detail and they can adapt to various page sizes, therefore.
Even raster (pixel) images can be converted to SVG files with this export command.

Design is exported into SVG in a real size. When exporting stitches, please note that overall size of
stitches may differ from size of the vector object they were generated from. The difference is caused by
several factors like pull compensation, dilatation gap, stitch sample, etc. In other words, stitches generated
from vector object in Studio are not supposed to have exactly the same size as the object itself.

Save in Compact Format (for internet) ❏  stores design in a scalable outline file without image
and stitches to achieve small file size. It is intended for internet delivery of embroidery files. Receiver of
such design can open it with Embird 2003 or later and resize it without loss of quality. Compact file has an
EOF extension just as normal design file, but it is much smaller in size. Digitizer should save her/his
design also in normal EOF format (Save, Save As) for further editing, if any. Compact format does not
include background image, guide lines and other data that are unnecessary for end user.

Save Selected As ❏  works like Save As, but only the selected objects are stored into the file.

The Import Vector File ❏  function opens the vector graphic file and converts it into the embroidery
design.

Color Palette sub-menu

Load Palette ❏

Save Palette ❏

These commands allow to copy customized color palette from one design file to another. Colors
are loaded to palette in the top part of the Main Control Panel. They serve to select color for
vector objects in design.

Border ▶  opens sub-menu with commands for creation and editing of user defined Border Samples.

New Border

Open Border ❏

Save Border ❏

Save Border As ❏

The last command is Exit , which follows the usual convention prompting user to name the design and choose a
location.

User Guide > ^Menu - Select & Transform > ^Select



Main Menu - Select
The Select Menu is accessible only in select/transform mode.

Commands in this menu allow to select vector objects with use of various criteria, or modify selection.

Scroll and Zoom to Selected

Zoom and Edit Selected Objects

Select All

Deselect

Invert Selection

New Selection

Add to Selection

Select Subset

Objects ▶

Fills ▶

All Fills

with Motif

with Auto-Column

Mesh ▶

All Mesh Objects

Sfumato Stitch ▶

All Sfumato Stitch Objects

Columns ▶

All Columns

with Pattern

Outlines ▶

All Outlines

Backward Paths

Redworks

Manual Stitches ▶

All Manual Stitches

Connections ▶

All Connections

Appliqués ▶



All Appliqués

All

Text /Alphabets/

Text /Font Engine/

The first command is Zoom to Selected Objects . This command scrolls selected object(s) to center of the screen and
zooms in or out to fit selection to the screen. It helps to localize object(s) selected in the Inspector window in the

work area.

Next command Zoom and Edit Selected Objects works in the same way as above command, but it also starts
nodes editing mode.

Invert Selection command unselects currently selected object(s) and selects the rest of objects. It can be used when
you want to apply some changes to most (but not all) objects. Select the those that should remain untouched and use
Invert Selection command to switch selection.

New Selection, Add to Selection and Select Subset options allow to define the way of how vector objects are selected
with rest of commands in this menu. These options work like radio buttons. Only one of them can be turned on. You can
define whether you want to make a new selection (and disregard existing selection, if there is any), or add objects to
existing selection, or select only certain objects from existing selection.

Example 1 - selection of all fills and outlines: 

1. Check the "Select>New Selection" option.
2. Use "Select>Fills>All Fills" command.
3. Check the "Select>Add to Selection" option.
4. Use "Select>Outline>All Outlines" command. All fills and all outlines in design are selected now.

Example 2 - restricted selection:

1. Select part of design in the work area or in the object inspector.
2. Check the "Select>Select Subset" option.
3. Use "Select>Outline>Backward Paths" command. Selection now contains only backward paths in the previously

selected part of design. It means that NOT all backward paths in design are selected, but only those that are inside
of previously selected part.

Rest of the commands in this menu allows to select multiple objects of the same type (like Manual Stitches , Backward
Paths or Fills with Motif ) at once. They work with either whole design or just selection, according to selection mode
defined by above options.

Commands for selection of text work only until you remove link from objects to respective text label with use of main
menu > Text > Convert Text to Normal Objects. When link is removed, object are no longer associated with text label and
cannot be selected with Select > Text commands.

User Guide > ^Menu - Select & Transform > ^Options

Main Menu - Options

Parameters ❏

Snap Objects ▶

☑ Snap Objects to Grid

☑ Snap objects to Guide Lines



Guide Lines ▶

☑ Lock Guide Lines

☑ Erase Guide Lines

Settings ❏

The Options Menu is accessible only in select/transform mode.

Parameters command opens the window parameters of design and its objects.

Snap Objects to Grid snaps selected objects to nearest grid line when user moves objects in the Transformation mode.
Objects are snapped only if they are near to the grid line. This function allows user to align objects with use of the grid
lines. It works with whole objects (not just edited nodes).

Snap Objects to Guide Lines snaps selected objects to nearest guide line when user moves objects in the
Transformation mode. Objects are snapped only if they are near to the guide line. This function allows user to align
objects with use of the guide lines. It works with whole objects (not just edited nodes).

Lock Guide Lines disables editing of guide lines and adding of new guide lines. Locking of guide lines prevents
unwanted seizure of guide lines when working with digitized objects in the Work Area.

Erase Guide Lines deletes all guide lines in the Work Area.

Use the Settings command to invoke window with Studio's settings like hoop size, grid, etc.

User Guide > ^Menu - Select & Transform > ^Image

Main Menu - Image

Import ❏

Export ❏

Tools ▶

Background Filters

Edit Image Window

Reduce Colors

Posterize

Rotate to Vertical

Rotate to Horizontal

Crop

Straighten

Move

Delete Image



The Image Menu is accessible only in select/transform mode.

Import is used to bring a raster image into the background as a template for digitizing; Studio can import an image in
JPG, GIF, BMP and PNG formats.

Studio ignores the DPI, resolution, or size set by the graphics program which generated the imported image, instead
using this scheme: 100 pixels = 1 cm of design size; 254 pixels = 1 inch. User may also select 'Scale image to fit current
hoop' option to scale image to hoop size while importing image.

Read Image Tools chapter to find out more about Background Filters and Edit Image Window

Read Image Color Reduction Tool chapter to find out more about conversion of image to limited palette colors

Read Image Posterization Tool chapter to find out more about flattening of the image colors

Rotate to Vertical and Rotate to Horizontal are tools for rotation of image. They are intended for precise rotation of
images that contain either vertical or horizontal objects or lines. Place rotation marks on the object (line) in the image
and then click right mouse button on 'arrows' symbol near the rotation mark. Select 'Rotate Image' from the pop-up
menu. Image will be rotated so that marked object is vertical or horizontal, respectively.

Rotation with Rotate To Horizontal tool.

Please note: use Edit Image Window for rotation of image with angle parameter.

Crop is tool for precise placement of crop marks and cropping of the image. Place crop marks on the image and then
click right mouse button on the 'scissors' symbol near the crop mark. Please note: Edit Image Window can be used for
cropping of image too.



Logo bounded by the crop lines.

Straighten is tool for compensation of the scanned image distortion. If deformed image has edges that are supposed to
be orthogonal, set the red marks on these deformed lines. Then click secondary mouse button on the Work Area and
select Straighten Image command from the pop-up menu. Image will be transformed so that selected shape becomes a
rectangle.

Note: it is also possible to transfer image to Studio with use of Copy (CTRL+C) and Paste (CTRL+V) commands.
Use CTRL+C in any graphic program to store raster image into clipboard. Then open Studio and use CTRL+V to
load image from the clipboard.

User Guide > ^Menu - Select & Transform > ^Text

Main Menu - Text
The Text Menu is accessible only in select/transform mode.

Text ...

Font Engine Text ...

Text with Selected Object as Baseline ...

Font Engine Text with Selected Object as Baseline ...

Edit Text

Convert Text to Common Objects

Import Baseline

Following 4 commands switch Studio to the lettering mode. There are two ways of how to create lettering in Studio: 1.
pre-digitized Alphabets, 2. Font Engine text. Both methods use very similar user interface, but they work with different
source of lettering.

Text inserts lettering from Embird Alphabets. Alphabets are pre-digitized Embird fonts that must be purchased
separately. Click anywhere on the Work Area to define the start point of text. If you click on existing text, it will switch



into editing mode. Otherwise, a new text creation begins. Program opens window for alphabet selection and parameters
and layout settings. Finished lettering is placed into Work Area of Studio. Unlike lettering in Embird Editor, which is in
plain stitches, lettering placed directly into Studio is in outlines and it is resizable, therefore. 

Font Engine Text inserts text from Embird Font Engine. Font Engine converts TrueType and OpenType fonts into
embroidery designs automatically. Click anywhere on the work area to define the start point of text. If you click on
existing text, it will switch into editing mode. Otherwise, a new text creation begins. Finished lettering is placed into Work
Area in outlines and it is resizable, therefore. Font Engine can be run also from Embird Editor, but result is lettering in
stitches. Font Engine is included in Embird (no separate download), but its registration password must be purchased
separately.

The difference between Font Engine and Alphabets is that Alphabets are pre-digitized fonts and Font Engine converts
any True Type or Open Type font automatically. Although Font Engine uses advanced techniques when filling letters with
satin stitches (auto column), result may be different to human digitizer approach, sometimes.

Above commands allow to create multi-line lettering by typing in the characters and automatic conversion to outlines and
stitches. If you digitize logo and there is no similar Alphabet ot font available, you may need to

digitize lettering manually with use of columns and connections.

Text with Selected Object as Baseline - same as Text command, but uses selected object in work area as a custom
baseline. This allows to use existing object (fill, column or outline, for example) as a baseline for lettering. This command
is useful when you want to draw baseline with freehand tool, or if you want to place text parallel to edge of existing
object.

Font Engine Text with Selected Object as Baseline - same as Font Engine Text , but uses selected object in work
area as a custom baseline.

Edit Text - access to editing of existing text. Select any part of existing text (letter or object) in work area or
object inspector and use this command. It will switch Studio to lettering mode and open respective text for editing.

When editing is finished, original text is replaced by the new one. If you have previously made some editing of text
objects on node-by-node level, these changes are lost.

Convert Text to Normal Objects - objects like fills, columns and connections belonging to some text label are linked
to this text label and marked by 'text label' Alphabets Text or 'text label' Font Engine Text in the object inspector window.
If you do not want to edit text on lettering level anymore, you can convert it to normal objects with this command. Link to
text is removed and it is possible to edit objects on node-by-node level.

Import Baseline command allows to import baseline in Embird Text Baseline *.etb file format. This command is intended
for use with old baseline files created in Studio. New lettering system allows to store lettering sessions (including
baseline) in the main design file, in a separate lettering file and to transfer lettering between designs with copy and paste
commands. Therefore, this command is provided only for backward compatibility.

User Guide > ^Menu - Select & Transform > ^Objects

Main Menu - Objects

Copy

Paste

Edit Nodes

Generate Stitches

Delete

Duplicate

Erase Stitches

Sort ▶

Sort Colors



Sort Types

Sort Sizes

Order ▶

To Back

To Front

Color ▶

Define Color ❏

Pick Color from Image

Pick Color from Image /3x3 sample/

Pick Color from Image /5x5 sample/

Color from Thread Catalog ❏

Tune Colors

The Objects Menu is accessible only in select/transform mode.

Clipboard operations Copy and Paste can be used for moving objects between separate designs.

Edit Nodes switches selected object to editing mode.

Generate Stitches computes stitches for selected objects. The same effect can be achieved with double click on object
icon in Object Inspector window.

Sort Colors function changes order of selected objects so that objects of the same color are in the successive order.
This function helps to eliminate the color changes.

Sort Types function changes order of selected objects so that objects of the same type are in the successive order.

Sort Sizes function is very important for editing of objects imported from vector graphics files like SVG. Such files
often contain large number of a very small objects (often smaller than 1 millimeter) that are not possible to sew out and
they spoil embroidery design. Use Sort Sizes command to re-order imported objects according to their size. Then select
too small objects and delete them.

Order submenu contains functions for change of the selected object(s) order.

Tune Colors allows to adjust colors of all selected objects, or even whole design at once. Tune Colors command
opens window with Brightness, Contrast, Gamma, Saturation and color balance controls (Cyan-Red, Magenta-Green,
Yellow-Blue). These controls work with color of vector objects and stitches (thread), not with the image colors.

Left: original colors before tunning. Right: brightness increased for all objects at once.



User Guide > ^Menu - Select & Transform > ^Transform

Main Menu - Transform
The Transform Menu is accessible only in select/transform mode.

Undo

Redo

Snap to Previous Object

Flip & Rotate ▶

Flip Vertically

Flip Horizontally

Rotate Left

Rotate Right

☑ Apply Rotation to Fill Stitches

Transformations Window

Center ▶

Bring to Center

Center Vertically

Center Horizontally

Columns ▶

Change Column Width

Broaden Thin Parts of Column ▶

0.5 mm

0.6 mm

0.7 mm

0.9 mm

1.1 mm

1.3 mm

1.5 mm

1.7 mm

2.0 mm

Offset ▶

Expand Object



Shrink Object

Reduce Nodes Number

Envelope

These commands work on objects selected with the Transform Tool (arrow) or in Objects Inspector.

Use the first command, Snap to Previous Object , to eliminate a jump caused when an object is moved accidentally.

Use Flip Vertically to flip selected objects along the horizontal axis.

Use Flip Horizontally to flip selected objects along the vertical axis. 

Use Rotate Left to rotate selected objects 90 degrees anti-clockwise.

Use Rotate Right to rotate selected objects 90 degrees clockwise.

Note : Apply Rotation to Fill Stitches option. If this option is checked, angles of cover stitches and zig-zag
underlay of Fill objects are adjusted whenever the object is rotated or mirrored. There are several function that
use this setting: common rotation, flipping, corner function, auto-repeat function. If this option is not checked,
stitch angles remain the same regardless of object rotation and mirroring.

Transformation window allows user to make transformationslike objects movement, rotation, skewing, resizing and
change of order. These operations are all available in an interactive form directly in the Work Area or in

Object Inspector window. Moreover, Transformations window allows user to align and distribute selected objects
within selection. Find out more about Transformations window here.

The next command, Bring to Center , is to help when an object is moved accidentally off the Work Area. Select the
object in the Object Inspector window and click Center to bring the object back to the Work Area.

Center Vertically and Center Horizontally commands center selected objects according to respective axis.  

Change Column Width allows user to make selected column objects wider or narrower.

Broaden Thin Parts of Column is intended for making thin columns parts like serifs on lettering wider for better sewing.
Only those section of column object that are narrower than given width are broaden. The rest of column remain
unchanged.

Expand Objects enlarges selected objects by offsetting the object contours. It is intended for creation of overlay of
constant width between adjacent objects. Expand Objects command does not provide the same result as normal
enlargement.

Shrink Objects reduces size of selected objects by offsetting the object contours. Shrink Objects command does not
provide the same result as normal size reduction. You can use it for fill opening to make it smaller, in order to create
overlay between opening and another object that covers the opening.

Reduce Nodes Number removes nodes from selected objects according to chosen "Simplicity" parameter. This
function is intended mainly to smooth lettering with distorted edges and large number of nodes, which is hard to edit
node-by-node.

Envelope command allows to deform selected object(s) with envelope curves.



User Guide > ^Menu - Select & Transform > ^Groups

Main Menu - Groups
The Groups Menu is accessible only in select/transform mode.

Group 1

Ungroup 1

Group 2

Ungroup 2

Group 3

Ungroup 3

Group 1, Group 2 and Group 3 are functions for combining several objects into one for easier manipulations. They
allow user to create hierarchically organized combined objects. This hierarchy simplifies the editing of combined parts.

Use Ungroup 1, Ungroup 2 and Ungroup 3 commands to divide groups on respective levels.

Groups chapter contains detailed description and example of how to use Group and Ungroup commands.

User Guide > ^Menu - Select & Transform > ^Build

Main Menu - Build

Create Connection to Previous Object

Auto-Outliner

Corner ...

Auto Repeat ...

Shaping ▶



Union

Intersection

Difference

Outlines ▶

Arrange Outline Parts

Arrange Outline Parts /no Connections/

Create Backward Path

Delete Backward Paths

Combine Outlines

The Build Menu is accessible only in select/transform mode.

The first command, Create Connection to Previous Object , is designed for designs where the selected object does
not touch the previous object; invoking this command will place a Connection object between noncontiguous objects
to eliminate jump stitches.

Auto Outliner function automatically creates a double-layered thin outline around selected object(s).Outlines
Overview chapter decribes also other methods to digitize outlines.

Corner ... command opens window with options to copy selected objects symmetrically into the hoop corners.

Corner options are:

1. Place - copy objects as they are,
2. Mirror - each corner is mirrored,
3. Rotate CW - each corner is rotated clockwise with respect to the previous corner.
4. Rotate CCW - each corner is rotated counter-clockwise with respect to the previous corner. Please note: if Apply

Rotation to Fill Stitches option in the main menu > Transform is checked, stitches angle is adjusted when object is
rotated.

Auto Repeat ... command opens window with options to duplicate selected objects along line, around the circle or
rectangle, or to fill rectangular area. It is possible to set distance (gap) between the objects.



In this example the triangle at top was auto-repeated 8 times around the circle.

Shaping submenu contains command for so called Boolean operations on filled areas, like union, intersection and
difference .

Arrange Outline Parts creates complex thin outlines with double stitching from separate elements.

The Create Backward Path command can be used on series of Outline, Manual Stitches or Connection objects to
duplicate and reverse these objects. Doing this will result in two paths: one path, from beginning to end, created by user
and the other path, from end to beginning, created by Studio. Create Backward Path command does not work if there is
already some backward path among selected objects. For overview of outline methods click here.

Delete Backward Paths command is meant for situation when complex outline created with Arrange Outline Parts must
be edited. Use this command to delete all backward paths in selected objects and thus to achieve original outline parts
without second layer of stitching (backward paths). Make editing of parts and then use Arrange Outline Parts again to
rebuild the complex outline. 

Combine Outlines makes single outline object from series of outlines. 

User Guide > ^Menu - Select & Transform > ^Convert

Main Menu - Convert
These commands work on objects selected with the Transform Tool (arrow) or in Objects Inspector.

Fill, Mesh & Sfumato ▶

Create Outlines from Fill

Create Columns from Fill

Create Outlines from Mesh

Create Separate Outline Elements from Mesh

Fill to Opening

Fill to Sfumato

Sfumato to Fill

Fill to Mesh

Mesh to Fill

Area to Center Outline

Create Fill from Opening



Outline ▶

Create Columns from Outlines

Create Fill from Outline

Outline to Connection

Outline to Carving

Split Border into Elements

Split Overlock into Elements

Column & Applique ▶

Column to Applique

Applique to Column

Column with Pattern to Column

Column to Column with Pattern

Column to Outline

Column to Fill

Split Applique into Layers

Connection & Manual Stitches ▶

Connection to Manual Stitches

Connection to Outline

Manual Stitches to Connection

to Editable Stitches

The Convert Menu is accessible only in select/transform mode.

Create Outlines from Fill creates outline object from selected fill object. If fill object has openings, Studio will create
also outlines of openings as a separate objects. Start point of each outline is identical to start point of the corresponding
fill or opening. It is often desirable to place start of outline on the place where fill ends. Switch outline to editing mode and
use Place Start Point here command from pop-up menu to change the outline start point.

Create Columns from Fill creates complex object composed of columns and connections from selected fill object. It
is intended mainly for cases when user uses Auto Column option for fill object and more parameters than provided by
Auto Column are needed.



Create Outlines from Mesh .
If mesh is multi-layered , it creates complex object composed of forward and backward outlines from selected mesh
object. It is intended for cases when user wants to edit mesh paths manually.

If mesh is single-layered , it creates object composed of outlines and connections. Outlines in this case are single-run
(no backward path) and any outline mode like satin stitch, samples, etc. can be applied to them.

Create Separate Outline Elements from Mesh .
This command converts mesh into outline elements which have no backward paths and are not arranged into continous
sequence. This command is intended for those who need to do deeper editing of generated mesh fill.

Create Column from Outlines creates column object from selected outline.

Split Border into Elements creates complex object composed of columns and/or outlines and/or connections from
selected outline object. It is intended for cases when the user needs to edit the parts of the predefined border outline
(like rope border, for example).

Split Overlock into Elements creates complex object composed of columns and/or connections from selected outline
object. It is intended for cases when the user needs to edit the parts of the predefined overlock outline.

Create Fill from Opening creates a new fill object from selected opening in existing fill. Opening must be selected in the
Parts Inspector window. This command is intended for situation when user needs to create cover stitches of other color
for a hole (opening) in the fill. User should adjust the newly created fill object so that it overlaps the opening underneath,
in order to create overlay to avoid gaps in stitching.



Create Fill from Outline creates a new fill object from selected outline objects. If outline is not closed, Studio
automatically closes the newly created fill object.

Split Applique into Layers creates separately editable layers from selected applique objects. These layers include
following objects: 1. marking stitches - outline object(s), 2. tack-down stitches - column object(s), 3. cover stitches -
column object(s).

Left: applique object with all layers. Right: layers moved to the side for better view.

It is important to note that all above commands will duplicate an object and then convert the new object as selected. For
example, if the Create Columns from Outlines command is selected, Studio will duplicate the object, leaving the first one
an Outline object, and converting the second one to a Column object. 

Next commands are:

Applique to Column
Column to Applique
Column with Pattern to Column
Column to Column with Pattern
Column to Outline
Column to Fill
Connection to Manual Stitches
Connection to Outline
Manual Stitches to Connection
Outline to Connection
Outline to Carving
Fill to Opening
Fill to Sfumato
Sfumato to Fill
Fill to Mesh
Mesh to Fill

Each of them converts objects from one type to other. They do not duplicate objects. Column to Applique joins
beginning and end of object, because Applique object must form a closed loop. Functions Column to Outline and
Column to Fill convert also Columns with Pattern and Appliques to Outlines and Fills.



Column to Column with Pattern

Column with Pattern to Column

If you have Font Engine module for Embird, command Fill to Mesh can be used to create intricate embroidery
lettering from True Type and Open Type fonts.

1. Use Lettering tool to create text
2. Select fill objects and convert them to mesh objects with about command
3. Select converted mesh objects and use Parameters window to set requires mesh style

Please keep in mind that mesh object must be large enough to achieve good-looking mesh pattern.

Special command Areas to Centerline allows to create redwork object(s) from fill or column object(s). Result is a set of
outline elements, which have to be combined into single outline object with use of ∎ main menu > Build > Outlines >
Arrange Outline Parts function. This function is mainly intended for creation of redwork lettering.



Command to Editable Stitches converts stitches in selected vector objects to editable manual stitches. Create any
object as a start and then use this function to access and edit individual stitches. This function can be used for precise
adjustment of motif fill, for example.

User Guide > ^Menu - Select & Transform > ^View

Main Menu - View
The View Menu is accessible only in select/transform mode.

Use this menu configure view mode and to hide/show objects, boundaries or stitches. Objects boundaries are lines and
curves visible only on the screen. They are not actual stitches.  

☑ Objects Boundaries

☑ Stitches

☑ Jumps

☑ Fabric (in 3D)

☑ Hoop (in 3D and Flat mode)

☑ Thicken One-way Outlines

Objects ▶

☑ Fills

☑ Mesh Objects

☑ Sfumato

☑ Carvings

☑ Columns

☑ Columns with Patterns

☑ Outlines

☑ Manual Stitches

☑ Connections

☑ Appliques

Show/Hide Objects ▶

Show All

Show Selected

Show All Except Selected

Hide Selected

Hide All Except Selected

Hide All Before Selected



Hide All After Selected

Layout ▶

☑ Rulers

☑ Guide Lines

☑ Grid

Unlike the Eye icon in the Object Inspector window which hides/shows only particular objects, commands in the
Show/Hide Objects submenu affect all objects that fit user-specified criteria. Showing and hiding of design parts is
useful for creation of complex design, when you need to hide some parts of design to see others. 

Jumps displays jumps stitches between objects or inside of objects that may contain jumps (Sfumato objects, for
example). Jumps between objects are also always indicated in the Object Inspector window by small red scissors icon
next to the object icon.

Thicken One-Way Outlines displays those outline objects that have no backward paths as a thick lines or curves. This
helps user to identify which parts of outline need second layer of stitches, i.e. backward path.

User Guide > ^Menu - Select & Transform > ^Gadgets

Main Menu - Gadgets
The Gadgets Menu is accessible only in select/transform mode.

Fragment Editors

Style Editor

Stitch Analysis

Sew Simulator

Fragment Editors displays window for creation of custom fill patterns, motifs and outline samples and for
assignment of user defined border samples.

Style Editor allows to define and apply optimized parameters for sewing on different materials.

Stitch analysis provides insight into characterics that are crucial for quality of design. More about this tool can be found
in the Stitch Analysis chapter.

Sew Simulator helps to analyze the stitches order of design. Stitch simulation is animation of stitching process.

User Guide > ^Menu - Editing

Main Menu
Main Menu Panel contains combination of controls like menu items, buttons and combo boxes. It is context-sensitive,

which means that its content changes according to the actual working mode. The most important modes are described in



detail in this chapter. In other working modes, this panel contains only a few controls like Cancel button, Apply
button, etc., and its usage is intuitive.

Mode #2 - Node Editing
This mode is activated when you start node-by-node vectorization or editing.

Menu panel in Node Editing mode contains following menu items and buttons:

Edit - Undo / Redo, turn ON/OFF the Insert Element Mode, Stop editing mode.
Shape - Commands to insert predefined shapes like star, rectangle, ellipse, etc.
Nodes - Commands to add or delete nodes, select, align or snap individual nodes.
Edge - Commands to swap, reduce, close, reverse, delete or mirror whole edge.

Insert node into highlighted element on the edge.

Delete highlighted node.

Change edge element to curve.

Change edge element to line.

Close edge.

Snap focused node to closest node.

Swap edges of Column or Applique object.

Switch ON or OFF the Insert Elements mode.



User Guide > ^Menu - Editing > ^Edit

Editing Main Menu - Edit

Undo

Redo

☑ Insert Elements Mode

End of Segment

Stop Editing Process

The Edit Menu is accessible only in creation/editing mode.

Learn about Insert Elements Mode in respective chapter.

End of Segment command inserts partition line into column or appliqué, dividing it into so called segments. One point of
the new segment end line is the selected node and the other point is found automatically on the opposite side (the
nearest node).

Segment ends serve to define stitch direction inside column or appliqué. When generating stitches for columns and
appliqués, program takes into account direction of segment end lines and conforms stitches direction on those places.

End of segment - effect on column stitch directions.

User Guide > ^Menu - Editing > ^Shape

Editing Main Menu - Shape

Ellipse ▶

Ellipse /4 elements/

Ellipse /8 elements/



Ellipse /16 elements/

Triangle

Rectangle

Rounded Rectangle

Polygon ▶

Polygon /5 sides/

Polygon /6 sides/

Polygon /8 sides/

Star /5 points/

To Elements

Cancel Shape

The Shape Menu is accessible only in creation/editing mode.

Basic shapes like ellipse, rectangle, etc. are available from this menu. These shapes can be used only in the node
editing mode. To use any of these shapes, place at least one node in the Work Area, then select one of the shapes
and draw it in the Work Area. Use secondary mouse click or pop-up menu and select To Elements from the small pop-
up menu. Studio will move the last node to the nearest point on the shape just created and the shape will be started from
that point. This means the shape can be started from any point.

Basic shape - star. Nodes 1 and 2 define the size of the star. Node 3 defines chosen start point
of the shape.

There are 3 types of ellipse available in the Shape menu: ellipse with 4, 8 and 16 elements. Ellipses with low number of
elements are not perfectly elliptical and they should be used only for a small objects. For a large object, use the 16
elements ellipse.

User Guide > ^Menu - Editing > ^Nodes

Editing Main Menu - Nodes

Insert Node

Delete Node



☑ Edit All Nodes

Align ▶

Align Beginning to Previous Object

Align End to Next Object

Align Outline Beginning to Beginning of Previous

Rectify Element Direction

Snap ▶

☑ Snap to Work Area Edges

☑ Snap to Nodes

☑ Snap to Guide Lines

☑ Snap to Grid

☑ Snap to Object Edges

Snap to Nearest Node

Select ▶

Select First Node

Select Last Node

Select Next Node

Select Previous Node

The Nodes Menu is accessible only in creation/editing mode.

Edit All Nodes enables/disables possibility to select and move nodes in editing mode. When disabled, user can edit only
last 2 nodes on each edge. This option is useful when nodes are near one to another and cursor selects existing node
instead of creating a new one. This option allows to 'lock' most of the nodes so that they do not interfere with new nodes.

The first command, Align Beginning to Previous Object , moves the beginning of an edited object to the end of
previous object. Use this command to assure there will be no jump stitch between the two objects.

The next command, Align End to Next Object , causes the end of the object being edited to the beginning of the object
to be created next.

Align Outline Beginning to beginning of Previous . When doing a complex outline, some outline parts start not on
end of previous part, but on its beginning, instead. Use this function to place beginning of the new part exactly on
beginning of previous part. Although 'Arrange Outline Parts' function allows some deviation in parts placement, the use
of this function may help to reduce 'Parts are not close enough' problems.

Rectify Element Direction . Aligns nodes of focused element so that element becomes vertical, horizontal or diagonal.
Direction is chosen automatically as a best match to original direction of element.

Snap nodes to Work Area Edges , Snap to Guide Lines , Snap to Nodes , Snap to Grid , Snap to Object Edges
are options for alignment of nodes during editing or creation of object. Nodes are snapped only if they are near to the

Work Area edges, guide lines, other nodes, grid lines or edges of other objects, respectively.

Note: : there are other snap option under the ∎ main menu > Options . However, these options serve to
snap whole objects (not just edited nodes).

Snap to Nearest Node command moves selected node on top of nearest node which belongs to other object. It means
that it does not snap selected node to nodes of actually edited object, only to nodes of other objects. This command



helps to align nodes precisely.

Select First, Last, Next and Previous Node commands select respective node on the vector edge. These commands
help to locate first and last node on complex edges with large number of nodes.

User Guide > ^Menu - Editing > ^Edge

Editing Main Menu - Edge

Swap Edges

Reverse Nodes Order

Delete Whole Edge

Create Second Edge

Reduce Nodes Number

Mirror ▶

Duplicate and Mirror

Duplicate and Mirror Horizontally

Duplicate and Mirror Vertically

Close Edges

The Edge Menu is accessible only in creation/editing mode.

Swap Edges is the next command; it is intended for columns and other objects that have two sides. Swap Edges is used
to change the sides in in order to end stitching of that object on other side.

Reverse Nodes Order comes next; it changes the order of nodes. This is another method to change which stitch will be
last. 

Use Delete Whole Edge command to erase whole edge and start its creation anew.

Create Second Edge command works on columns and objects with two sides. Create one edge and the first point of the
second edge, then use this command. The second edge will be parallel to the first and the segment end will be placed
after each element of edges.

Reduce Nodes simplifies edge containing large number of nodes by combining elements together and thus reducing
also the nodes number on the edge.

Duplicate and Mirror command help to create symmetrical objects. Draw first part of the object and then use Duplicate
and Mirror command to create second part of the object, which is symmetrical to the first part about the axis passing
through the first and last node.



Duplicate and Mirror Horizontally and Duplicate and Mirror Vertically work in a similar way, but the axis of the
symmetry is vertical and horizontal straight line passing through the first node.

Creation of object symmetrical about both horizontal and vertical axes is explained on the following example:

1. Create one quarter of the object.
2. Use Duplicate and Mirror Vertically command.
3. Use Duplicate and Mirror Horizontally command.

User Guide > ^Menu - Lettering

Main Menu
Main Menu Panel contains combination of controls like menu items, buttons and combo boxes. It is context-sensitive,

which means that its content changes according to the actual working mode. The most important modes are described in
detail in this chapter. In other working modes, this panel contains only a few controls like Cancel button, Apply
button, etc., and its usage is intuitive.

Mode #3 - Lettering
This mode is activated when you start text typing or editing.

Menu panel in Lettering mode contains following menu items and buttons:

Tools - Undo/Redo changes. Load/Save lettering. Paste text from clipboard. Stop lettering mode.
Font - Scan fonts (not applicable to Alphabets). Font styles like Bold, Italic, Vertical, Other Side.
Nodes - Baseline nodes operation like Insert, Delete, etc.

Stop and cancel Lettering Mode.



Finish Lettering Mode.

Finish Lettering Mode and generate stitches for the letters.

Combo box: text alignment

Combo box: sewing order of characters

Combo box: fill and outline kind

Combo box: connection stitches

User Guide > ^Menu - Lettering > ^Tools

Lettering Mode - Main Menu - Tools

Undo

Redo

Load

Save

Paste

Erase

Reset ▶

Reset Spacing

Reset Layout

Reset All



Stop Alphabet / FontEngine Mode

User Guide > ^Menu - Lettering > ^Font

Lettering Mode - Main Menu - Font

Find Fonts

☑ Other Side

☑ Vertical

☑ Bold

☑ Italic

☑ Flatten Composite Glyphs

Flatten Composite Glyphs option allows to correctly process rare TrueType and OpenType fonts made from piled-up
blocks instead of common contours.

Left: glyphs made from piled-up blocks. Right: glyphs flattened to contours.

Fonts made from blocks are relativelly rare. However, if you want to convert such a font into embroidery, flattening is
necessarry.

Note : do not use flattening on common fonts, it will eliminate holes in glyphs.

User Guide > ^Menu - Lettering > ^Nodes

Lettering Mode - Main Menu - Nodes

Insert Node

Delete Node

To Curve

To Line

Smooth



Close Baseline

User Guide > ^Image

Image
Raster image is often a base upon which an embroidery design is created in the Studio. Image is imported into Work
Area and serves as a template to digitize from. All digitizing work is done on top of the image layer, therefore is it often
reffered to as a background image.

Use of the background image for digitizing is usefull in many cases, but it is not mandatory. You can leave the image
layer empty and create design on a clean background if you preffer to.

To bring image into the background of design, use ∎ main menu > Image > Import command.

Raster image is composed of square color dots called pixels (or picture elements), which in general have no exact
physical size and are rendered on each device in different size. When used as template for digitizing, some physical size
must be assigned to image pixels so that design drawn on top of image has required physical size. Studio uses fixed
ratio between image pixels and design dimensions. 10 pixels equal 1 millimeter size, which is the same as 254 pixels for
1 inch size.

Digitizing of embroidery objects means creation (either manual or automatic) of vector objects with just few control
nodes on top of the raster layer. Studio then fills digitized vector boundaries with stitches, which are the final product of
digitizing.



Structure of embroidery design in Studio: 1. raster image (optional), 2. digitized vector objects, 3.
final product - stitches. When saving design to a disc or other storage, all layers are kept in the

same file.

Before imported raster image is suitable for digitizing, it often needs some adjuments. Studio provides
tools for trimming and enhancement of raster images.

User Guide > ^Image > ^Image Tools

Image Tools
These tools serve to edit raster image used as a template for digitizing.

To bring image into the background of design, use ∎ main menu > Image > Import command.

Image Tools include:

1. Background Filters
2. Edit Image Window
3. Reduce Colors
4. Posterize
5. Rotate to Vertical tool
6. Rotate to Horizontal tool
7. Crop tool
8. Straighten tool
9. Move tool

Background Filters
Background filters affect the way the background (hoop or imported image) is displayed behind the digitized design.

In contrast to graphics programs where the main meaning of filters is to enhance the look of an image, filters in Studio
are intended for dimming, darkening, brightening or other adjustment of image so that its colors do not interfere with



stitches and objects drawn on top of the background image. All these parameters are saved with design into one file.

Left to right: 1. increased brightness, 2. decreased saturation, 3. hue moved to yellow

There are three groups of controls in Background Filters:

1. Luminosity - Brigthness, Contrast and Gamma .
2. Saturation
3. Hue - hue is achieved as a balance between cyan and red, magenta and green, blue and yellow. Shadows,

midtones and highlights can be balanced separatelly.

Gamma control changes brightness mostly of dark colors and it does not affect absolute black and white. It is useful for
too dark or too bright scans and photos.

Saturation control changes colors from vivid to bleak and to a grayscale.

The Cyan-Red ,Magenta-Green andYellow-Blue controls affect the color balance of the background. Use them to
change an image to a certain shade (blue, for example) to separate image from digitized objects. The resulting contrast
makes it easier to distinguish between the background and digitized objects.

Edit Image Window

The Edit Image Window is accessible through ∎ main menu under Image > Tools > Edit Image Window .
Controls in this window allow user to rotate and resize image and add border to image for easier digitizing near edges of
image.

After importing the image, invoke theEdit Image window and make adjustments in the following order:

1. Rotate image
2. Size - set new size of image after rotation.
3. Expand - add empty border around the image.

After above steps, click Apply button in menu panel to perform changes.

Note: use ∎ main menu > Image > Tools Rotate to Vertical and Rotate to Horizontal commands for
precise rotation of images that contain straight vertical or horizontal features.

Reduce Colors
The tool for reduction of color number in the raster image is described in a separate chapter Image Color Reduction Tool
.



Paletted image with reduced color number

Posterize
Posterization merges adjanced pixels of similar color, which results in a simplification of the image.

The tool for posterization of the raster image is described in a separate chapter Image Posterization Tool .

Image after posterization

Rotate to Horizontal
If image to be rotated contains distinctive horizontal feature, rather than by guessing the angle of rotation in Image
Edit Window use the Rotate to Horizontal tool. Place control handles along feature that will become horizontal and click
Apply.



Rotate to Vertical
This tool is identical to Rotate to Horizontal tool with a single difference - it works with vertical features and rotates
image so these features become vertical.

Crop
This tool uses two handles to frame the part of image that will be cropped after clicking Apply button.

Straighten
This tool works in a similar way as previous tools. It uses 8 handles to straighten bent or skewed image to perfect
rectangular shape. It is intended mostly for scans and photos.



When depressed, forces new lines and curves to precise horizontal, vertical or diagonal
direction in edit/create mode. If used with Shapes, creates precise circle instead of
ellipse and square instead of rectangle. CTRL key has other meaning in

lettering mode and also in User Pattern Editor.

CTRL

Zoom to selected object(s)CTRL+1

Zoom to selected object(s) and switch to the nodes editing mode.CTRL+2

Select all objects (in transformations mode)CTRL+A

Deselect (in transformations mode)CTRL+Shift+A

Open export design dialog windowCTRL+Shift+E

Create backward path to selected outline objects.CTRL+B

Copy selected objects into clipboardCTRL+C

Duplicates selected objectsCTRL+D

Edit. Switch selected object(s) to the nodes editing mode.CTRL+E

Compile design and send it to the Embird Editor for further processing.CTRL+F

Generate stitches for selected objects.CTRL+G

Import imageCTRL+I

Merge fileCTRL+M

New fileCTRL+N

Display parameters windowCTRL+P

Save designCTRL+S

Text (Embird Alphabets)CTRL+U

Paste objects from clipboardCTRL+V

RedoCTRL+Y

UndoCTRL+Z

Create connection to previous objectCTRL+INSERT

Align beginning of object to end of previous object (in editing mode)CTRL+F1

Align end of object to beginning of next object (in editing mode)CTRL+F2

Align beginning of outline object to beginning of previous outline object (in editing
mode)

CTRL+F3

Background Filters (Image colors)CTRL+ALT+B

Move
This tool works in a similar way as previous tools. It uses 2 handles to define direction and distance to move the image.

User Guide > ^Shortcut Keys

Short-cut Keys
If your device uses hardware keyboard then the most frequently used functions can be accessed with short-cut keys.
Below list contains all short-cuts available in Studio.



"Bring to Center". Moves selected objects to center of the Work Area.CTRL+ALT+C

Delete second edge parallel to first edge (in editing mode)CTRL+ALT+E

Display Edit Image windowCTRL+ALT+I

Convert fill to outlineCTRL+ALT+O

Display Transformations windowCTRL+ALT+T

User EditorsCTRL+ALT+U

Insert text from Embird Font Engine. Inserts lettering converted from TrueType fonts
to embroidery design.

CTRL+Shift+U

If any vector object is selected in the work area, launch thread catalog window to
choose new color for this object.

CTRL+Shift+K

Snap selected node to nearest node2

Place beginning of object to end of previous object3

Place second beginning point (for columns-type objects) to end of previous object4

When creating outline object, pressing this key performs these three operations at
once: 1. outline object is finished, 2. backward path is created to the outline object, 3.
outline object and its backward path are joined into single object.

b

Add new line part to edgee

Add new line part to second edge (for columns- type objects)r

Add new curve part to edged

Add new curve part to second edge (for columns- type objects)f

Changes first zigzag underlay angle of fill object in the creation/editing mode.i

Changes second zigzag underlay angle of fill object in the creation/editing mode.o

Changes cover stitches angle of fill object in the creation/editing mode.p

Works like secondary mouse button to invoke pop-up menus in Work Area, color
palette and Object Inspectorlist. It is intended for use with stylus pen.

x

Finish object creation/editing, if possibleSpace

Cancel object creation/editing. Dismiss dialog windowEsc

Confirm dialog windowEnter

Scrolls Work Areaarrow keys

Moves selected objects in transform mode and selected node in edit/create
mode.

arrow keys +ALT+CTRL

Zoom out-

Zoom in+

Zoom outPage Up

Zoom inPage Down

To Front (order of objects)SHIFT+ Page Up

To Back (order of objects)SHIFT+ Page Down

Deletes selected objects (in transformations mode). Deletes an element that ends with
selected square (in creation/editing mode).

Delete

Inserts a new element before selected square node in creation/editing mode.Insert



Inserts a Segment End at selected square node in creation/editing mode.End

Description of ALT key use in lettering mode is available in Interactive Lettering
chapter.

ALT

Hide / Show boundaries of objectsALT+B

Snap node to nearest node (creation/editing mode)ALT+C

Hide / Show gridALT+D

Hide / Show fill objectsALT+F

Hide / Show guide linesALT+G

Hide / Show jumpsALT+J

Hide / Show columnsALT+L

Hide / Show manual stitchesALT+M

Hide / Show columns with patternALT+N

Hide / Show outline objectsALT+O

Hide / Show appliquesALT+Q

Hide / Show rulersALT+R

Hide / Show stitchesALT+S

Hide / Show button barALT+T

Hide / Show sfumato objectsALT+U

Hide / Show carvingsALT+V

Hide / Show one-way outline objectsALT+W

Hide / Show connectionsALT+X

Hide / Show zoom windowALT+Z

Activate Transform toolALT+F1

Activate Edit toolALT+F2

Activate Zoom toolALT+F3

Opens help filesF1

Create Fill objectF2

Create Sfumato objectF3

Create Opening objectF4

Create Carving objectsF5

Create Column objectF6

Create Column with Pattern objectF7

Create Outline objectF8

Create Manual Stitch objectF9

Create Connection object

Create Applique objectF11

Create Hole for Applique object
F12



Starts creation of new object without need to select
any tool. The new object is of the same type as the
previous object. This short-cut helps to create series of
object of the same type faster.

Double click on Working Area

This action temporarily switches on the pan tool
instead of actual working mode. When button is
released, program returns to previous mode. This
helps to scroll the work area quickly, without using any
control (scroll bars).

Secondary mouse button depressed +
dragging cursor over Work Area

If double clicked on object icon, stitches are generated
for this object

Double click on Object Inspector
window

In nodes creation/editing mode - selects first node on the edge. Helps to locate first
node on complex edge with many nodes.

Home

In nodes creation/editing mode - selects last node on the edge. Helps to locate last
node on complex edge with many nodes.

End

In nodes creation/editing mode - selects previous node.CTRL+Home

In nodes creation/editing mode - selects next node.CTRL+End

In nodes creation/editing mode - activates Fast Node
Insertion mode to allow insertion of new nodes after
any selected node, not just the last one. Helps to
speed-up nodes insertion and helps to avoid
undesired selection of existing nodes.

a + primary mouse button click

When creating a new object, TAB key on hardware keyboard can be used to quick
adjustment of the curve elements. Create new curve element with TAB key instead of
primary mouse button. Then move the mouse with TAB key depressed to adjust the
curve. Then release the TAB key. Please note: to use the TAB key for curves
adjustment, the edge mode must be set to 'curve'.

Tab

User Guide > ^Transformations

Transformations

Transformations like resizing, moving, rotation and skewing are very common operations. These operations can be
done interactively with tool described below, or with numeric controls accessible in Transformations Window .

Move or Resize



Object selected for move and/or resizing.

To transform object(s) interactively in the work area, select object(s) and:

to change size proportionally, press primary mouse button on any corner handle and drag to desired size.
to change size non-proportionally, press primary button on a middle handle and drag to desired size.

Proportional scaling Non-proportional
scaling

Rotate or Skew
To switch transformation mode click the icon in the middle of selection box. The mode switches between move/resize
and rotate/skew.

Object selected for rotation and/or skewing.

to rotate, press primary button on any corner handle and drag to desired position. Please note: if Apply Rotation
to Fill Stitches option in the ∎ main menu > Transform is checked, stitches angle is adjusted when object is
rotated.
to skew, press primary button on any middle handle and drag to desired shape.



Rotation Skewing

Selection with Marquee Box
There are 2 ways of how to make selection of objects with marquee box:

1. Drag marquee box from left to right to select objects without completely enclosing them with a marquee box
2. Draw marquee box from right to left to select only those objects that lay completely within the marquee box.

User Guide > ^Transformations > ^Transformation Window

Transformations Window
The Transformations window is accessible via ∎ main menu > Transform > Transformations Window . It allows to
do three types of operations on selected objects: 1. transformations, 2. alignment, 3. distribution. Buttons to switch
between these three operation types are in the vertical tool box.



Transform Functions

Transform controls do the same operations that are available also in an interactive form in the work area or
Object Inspector: movement, rotation, skewing, resizing and change of objects order.

Rotation uses center (reference) point that can be moved in the work area with mouse cursor.

Note: if Apply Rotation to Fill Stitches option in the ∎ main menu > Transform > Flip & Rotate is
checked, stitches angle is adjusted when object is rotated.

Align Functions

Alignment works with two or more selected objects.

Three objects selected in the Work Area.

Three horizontal controls align selected objects to left side, center and right side of the whole
selection.

Three vertical controls align selected objects to top, center and bottom of the whole selection.



Objects from above example aligned to upper edge.

Distribute Functions

Distribution works with three or more selected objects.

Three vertical controls distribute objects in vertical direction so that tops, centers or bottom of
objects are equally spaced within selection.

Three horizontal controls distribute objects in horizontal direction so that left sides, centers or
right sides of objects are equally spaced within selection.

Remaining two controls distribute objects in vertical and horizontal directions so that there are
equal spaces between objects.

Objects from above example equally spaced with respect to their centers.



Note: It is possible to combine multiple operations while Transformation window is open. For example, you can
scale selected objects, align them according to upper edge and space them equally in the horizontal direction.

User Guide > ^Transformations > ^Envelope

Envelope Tool
This tool allows to deform selected object(s) in the Work Area of Studio with use of adjustable boundary. It is
especially suitable for adjustment of embroidery lettering and banners.

Left: original lettering. Right: lettering trasformed with envelope. Points marked with (1) are
anchor nodes of the envelope, points marked with (2) are control nodes.

Select object(s) and use ∎ main menu > Transform > Envelope command to switch to the envelope mode.

Options like predefined shape , type of horizontal and vertical edges and symmetry settings are displayed on the
control panel at the side of the screen.

Move envelope nodes to deform selected object(s) as needed and then click Apply or Generate Stitches button in
the top menu panel.



Note : Straight-line elements of vector objects are not bend when applying the envelope. They remain straight
and only their end nodes are moved. If you want to bend these elements, please enter the editing/creation mode
first and convert straight-line elements to curves.

User Guide > ^Transformations > ^Shaping

Shaping
These commands work on objects selected with the Transform Tool (arrow) or in Objects Inspector.

To find out how to use shaping commands as mask for splitting objects please read
Use of the Mask to Split Vector Objects chapter.

The ∎ main menu > Transform > Shaping commands allow to modify and combine selected objects with use of
the Boolean operations like Union, Intersection and Difference. They work only with the solid objects of fill, sfumato and
column type. These commands do not work with outlines, manual stitches and connections. To use these commands,
select several objects.

Two selected objects - star and rectangle. Star has an opening.

Union - this command creates an object or objects that contain all selected objects merged together. Vertices inside of
the filled areas are erased. If selected objects do not overlap one another, result of the union are copies of the original
objects.



Note : this command can be used to create underlay (fill without cover stitches) under the whole design, for
example. Select all objects and use the Union command to merge objects. Then open Parameters window
and set underlay parameters. Uncheck the Make Cover Stitches box to eliminate the top stitches and leave
underlay only.

Union of two objects.

Intersection - this command creates an object or several objects that are intersections of the selected objects. If
selected objects do not overlap one another, this function does not produce any new object (as intersection does not
exist).

Intersection of two objects.

Difference - this command subtracts selected objects from the object that is first in order of creation among the selected
objects. It is necessary to arrange order of respective objects in the object inspector list before use of this function, to
assure proper order of objects. Newly created object or objects contain only those areas of the first object that are not
covered by the next objects.

Difference of two objects.



User Guide > ^Object Parameters

Parameters
Studio works with vector objects which are filled with chosen type of stitches. The way of how stitches are generated is
defined by parameters . For example, the most common parameter is density of stitches. All objects created in Studio
have adjustable parameters that can be used for creation of special effects and for accommodation of design for sewing
on specific type of fabric.

There are two ways of how to access the object's parameters:

1. Quick access via panel during creation or node-by-node editing of single object. Parameters are shown in the
main control panel. Any change to parameters affects only the object that is currently created or edited.

2. In a separate Parameters window with more options.

Parameters Window
This window allows to change parameters of multiple objects at once, or to change overall parameters that affect the
whole design.

To change parameters of several objects at once, select objects and invoke the Parameters window by tapping the
pop-up button or with use of ∎ main menu > Options > Parameters .

Parameters Window

A List of parameter sections like Overall, Fill, Column, Outline, etc. Switch between the sections by tapping its
name.

B Buttons to close the window, reset parameters to default values, apply parameters to see their effect on
design, invoke the help, etc.

C Parameters belonging to the same section are displayed here. If there are too many of them to show at once,
they are organized into tabs.

D Example of parameter control.

E Splitter control to adjust the window left and right side proportion.

F
Pop-up button with menu for management of parameters. Use this menu do store current values as new
defaults or to hold them for newly created objects. Default values are preserved even if you quit the Studio.



On the other hand, holding parameters for new objects applies only to current working session.

Sections
Parameters are organized into several sections, according to type of objects or parameter scope. There are also
common parameters that apply to all objects in design, regardless of if they are selected or not. These parameters are
located in Overall section.

Overall Section - whole design

All Selected Section

Fill Section

Mesh Section

Column Section

Column with Pattern Section

Outline Section

Manual Stitches Section

Connection Section

Applique Section

Sfumato Stitch Section



Parameters
Non-numerical parameters are mostly represented by well known check boxes and combo boxes.

Many parameters have numerical value and they are represented by controls like this example: (A) icon or caption, (B)
value, (C) unit

To change value of such parameter, press the primary mouse button on the parameter value (B) to increase it, or press
the secondary mouse button on the parameter value (B) to decrease it.

Value Panel - Additional Options
Above mentioned numerical parameter controls allow to invoke a panel with additional options. Click the parameter's
caption or icon to access panel with controls for easier change of the parameter.

A Name of the parameter



B Parameter icon

C Numerical value of parameter

D Minimum possible value of parameter

E Maximum possible value of parameter

F Edit box for entering the value with keyboard, either hardware or on-screen

G Quick access buttons with pre-defined frequently used values

H Track bar for adjustment of the value

I Cancel and Apply buttons

User Guide > ^Object Parameters > ^Whole

Parameters - Whole Design

These parameters are organized into several tabs:

Main settings of design
Thread related adjustment
Fabric related adjustment
Tie-up stitches
Offset of underlay
Fill underlay
Column and applique underlay

Main Settings of Design Tab

Name . This parameter is used for user defined Border Samples.

Reference Width, Reference Height . These parameters are used for user defined Border Samples.

Overlong Stitch Mode . Most embroidery machines impose a limit to maximum length of stitch. This limit is
approximatelly 1/2 of inch (12.7 mm). When this limit is exceeded, Studio either puts needle points in between, i.e. splits
long stitch into several shorter stitches, or replaces long stitch with series of jump (floating) stitches. Each option has its



drawback - additional needle points create a kind of texture, floating stitches are prone to loose. This control allows to
choose which option you prefer.

Combine Arranged Outline Parts - if turned on, outline elements are combined into larger segments when
Arrange Outline Parts function is used, to optimize stitches layout. If turned off, outline elements are preserved for

easier editing.

Thread Related Adjustment Tab

Fills Start/End Gap : This gap prevents the thread bulging at ends of fill. It is especially important if there is a thin
running stitch outline around the fill object.

Columns Start/End Gap : This number defines the size of the small gap at beginning and end of column-like objects.
The stitches seen on screen are just the axis of real stitches that are wider, in fact. This gap prevents the thread bulging
at ends of columns, and columns with pattern.

Minimum Stitch Length : This is a global parameter (unlike maximum length of stitches, which can be adjusted
separately for each object).

Fabric Related Adjustment Tab

Additional Pull Compensation : This parameter allows user to adjust whole design at once for sewing on a different
types of fabric. If the fabric is too elastic or if the design sinks into the fabric, use this parameter to add more pull
compensation to the whole design at once.

Additional Spacing : This parameter allows user to adjust whole design at once for sewing with a different types of
thread. If the whole design seems to be too loose or too dense because of the threads used, adjust the density with this
parameter.



Tie-Up Stitches Tab

Fill Tie-Up Stitches : These are small stitches that Studio automatically adds before and after jump stitches to anchor
the thread on Fill and Sfumato objects.

Outline Tie-Up Stitches : These are small stitches that Studio automatically adds before and after jump stitches to
anchor the thread on Outline, Connection and Manual Stitch objects.

Column Tie-Up Stitches : These are small stitches that Studio automatically adds before and after jump stitches to
anchor the thread on Column, Column with Pattern and Applique objects (The only exceptions are jump stitches inside a
column that is wider than about 1.2 cm, which is about 0.5 inch).

Manual Stitch Tie-Up Stitches : These are small stitches that Studio automatically adds before and after jump stitches
to anchor the thread on Manual Stitch objects.

Tie-Up Stitches Length : maximum length of all above types of the tie-up stitches.

Offset of Underlay Tab

This global offset setting affects distance of edge and zig-zag underlay of all objects in the design. There are two ways of
how to use global underlay offset:

1. Optimized and scaled offset (in %)
2. Absolute offset (in inches or millimeters)

These options are available from the combo box on this tab.

When you select option #1, underlay offset of individual objects is automatically optimized according to size of respective
object. Moreover, you can apply overall % scale to these offsets to adjust design for sewing on various fabrics. Use scale
larger than 100% if you are sewing on elastic material or on the fleece.

Option #2 allows to set all underlay offsets to constant distance in inches or millimeters.

Controls described below use % or absolute units according to chosen offset mode.

Offset of Edge Underlay (A) : this global parameter affects distance of edge underlay of all objects in the design. There
is a separate offset parameter available for fills, columns and appliques.



Offset of Zig-Zag Underlay (B) : this global parameter affects distance of zig-zag underlay of all objects in the design.
There is a separate offset parameter available for fills, columns and appliques.

Fill Underlay Tab

Minimum and maximum length of edge and zig-zag underlay for Fill objects.

Column and Applique Underlay Tab

Minimum and maximum length of center (A), edge (B) and zig-zag (C) underlay for Column and Applique objects.

User Guide > ^Object Parameters > ^Selected

Parameters - All Selected

There is only one local parameter common for all types of objects, currently. This parameter is Color of objects.

There are several ways of how to change change color of selected objects, please see Colors chapter.

To change the color of selected objects from this window, click the color box and mix color in the Color Mixer window.

User Guide > ^Object Parameters > ^Fill



Parameters - Fill

These parameters apply only to Fill objects.

Fill object has one outer edge. Point (A) is a starting node of the edge. (B) is end of fill with
underlay direction lines. Symbol in the middle indicates focus point (C) for special effects, if

applicable. (D) is arrow that indicates direction of the currently selected element of the edge.
Holes in fill object are created separatelly with use of Opening tool .

The Fill object can be filled with stitches in one of these ways:

Fill Options

1. Plain Fill - parallel running stitches with Pattern.

2. Auto Column - object is automatically filled with stitches in the same way as Column objects.

3. Motifs - object is filled with one or multiple stitch motif.

Left: plain fill mode. Right: auto column mode



Motif fill mode

Pull Compensation is extension of each stitch on edge of object in order to compensate for thread pull (on elastic
fabric) or sinkage (on fleece). The thread pull causes the ends of stitches are pulled inwards and object is smaller
(narrower) than intended.

Icon of Pull Compensation control

1. Plain Fill Parameters

Main Settings Tab

Pattern defines the texture of cover stitches of the fill. User can define up to five own patterns in ∎ main menu >
Gadgets > Fragment Editors > User's Patterns Tab . Pattern effect is created with layout of needle points within
rows of stitches. Therefore, length of stitches in fill is given by needle points distance in pattern.

Texture of cover stitches of the fill



Pattern effect created with needle points within rows of stitches

Additional lines and curves in patterned fill can be achieved with use of Carvings objects, which must follow immediately
after Fill object and its openings.

Additional texture made with Carvings

Spacing is distance between rows of stitches or motifs. Larger spacing means lower stitch density. Spacing 4.0 indicates
that this distance will be 0.2 mm. Default value of spacing is derived from the Default Thread Weight in Preferences.

Angle of stitches. This control and number of others too allow increment and decrement the value and also to access a
panel with edit box and track bar. More detail is available in Parameters chapter.

Stitches angle control

Underlay Tab

Plain Fill Underlays . Edge and both Zig-Zag underlays can be usually turned on on all Plain Fill objects because Studio
ignores these underlays on small objects. Turn them off if the fabric is firm and does not need the stabilization.

Edge Walk Underlay helps to make crisp edges of fill. Click here to find out more about Edge and Zig-Zag underlay
offset .

Zig-Zag Underlays parameters define the angles and spacing of these underlays. Zig-Zag underlays stabilize the fabric
with a grid of loose stitches before sewing the higher density cover stitches. The angles of underlays can be set here as
well as in the editing mode (press I or O key while moving the mouse in editing mode). To change the angle click on
circular angle indicator or press mouse button on the angle value.



A : shape of object.B : edge underlay.C : zig-zag underlay.

Underlay-Advanced Tab

Controls in this tab allow to override global (overall) underlay settings which are normally applied to each object when
generating stitches. See Object's Individual Underlay Parameters chapter for more information.

Cover Layer Tab

Make Cover Stitches allows user to switch off cover stitches. Uncheck the box when one large underlay under the
whole design is needed to provide stabilization. Edge, Zig-Zag 1 and Zig-Zag 2 allows user to switch off automatic
underlays by checking the boxes. Click on the circular angle indicator at right side to set the cover stitches angle. When
the Make Cover Stitches option is un-checked, a small green arrow icon appears next to the check box. This icon warns
user that some settings (like spacing) are not applicable when there are no cover stitches.

Scale parameter determines the size of the pattern and consequently the length of fill stitches.

Random Shift randomizes pattern to allow user to create fur-like effects, for example.

Use jumps (if loose density) . If checked, connections between blocks of stitches are replaced with jumps (trims).
Objects can be seldom sewn in a single draw. Therefore, object is usually divided into several blocks and they are
connected either with connection stitches or jumps (mostly used on objects with gradient).

Sides Tab

Complete row if spacing above defines the spacing under which the last point on each row of stitches is omitted (see
the left picture). If the last point is not omitted, the result would be stitches that may be too small on the edge of fill. The
pointed ends of rows are not visible on actual embroidery if default spacing is used. If distance between rows is higher
than this threshold, last point on row is not omitted.

Left : last point on each row of stitches is omitted. Right : complete rows



Max. Random Broadening defines maximum random prolongation of fill stitches to side. Random Broadening adds
'ragged edges' effect to objects.

Gradient Tab

Gradient affects the distance between rows of stitches or motifs within object. Distance of rows will gradate from spacing
value to spacing plus gradient value. Gradient Type combo box allows to choose from various gradation schemes.

Spacing (density) gradient

Effect Tab

Effect . Plain Fill may be combined with additional effects like Wave, Contour fill, Radial fill, Square fill and Rounded fill.
Parameters of Wave can be adjusted by clicking on the wave control or by pressing mouse button on parameters values.
Wave parameters define the curve of fill rows. Radial, Square and Rounded fill effects create stitches in a spiral starting
from the 'Focus Point' of the object. User can adjust the Focus Point position in the Editing Mode.

2. Auto Column Parameters



Main Settings Tab

Pattern property is the same as with plain fill.

Use Pattern . If checked, the Auto Column uses pattern set in Plain Fill pattern combo box. Otherwise the column
stitches are without pattern.

Spacing has the same meaning as with plain fill.

Underlay Tab

Auto Select Column Underlay . If checked, the type of underlay for Auto Column objects is selected automatically.

Center . If Center is checked then columns will have underlay running along their center. Use this type of underlay for
small or thin objects.

Edge underlay runs along edge of the object. It should be used for medium size and large objects.

Zig-Zag underlay should be used in combination with edge underlay for large or thick objects

Spacing of zig-zag underlay is usually much larger than spacing of cover stitches.

Underlay-Advanced Tab

Controls in this tab allow to override global (overall) underlay settings which are normally applied to each object when
generating stitches. See Object's Individual Underlay Parameters chapter for more information.

Sides Tab

Pull Compensation property is explained at the beginning of this chapter.

Direction of stitches in auto column fill can be controlled to some degree with direction lines. Click here to find out
more.

3. Motif Parameters

Main Settings Tab

Motif is a simple stitch design that can be used to fill object instead of dense parallel stitches. User can define up to 5
own motifs in ∎ main menu > Gadgets > Fragment Editors > User's Samples Tab .

Animation of motif



Spacing of motif rows is usually few millimeters.

Angle defines direction of motif rows.

Grid Tab

It is possible to use multiple motifs in a single object. Controls in this tab allow to define grid of motifs with up to 3 rows
and up to 3 columns.

Rows, Columns define size of grid with motifs.

Overall Shift X, Overall Shift Y allow to move motif fill in both X and Y axes.

More detail is available in Fill with Multiple Motifs chapter.

Cover Layer Tab

Use jump stitches defines whether the jump (trim) or connection is inserted between distant rows of motifs or stitches.

Row Shift defines distance of how rows of motifs are scrolled one from the other.

Motif Width allows to make motif wider or narrower. The height of motif remains intact.

Motif Scale enlarges or shrinks motif in both axes simultaneously. Consequently, it determines also the length of fill
stitches.

Gradient Tab

Gradient has the same meaning as with plain fill.

Effect Tab

Motif Fill can be combined only with the Wave effect.

Wave effect on motif fill



User Guide > ^Object Parameters > ^Fill with Multiple Motifs

Fill with Multiple Motifs
Studio allows to use several motifs within a single fill. See below examples of object filled with use of several motifs at
the same time.

To use this feature, create a fill object first, then access its parameters and select Motif mode . Then select the grid
tab.

Multiple motifs can be combined with all options available for single motif like scale, shift, fill angle, wave and gradient.
However, respective motifs must be all of the same size. User does not have to care about it, because respective motifs
are automatically resized to size of the 'master' motif, which is the motif selected in Main Settings page. Master motif is
displayed also in below grid in a top left cell.

The tab with grid of multiple motifs is visible only when Motif mode is selected in fill parameters window.

Use Rows and Columns controls to set number of motifs. It is possible to define up to 3x3 motifs.

2x1 grid with two motifs

Two motifs inside of the same object

Setting of desired number of rows and columns defines a grid of motifs that will be used to fill the object. Select
predefined or user-defined motifs to respective cells of the grid. Then click Apply, Generate Stitches or OK
button to store new settings for object.

With a grid of properly digitized user motifs it is possible to achieve homogenous random-like fill.



2x2 grid with random-like motifs

Homogenous random-like fill

User Guide > ^Object Parameters > Mesh

Parameters - Mesh

These parameters apply only to Mesh objects.

Mesh object has one outer edge. Point (A) is a starting node of the edge. (B) is end of outer edge with angle direction
line. Angle here reffers to transformation angle. Symbol in the middle indicates focus point (C) for special effects. (D)
is arrow that indicates direction of the currently selected element of the edge. Holes in fill mesh are created separatelly
with use of Opening tool.

Fill Span

Some types of mesh allow to set fill Span .

Span defines extent of fill with respect to object contours. Possible values are Overflow , Cropped , Interior .



In case of Overflow fill you may want to exclude object contours from the mesh. This can be done in Common
Settings tab.

Depending on the fill type the Overflow and Interior spans may use origin point as start point. If origin point is
not defined or if it is outside of object's contour or if it is inside of a hole, the fill may be not generated. In such a
case place the origin point inside the object.

In case of the Overflow and Interior span the fill may be not generated if gap between mesh paths or cell size is
too large and path elements do not fit inside the object. In such a case decrease the gap value (or cell size) or
enlarge the object.

Span setting is ignored if fill has a Single Layer switch and this switch is on.

Overflow Cropped Interior

The Mesh object can be filled with stitches in one of these ways:

Mesh Options

1. Stippling - fill based on stitch meanders.

2. Tiles - tiled blackwork and tessellation patterns.

3. Net - lacy fills made from line and curve elements, shapes, fractals and labyrinth paths.

4. Knots - celtic knot fill.

5. Crosses - simple cross stitch fill.

6. Glyphs - fills based on font glyphs and pre-defined library glyphs.

7. Plant - plain and curly branching fills.

Stippling -
Necklace

Stippling -
Maze

Tiles -
Blackwork



Tiles -
Tessellation

Plants - Plain
Mode

Plants - Curly
Mode

Glyphs Net from
elements

Net from shape

Net - fractal
Knots

Crosses

Common Settings

Settings in this tab apply to all mesh modes.

Include Outer Contours , Include Inner Contours . If switched ON, the object's contours are treated as part of the
mesh fill. This means that contours are stitched just as the fill. When using Cross Stitch or Celtic Knots fill that exceeds
the object's boundaries it is usually desirable to not include contours. These settings are ignored in case of a single-layer
fill, they work with multi-layer fills only.

Layers (for multi-layer fills only) Each path of multi-layer mesh fill is sewn at least two times: forward and backward,
which means two passes of each path. Layers control allows to duplicate forward and backward passes and achieve
thicker paths. This setting is ignored for a single-layer fills.

Min. Stitch Defines smallest stitch length of mesh fill. Stitches are generated so that their length is between minimum
and maximum allowed length.

Max. Stitch Defines largest stitch length of mesh fill. Stitches are generated so that their length is between minimum and
maximum allowed length.



Effect

Mesh fill may be combined with additional effects like fish eye, black hole, swirl, ripple and saw. Most effects use Focus
Point of the object as a starting point. User can adjust the Focus Point position in the ∎ node editing mode .

Kind control allows to select desired effect or switch off effect by selecting 'None'.

None Fish Eye Black Hole

Swirl Ripple Saw

Varying
Ripple

Random
Ripple

Varying
Saw

Intensity controls the strength of fish eye, black hole and swirl effects.

Distance , Count and Angle control ripple and saw effects

Even simple mesh fills like straight lines (blackwork sample #47) may create interesting textures when effect is applied to
them.



Ripple applied to simple blackwork sample (horizontal lines)

Transformations

Controls in this tab allow to move, skew, rotate and project the mesh fill within the object. These operations can be used
in combination with Effect . The difference between the transformations and effect is that effect warps the fill look while
transformations preserve it.

Offset allows to move the fill.

Skew allows to shear the fill.

Perspective allows to add a 3D look to the fill.

Angle

Mesh fill Mesh fill rotated
45 degrees

In node editing mode the mesh transformation angle is displayed also on object's contour as
direction line (B).

Skewing, rotation and perspective projection use Focus Point of the object as a pivot. User can adjust the Focus Point
position in the ∎ node editing mode .

Remarks

Single Layer Setting



Single Layer is available for some mesh fill types. If this setting is switched on, the inner part of mesh fill is
stitched with single run of thread. Connections between fill elements are forced to edges of the object. If
connecting along edges is not possible, a jump (trim) is inserted between the fill elements. Some common
settings like Layers Count and Include Contours are not applicable to fill when Single Layer switch is on.
While inner fill is a single-layer, connections on the edges may overlap one another. The edge of the object with
connections is supposed to be covered by other objects or physically removed on a stitch out.

Single-layer mesh fill can be used as is (single stitching), or it can be converted to outlines and then any
outline style can be applied, for example satin stitch, tripple bean stitch, etc. Use Convert command from the
main menu.

Single-layer Blackwork
mesh

Converted outlines,
satin mode

If Single Layer setting is switched off, the mesh fill is stitched with even number of layers (2,4, or more).

User Guide > ^Object Parameters > Mesh - Stippling

Mesh Tool - 1. Stippling Parameters

This is a sub-chapter of the Mesh Parameters chapter

Category - select the way of how stippling path is generated: A) Necklace, B) Maze. Necklace mode allows to add
glyphs from library or from font along the stippling path. The gap between branches varies above anf below the set
value. Maze mode creates a simple meandering path with required gap between meanders.

Stippling - Maze



Stippling -
Necklace

Following tabs are available in the Necklace mode:

A) Necklace - Main Settings Tab

Kind - select any of predefined stippling paths or make your own path from library and font glyphs.

Average Gap - average width of the empty space between meanders. The actual gap varies above and below this
value.

Single Layer - see detailed description of Single Layer setting at the end of this chapter . Single Layer option is not
available for Font and Glyph necklace fills.

Glyph Spacing, Step defines how often the glyphs appear along the path.

Direction allows forward, backward, alternate or random orientation of glyphs while putting them along the path.

Random Glyph Order . If there are more glyphs selected, this control allows to randomize their order along the path.

Reverse Glyph Order . If there are more glyphs selected, this control allows to swap their order along the path.

Span defines extent of fill with respect to object contours. Possible values are Overflow , Cropped , Interior . In case of
Overflow fill you may want to exclude object contours from the mesh. This can be done in Common Settings tab.

Interior fill,
contours
excluded

A) Necklace - Font Tab

Font - select font to chose glyphs from.

Text . This control allows to type in one or multiple glyphs (letters, dingbat or clipart symbols) from chosen font.

Bold - switches font style to thick, if supported by given font.

Italic - switches font style to slanted, if supported by given font.

Angle - allows to rotate glyphs with respect to path direction.

A) Necklace - Glyphs Tab

Glyphs . This control allows to select one or multiple predefined glyphs from library.



B) Maze

In the Maze mode only two controls are available:

Kind - select contour, radial or random meanders layout.

Gap - width of the empty space between meanders.

Single Layer - see detailed description of Single Layer setting at the end of this chapter .

User Guide > ^Object Parameters > Mesh - Tiles

Mesh Tool - 2. Tiles Parameters

This is a sub-chapter of the Mesh Parameters chapter

Tiling is made with A) ready-made blackwork samples or B) generated tessellation mosaics .

Category A) - Blackwork

Sample is tiled seamlessly to fill whole mesh object.

Blackwork Tiles

Single Layer - see detailed description of Single Layer setting at the end of this chapter . Single Layer option is not
available for all blackwork samples. Samples which allow the single-layer stitching are marked.

Scale control allows to adjust size of the samples and consequently the density of mesh paths.

Category B) - Tessellation



Tessellation
mosaic

A tessellation is the covering of an area using one or more geometric shapes with no overlaps and no gaps.

Controls affecting the tessellation are:

Kind - select the tessellation pattern. Fill colors of individual geometric shapes indicate whether the shape is large
enough to be subdivided into smaller shapes (see Subdivision / Threshold parameter). Shapes large enough for
subdivision are filled with green color, smaller shapes are filled with pink color.

Average Size of Cells / Size - average width of the empty space between edges. The actual gap varies above and
below this value.

Distortion / Range - sometimes good looking effect can be obtained by distortion of the mesh. Set non-zero value to
this control to randomize the mesh fill.

Randomly distored
edges

Split - new patterns can be obtained by splitting the existing pattern into smaller parts. There are several methods of
how smaller parts are made from the larger one. Their effect is depicted on respective method's icon.

Currently available split methods are: Corner Spokes, Edge Spokes, Inscribe, Inset, Shrink

Split methods explained on a 6-sided shape: 1. Corner Spokes, 2. Edge Spokes, 3. Inscribe, 4.
Inset, 5. Shrink.

Inscribe, Inset and Shrink methods produce an inner shape (yellow) and outer shapes (blue).

Split / Threshold - this threshold divides geometric shapes in the pattern to those that are split into smaller parts, and
those that are not. Shapes with area larger than the threshold value are split using selected split method. Select 0%
threshold if you want all shapes to be split. Shapes smaller than split threshold are rendered in pink color in the
tessellation pattern box. Shaped equal or larger than split threshold are rendered in green color.



Split / Outer Lines - some split methods (Inscribe, Inset and Shrink) create inner shape inside of the parent shape and
several small shapes around this inner shape. This switch allows to delete outer shapes. In some cases it produces nice
new patterns.

Split / Offset - some split methods are parametrized with offset value. This control is disabled in case of split methods
which are not using offset.

Edges Result of tessellation is mesh of edges, which can be further modified by following parameters:

Edges / Extrude - expands edges and produces a decorative star-like objects in some patterns, especially those
containing 8-sided polygons (octagons)

Same pattern with increasing edge extrusion. Left to right: 0%, 50%, 75%.

Edges / Bend - replaces straight-line edges with arcs, creating a more organic-looking mosaic.

Arched edges

User Guide > ^Object Parameters > Mesh - Net

Mesh Tool - 3. Net Parameters

This is a sub-chapter of the Mesh Parameters chapter

Category - select the way of how the net is build: A) from elements, B) from shapes, C) with fractals, D) from labyrinth
paths, E) from free-standing lace grid



Net from elements Net from shape

Net - fractal Net - labyrinth

Net - FSL grid

Category A) - Elements

Kind - select the net kind

Distribution - defines how elements are arranged in space to follow one another. Distribution pattern becomes noticable
on large objects. Its effect on small objects may be insignificant.

Average Gap - average width of the empty space. The actual gap varies above and below this value.

Distortion / Randomness - sometimes good looking effect can be obtained by distortion of the mesh. Set non-zero
value to this control to randomize the mesh fill.

Category B) - Shapes

Kind - select the net kind



Distribution - defines how shapes are arranged in space to follow one another. Distribution pattern becomes noticable
on large objects. Its effect on small objects may be insignificant.

Average Gap - average width of the empty space. The actual gap varies above and below this value.

Single Layer - see detailed description of Single Layer setting at the end of this chapter . Note: Scale and Span settings
are not applicable when Single Layer switch is on.

Scale - controls size of shapes forming the net. When setting scale to value lower than 100% the shapes become more
visible and net structure is supressed.

Span defines extent of fill with respect to object contours. Possible values are Overflow , Cropped , Interior . In case of
Overflow fill you may want to exclude object contours from the mesh. This can be done in Common Settings tab.

Category C) - Fractals

Kind - select the net kind

Smooth - some fractals create crisp paths. This control allows to soften them.

Organic-looking mesh can be obtained by applying randomization and smoothing to fractal fill.
Further enhancement (not shown in this picture) can be achieved by applying swirl or ripple

effect - see Effect section in this chapter.

Average Gap - average width of the empty space. The actual gap varies above and below this value.

Single Layer - see detailed description of Single Layer setting at the end of this chapter .

Distortion / Randomness - sometimes good looking effect can be obtained by distortion of the mesh. Set non-zero
value to this control to randomize the mesh fill.

Category D) - Labyrinths

Grid Shape - select the labyrinth base grid. Available forms are rectangular, circular, hexagonal and triangular

Path Kind - each path option generates a different look of the labyrinth

Cells / Approximate Size - average size of the labyrinth cells. The actual size varies above and below this value.

Distortion / Randomness - sometimes good looking effect can be obtained by distortion of the mesh. Set non-zero
value to this control to randomize the mesh fill.



Rectangular
labyrinth with

random distortion

Category E) - FSL Grid

Kind - select the grid kind

Spacing - average width of the empty space. The actual gap varies above and below this value.

Single Layer - see detailed description of Single Layer setting at the end of this chapter .

Net from lace grid

User Guide > ^Object Parameters > Mesh - Knots

Mesh Tool - 4. Knot Parameters

This is a sub-chapter of the Mesh Parameters chapter

Shape - choose between round, angular or combined shape of knots.

Round Celtic
Knots

Thickness controls the width of strands forming the knot mesh.



Size is dimension of individual knot measured like shown on the following illustration

Structure / Unweave . Increase this value if you want more knots to be formed inside the fill.

Span defines extent of knot fill with respect to object contours. Possible values are Overflow , Cropped , Interior . In
case of Overflow fill you may want to exclude object contours from the mesh. This can be done in Common Settings
tab.

Align to Common Grid . This option allows to align knots in individual objects to the same grid. To make this alignment
work the objects must have same size of the knots and no effect or transformation can be used.

No alignment Aligned to
common grid

User Guide > ^Object Parameters > Mesh - Crosses

Mesh Tool - 5. Crosses Parameters

This is a sub-chapter of the Mesh Parameters chapter

Kind - select cross type for the mesh fill.



Full Crosses

Size reffers to dimension of individual crosses. All crosses inside the object have the same size unless some effect or
transformation is used.

Span defines extent of knot fill with respect to object contours. Possible values are Overflow , Cropped , Interior . In
case of Overflow fill you may want to exclude object contours from the mesh. This can be done in Common Settings
tab.

Align to Common Grid . This option allows to align crosses in individual objects to the same grid. To make this
alignment work the objects must have same size of the crosses and no effect or transformation can be used.

No alignment Aligned to
common grid

Merge Half Lines . Crosses are formed from half lines meeting each other in the center of the cross. Some half lines are
co-linear and can be merged together to decrease the stitch count. However, this may affect the uniform texture of
stitches.

Separate half
lines

Merged half
lines

User Guide > ^Object Parameters > Mesh - Glyphs



Mesh Tool - 6. Glyphs Parameters

This is a sub-chapter of the Mesh Parameters chapter

Options Tab

Average Cell Size . The actual size of glyph cells varies above and below this value.

Glyph Rotation Range - range within which the glyphs are randomly rotated to create more intricate mesh.

Small Cells Amount . Glyph cells are of various size. Small ones are filled with other glyphs than the large ones. This
control defines margin between small and large cells.

Font glyphs mesh

Span defines extent of fill with respect to object contours. Possible values are Overflow , Cropped , Interior . In case of
Overflow fill you may want to exclude object contours from the mesh. This can be done in Common Settings tab.

Large Glyphs Tab

Kind . Choose between Font (letters, dingbat or clipart) glyphs and glyphs from Library mode.

Scale - this control allows to size-down the glyphs within their cells.

Add Circle - if switched ON, a circle outline is added to each glyph cell.

Font - if Font mode is chosen, this control allows to browse and select font. Also, there are Bold and Italic switches
available to modify the font if it supports such options.

Text - if Font mode is chosen, this control allows to type-in the glyphs.

Glyphs from Library - if Library mode is chosen, this control allows to select one or multiple pre-defined glyphs.

Small Glyphs Tab



Kind . Choose between Font (letters, dingbat or clipart) glyphs and glyphs from Library mode.

Scale - this control allows to size-down the glyphs within their cells.

Add Circle - if switched ON, a circle outline is added to each glyph cell.

Font - if Font mode is chosen, this control allows to browse and select font. Also, there are Bold and Italic switches
available to modify the font if it supports such options.

Text - if Font mode is chosen, this control allows to type-in the glyphs.

Glyphs from Library - if Library mode is chosen, this control allows to select one or multiple pre-defined glyphs.

User Guide > ^Object Parameters > Mesh - Plant

Mesh Tool - 7. Plant Parameters

This is a sub-chapter of the Mesh Parameters chapter

Plant Mesh is available in two types

A. Plain Branching
B. Curly Branching

Type A) - Plain Branching

Options Tab

Kind . Select plant mesh mode: roots, bare stem or stem with flowers, leaves or both.

Average Cell Size . Flower, fruit and leaf glyphs are rendered into cells along the stem. The actual size of cells varies
above and below this value.

Plant Mesh - plain branching



Span defines extent of fill with respect to object contours. Possible values are Overflow , Cropped , Interior . In case of
Overflow fill you may want to exclude object contours from the mesh. This can be done in Common Settings tab.

Overflow, with contours included Interior, contours excluded

Flowers Tab

Kind . Choose between Font (letters, dingbat or clipart) glyphs and glyphs from Library mode.

Scale - this control allows to enlarge or shrink the glyphs within their cells.

Font - if Font mode is chosen, this control allows to browse and select font. Also, there are Bold and Italic switches
available to modify the font if it supports such options.

Text - if Font mode is chosen, this control allows to type-in the glyphs.

Glyphs from Library - if Library mode is chosen, this control allows to select one or multiple pre-defined glyphs.

Leaves Tab

Kind . Choose between Font (letters, dingbat or clipart) glyphs and glyphs from Library mode.

Scale - this control allows to enlarge or shrink the glyphs within their cells.

Font - if Font mode is chosen, this control allows to browse and select font. Also, there are Bold and Italic switches
available to modify the font if it supports such options.

Text - if Font mode is chosen, this control allows to type-in the glyphs.

Glyphs from Library - if Library mode is chosen, this control allows to select one or multiple pre-defined glyphs.

Type B) - Curly Branching

See Also

Curly Plant Mesh - Essential Guide
Curly Plant Mesh - Advanced Techniques

This kind of plant fill is composed of curled stems and sprouts. Sprouts can be replaced with flowers, which are either
pre-digitized glyphs from library or glyphs from any TrueType or OpenType font. Another way of how to decorate sprouts
is to widen them so that they look like leaves.



Curly plant fill with flowers and leaves

Besides filling the interior of object, the curly branching can be also used to generate an intricate flower ornaments if
symmetry and mirroring is applied.

Curly plant ornament with symmetry

Branching start point is Origin point of the object. If the Origin point is not defined, branching starts as close to the
center of the object as possible (with respect to holes in the object, if there are any). This start point is especially
important if symmetry is applied because symmetry origin is identical with the start point.

Options Tab

Growth Kind . Growth of sprouts is either managed or free - autonomous. Managed growth is more suitable for
ornaments and autonomous growth is intended for fills.

1

2

3

4



Sprouts Growth Symbols: 1 from origin
point (autonomous), 2 from core (font

glyph, library glyphs, hole or carving), 3
from origin or from base, rotational

symmetry, 4 from origin or from base,
mirrored and rotated

1 432a 2b

Sprouts Growth Examples: 1 from origin point
(autonomous), 2a from core (library glyph), 2b from core
(font glyph), 3 from base with rotational symmetry, 4 from

base, mirrored and rotated

Size Levels . Sprouts size may vary from small to large. This control allows to limit the range of sizes. Value 8 means full
range of sprout sizes. Value lower than 8 means limited range of sizes. Value 1 means that only the smallest sprouts are
generated.

Maximum Sprout Generations . Sprouts grow from their platforms (origin point, core, basis or other sprouts) in layers
called generations. This control allows to control maximum number of generations before the growth is stopped. Another
factor that can limit the growth of sprouts is the mesh object contours. If sprouts grow from the core or base, restricting
number of generations makes the plant overall shape roughly similar to the platform it grew from.

Core from font glyph, 1
sprout generation

Core from font glyph, 2
sprout generations

Overall Sprouts Scale . Increase the scale if you want to enlarge all sprouts. Decrease it if you want to make them
smaller. This control does not affect basis and core.

Span defines extent of fill with respect to object contours. Possible values are Overflow , Cropped , Interior . In
case of Overflow fill you may want to exclude object contours from the mesh. This can be done in Common Settings
tab.

Seed - plant fill is generated pseudo randomly, which means that it is not really a random proccess. It is designed so that
when you run generation of stitches multiple times it will always produce the same result unless you change some
parameters or size of the object. The seed is a quick way to obtain other result without changing parameters. In other
words, if you want to preserve your current set of parameters, but you want to generate a different-looking fill or
ornament, change he seed value and generate the stitches. In most cases you will get a new layout of the plant. Arrow
buttons perform double action - they increase or decrease the seed and apply its new value to mesh object (generate its
stitches) so that you can preview result in the Work Area without leaving the Parameters window.

Flowers Tab

Flower Kind . Choose between Font (letters, dingbat or clipart) glyphs and glyphs from Library flower mode.

Scale - this control allows to enlarge or shrink the flower glyphs.

Amount specifies approximate ratio between flowers and leaf sprouts. As flower generation is random process, the
actual flower/sprout ratio may be different, usually smaller than this value.



Compression causes the bottom of flowers to be thinner and thus fit better into the inner curves of parent sprouts.

Glyphs from Library - if Library mode is chosen, this control allows to select one or multiple pre-defined glyphs.

Font Glyphs - if Font mode is chosen, this control allows to type-in the glyphs.

Font - if Font mode is chosen, this control allows to browse and select font. Also, there are Bold and Italic switches
available to modify the font if it supports such options.

Rotation control allows to rotate font glyphs with respect to the stem to which they are attached.

Leaves Tab

Leaf Kind - select the shape of leaves.

Leaf Width - this control allows to make the leaves wider or narrower. Layout of leaves is not affected.

Leaf Length - this control allows to truncate the leaves. Layout of leaves is not affected.

Curliness - amount of winding applied to the leaves.

Base Tab

Base Sample - the plant may grow from a predigitized base or even from mupltiple basis. Use this control to choose
from predigitized base samples.

Basis are available only if Growth Kind is any of the rotation / mirror items, i.e. not core and not origin point.

Base Size - adjust scale of the predigitized base.

Base Width - adjust width of the predigitized base. Base samples are arranged around the symmetry center, which is
identical to the origin point of the mesh. This arrangement means that base is kind of ring around the symmetry center.
Base Width controls how wide is this ring.

Multiple basis may be combined within a single object. The basis may overlap and/or intersect each other.

Two basis combined in a single object. Design is monochrome, the colors in this illustration were
added only to differentiate basis (red and green) and leaves (violet).



Three basis combined in a single object.

Core Tab

Core if available only if Growth Kind value is From Core .

Core Kind - Select shape of the core. Possible values are Font, Library, Holes, Carvings.

Font core allows to create letter glyphs with ornaments.

Library provides predefined glyphs like coat of arms, geometric shapes, etc.

If Holes option is selected, the sprouts grow from contours of holes of the parent mesh object, which allows user to use
her/his own core shape. The same applies to Carvings core with significant exception - the core has no inner area in this
case because carvings are linear objects.

Core Scale - Font and Library cores can be scaled in size. This parameter has no meanning for Holes and Carvings
cores, they preserve their original size and are not scaled.

Symmetrical Sprouts - Sprouts growing from the library glyph core may be mirrored horizontally to achieve symmetric
look. Other types of core do not have this option.

See Also

Curly Plant Mesh - Essential Guide
Curly Plant Mesh - Advanced Techniques

User Guide > ^Object Parameters > ^Column

Parameters - Column

These parameters apply only to selected objects that are Column objects.

Column object has a start base, two edges, end base and optional inner segments

(A) is column starting point. It lays on the first edge(1). (B) is end point, it lays on the second edge (2). (C) is start base,
(D) is end base. (S) is optional inner segment. Column may contain any number of inner segments. Arrow (E) indicates
direction of currently selected element.

Column objects can be filled with stitches in the following ways:

1. Zig-Zag Sample fill using the various zig-zag samples



2. Strips fill using the lines stitched along contours of the column

3. Multilayer zig-zag fill with multiple forward and backward layers for raised columns

1. Zig-Zag Sample Fill

Column object filled with zig-zag samples

Main Settings Tab

Sample is the zig-zag stitch pattern that fills the Column object. Stitch samples differ in number of stitches and their
layout.

Spacing parameter defines the maximum distance between stitch samples. If the Column object forms a bend, the
distance on the inner curve is lower.

Auto Shortening is function that shortens some stitches on inner side of bend object to prevent too high density (see
below picture).



Circles in above illustration indicate automatically shortened stitches in sharp curve

Underlay Tab

Auto Select Underlay check box allows user to switch off the automatic program decision on what type of underlay will
be used for the object.

Center, Edge and Zig-Zag check boxes allow user to choose which underlays will be used for the object. More detail
about offset of Edge and Zig-Zag underlay is available in the Parameters - Whole Design chapter.

(A) is object shape, (B) is edge underlay, (C) is zig-zag underlay, (D) is center underlay.

Spacing parameter indicates the spacing of the zig-zag underlay.

Underlay-Advanced Tab

Controls in this tab allow to override global (overall) underlay settings which are normally applied to each object when
generating stitches. See Object's Individual Underlay Parameters chapter for more information.

Cover Layer Tab

Make Cover Stitches allows user to switch off cover stitches. Turn off the cover stitches if you need to add only the
underlay to design digitized in other software.

Auto Corners . Studio automatically splits or folds too sharp corners on Column objects. Use this check box to turn off
this function.

Normal corner and automatically adjusted corners.

Perpendicular Stitches function automatically divides long columns with line (not curve) edges to two or three parts to
make middle part of column perpendicular to its virtual axis.



Top : normal stitch flow from start base to end base. Bottom : middle stitches forced to
perpendicular orientation

Note : Column can be followed by a Carving object which gives additional stitch texture to the column.

Sides Tab

Pull Compensation is extension of each stitch on edge of object in order to compensate for thread pull (on elastic
fabric) or sinkage (on fleece). The thread pull causes the ends of stitches are pulled inwards and object is smaller
(narrower) than intended.

Max. Random Broadening defines maximum random prolongation of column stitches to side. #1 parameter applies to
first edge of column and #2 to second. Random Broadening adds 'ragged edges' effect to objects.

Envelope shortens some column stitches to create special effects. When using Envelope, turn off all underlays.

Column side-to-side stitches trimmed with envelope

Gradient Tab

Gradient affects the distance between stitches within object. Distance will gradate from spacing value to spacing plus
gradient value. Gradient Type combo box allows to choose from various gradation schemes.



Increasing sample spacing creates density gradient

2. Strips Fill

Strips Tab

Strips fill the column object from one side to the other, with stitches running along the column
edges.

Number parameter defines number of strips.

Min. Length and Max. Length define minimum and maximum length of stitches. Length of stitches is adjusted
automatically to ensure smooth approximation of curved parts of the strips.

3. Multilayer Fill

Multilayer columns have a subset of zig-zag column parameters. They are intended for creation of thick raised columns.
Therefore, some parameters like gradient, envelope, etc. are not applicable.

Multilayer columns have just few extra parameters like Layers - the layer count and Offset - the margin between lower
stitch layers.

Rising effect is achieved by using multiple layers of dense zig-zag underlay. Each zig-zag layer is offset to the previous
layer to wrap around it.

User Guide > ^Object Parameters > ^Column with Pattern



Parameters - Column with Pattern

These parameters apply only to selected objects that are moreover the Column with Pattern objects.

Column without a pattern

Column zig-zag stitches with pattern applied to the cover layer

Pattern is texture of cover stitches

Most of the parameters are same as parameters of Column object except the following:

1. Pattern - the texture of cover stitches (same meaning as on Fill object).
2. Random Shift (same meaning as on Fill object).
3. Scale (same meaning as on Fill object).
4. Stretch - this switch makes pattern adaptive, which means that it is enlarged or shrinked along the column

according to the column width on any given place. This option can be used for making a lace-like columns, for
example.

5. Twist Count - this option is valid only when Stretch option is switched on. It scrolls the pattern along the column
so that it looks like if it was twisted.

Adaptive Pattern with Scale=50%, Twist Count=5.



Adaptive Pattern with Scale=66%, Twist Count=0

Adaptive Pattern with Scale=125%, Twist Count=0

In above 3 examples pattern adapts to the varying width of column. These examples were made with the following pre-
defined patterns:

1. Vertical Lines, 2. Bricks, 3. Parquets

Adaptive pattern can be combined with a Random Shift option to give it a fuzzy look:

Vertical Lines as adaptive pattern with Scale=50%, Twist Count=4, Random Shift=1.5mm

Vertical Lines as adaptive pattern with Scale=50%, Twist Count=0, Random Shift=1.5mm

Note : Column with Pattern can be followed by a Carving object which gives additional stitch texture to the
column.



Icon of the Carving Tool

Column with Pattern does not have a Make Cover Stitches option, Strips fill mode not Multilayer fill mode.

User Guide > ^Object Parameters > ^Applique

Parameters - Applique

These parameters apply only to selected objects that are Applique objects.

All Applique parameters except one (color of tack-down stitches) are subset of the Column object parameters. Color
of tack-down stitches is specific to Applique objects only.

Left: applique object with all layers. Right: layers moved to the side for better view.

Layer 1 is mark-up stitches. Their meaning is to show position of applique patch on the underlaying fabric.

Layer 2 is tack-down stitches. Their meaning is to fix applique patch on the underlaying fabric. They are separate color
to force machine stop before and after this layer. Stop before tack-down allows to place applique patch on position
idicated by mark-up stitches. Then the tack-down stitches are placed to fix the patch and the next stop allows to trim the
patch along the tack-down stitches.

Layer 3 is cover stitches. They overlap and hide tack-down stitches and edges of the applique patch.

Note: in contrast to Column object, Applique cannot have gradient effect nor strips fill.

User Guide > ^Object Parameters > ^Connection



Parameters - Connection

These parameters apply only to selected objects that are Connection objects. Refer to detailed
Connections chapter to learn more about connection objects.

Maximum and Minimum Length have same meaning as on Manual Stitches object.

Connections are automatically adjusted when objects are moved or otherwise transformed to
prevent insertion of jump (trim).

Jumps option allows user to create controlled jump stitches between objects. If objects are too close one to the other, it
may be hard to scissor the tiny jump stitch between objects (left picture). User can create connection with jumps option
between objects to achieve controlled jumps that are longer and easier to scissor.

User Guide > ^Object Parameters > ^Manual Stitches

Parameters - Manual Stitches

These parameters apply only to selected objects that are Manual Stitches objects.

The Maximum Length (1) defines the longest stitches generated when compiling Manual Stitches object into actual
stitches. Each Manual Stitch longer than Maximum Length + Minimum Length is divided into one or more stitches of
maximum length one (or none) shorter stitch, but not shorter than Minimum Length (2) .

User Guide > ^Object Parameters > ^Outline



Parameters - Outline

These parameters apply only to selected objects that are moreover the Outline objects.

Mode

Mode combo box at the top of Outline parameters panel allows to choose from available stitching modes:

1. Sketch

Sketch resembles a very flat satin stitches. It can be used for outlines that are thicker
than running stitch outline and thinner than narrowest possible satin stitch outline.

2. Samples

Samples are stitch patterns repeated along the outline.

3. Satin Stitches

Satin stitches can be used to create zig-zag object of constant width similar to column
objects.

4. Applique

Applique contains tack-down stitches of separate color to stitch applique fabric to the
underlying fabric.

5. Border

Border is composed of pre-digitized objects. It can have outlines of separate color.

6. Overlock



Overlock mode imitates straight and zig-zag stitches made by specialised serger
machine (overlocker), which are used to stop fabric from unravelling.

Satin Stitches, Applique and Border modes share the same parameters except the Outlines Color and Border sample
length that is only used with Border.

Width parameter is common to all outline modes. Width is the width of reference cells along the outline to which the
stitches are projected. It is not necessarily the width of finished outline, because projected stitch sample can be wider or
narrower than reference cells.

Outline object with stitch samples (left), outline object with satin stitches (right).

Flip Sides option is common to Sketch, Samples, Border and Overlock modes. Use this option to mirror stitch pattern
for respective outline mode.

Sketch and Samples Outline Parameters
Sketch is a special outline that resembles a very flat satin stitches. It can be used for outlines that are thicker than
running stitch outline and thinner than narrowest possible satin stitch outline.

Sketch parameters Length (A) and Width (B)

Sample is a series of stitches that are repeated along the outline. When you change the sample, program automatically
sets the Width , Minimum Length and Maximum Length parameters to values default for this sample. However, you
can change these parameters if you wish. User can define up to 5 own stitch samples in ∎ main menu > Gadgets >
Fragment Editor User Samples Tab.



Sample Length

In curves, program automatically decreases the length of samples for better approximation of curve. If you want to have
all samples of the same length even in the curves, set the Minimum Length equal to Maximum Length .

Sample Width

Satin Stitches, Applique and Border Parameters
Spacing parameter defines the maximum distance between stitch samples. If the Outline object forms a bend, the
distance on the inner side is lower.

Pull Compensation is extension of each stitch on edge of object in order to compensate for thread pull (on elastic
fabric) or sinkage (on fleece). The thread pull causes the ends of stitches are pulled inwards and object is smaller
(narrower) than intended.

Auto Select Underlay check box allows user to switch off the automatic program decision on what type of underlay will
be used for the object.

Center, Edge and Zig-Zag check boxes allow user to choose which underlays will be used for the object.

Spacing parameter indicates the density of the zig-zag underlay.

Underlay-Advanced Tab

Controls in this tab allow to override global (overall) underlay settings which are normally applied to each object when
generating stitches. See Object's Individual Underlay Parameters chapter for more information.

If more control is needed, convert the Outline object to Column object with more parameters available.

Outlines Color defines the color of running stitch outlines if border sample contains outlines.

Border sample length defines the size of samples along the outline.

Overlock Parameters
Sample is a series of straight stitches or satin zig-zag blocks that are repeated along the outline.



Cell Length . Samples are aligned along the outline so that virtual reference cells are computed along the outline and
then samples are projected into these cells, one sample per cell. Cell Length defines the spacing of cells along the
outline.

Cell Length

Spread . This parameter controls additional extension of outer side of the overlock sample. With most samples, the
spread causes overlapping of the samples. Besides a visual effect it creates, the meaning of spread for samples with
satin blocks is to ensure better coverage of the fabric loose edge.

Left: Basic shape of sample, right: sample with spread top

Spread has no effect on some samples with spiky outer side.

Transverse Lines - Layers . The Transverse Lines in overlock sample are those individual stitches that run from the
inner contour to the outer contour and vice versa. They are treated in a different way than stitches parallel to the edges
and also different than the satin stitches. Transverse lines can be sewn as multi-layered to achieve a bean-stitch effect.
Available options are single layer, 3 layers and 5 layers.

Illustration of transverse lines in overlock outline (solid, magenta) versus edge lines (dotted,
black).

Transverse Lines - Dispersion . If transverse lines are multi-layered, Dispersion controls how far the layers are one
from another. The first layer is in the middle and next layers are offset to the left and to the right. Dispersion has no effect
on a single-layer lines.



Satin Stitch - Spacing parameter indicates the density of the satin parts (if there are any in the chosen overlock
sample).

Width is the width of reference cells along the outline to which the samples are projected. It is not necessarily the width
of finished outline, because projected sample can be wider or narrower than reference cells.

Cell Width

Flip Sides Use this option to swap sides of the overlock.

Sample Baseline This option defines the reference contour on which the sample cells are constructed. Inner contour is
shorter than center line and outer contour. Therefore, projecting given cell length on outer contour results in spacing of
cells different than when projecting the same cell length on an inner contour or on a center line. This effect is most visible
near sharp corners of the outline. Selection of baseline depends on the overlock sample and the effect you preffer.

Left to right: Inner contour as baseline, Center line as baseline, Outer contour as baseline

Pull Compensation is extension of each stitch on edge of object in order to compensate for thread pull (on elastic
fabric) or sinkage (on fleece). The thread pull causes the ends of stitches are pulled inwards and object is smaller
(narrower) than intended.

User Guide > ^Object Parameters > ^Sfumato

Parameters - Sfumato

These parametersapply only to selected objects that are Sfumato objects. Sfumato objects are used for creation of
photo-like embroidery designs. It is often used to create portraits,landscapes or still-lives. Sfumato object is drawn
exactly like the Fill object, but the stitches inside of object are generated in other way. Thread creates meanders of
various size to approximate the picture (photo) under the object.



Left: design composed of 6 Sfumato vector (outline) objects. Center: finished design filled with
stitches. Right: meanders of different shade and density - detail.

Meanders are replaced with plain fill of given angle on the highest density places. Sfumato does not cover whole area of
the object with stitches, but it leaves fabric show through stitches on loose places. Therefore, it is important to choose
Background Color of Sfumato objects properly, because density of stitches is adjusted according to Background Color
and thread colors.

Sfumato object is filled with 1-5 shades of thread. Shades are generated automatically from Basic Color of the Sfumato
object or set manually by user. User can switch on and off respective shades and thus control number of colors within
single object. Each color (thread shade) has Additional Density and Shade Threshold adjustable parameters.

Sfumato object can have openings like the Fill object. Use the opening tool to add openings to Sfumato object. Also,
Sfumato object can have carvings. Unlike the Fill object, carvings on Sfumato are formed by additional stitches and not
by needle points pattern. User can adjust width and color of carvings. Carving objects must follow immediately after
Sfumato object and its openings.

Parameters of Sfumato object are organized into several tabs of the parameter panel.

Mode

Mode combo box at the top of Sfumato parameters panel allows to switch between these working modes:

1. Parameters Mode

2. Pick Color from Image - click work area to pick color from picture in its background. Use
pop-up menu to choose where do you want to use picekd color (basic thread color, mask color, etc).

3. Shades Layout Preview - this preview mode renders Sfumato object in the work area as
color map to let you see layout of shades within the object. Change respective threshold parameters or mask
range to accuratelly adjust the color layout.

Sfumato object has much more parameters than other types of objects. It would be very cumbersome to change
parameters and then generate stitches to check their effect on the stitches. Therefore, there are preview modes available
directly in the parameter panel to make work with Sfumato objects faster.

Another handy mode is the pick color mode. As stitches in the Sfumato objects are generated from photo, it is usefull to
bring colors from photo directly to various Sfumato parameters.

Above modes are usefull when accessing parameters via main control panel during the node editing in work area,
because all these modes interact with the work area. Pick color mode allows to pick color from picture in the work area.
Shades layout preview modes renders respective preview directly on the work area.



Above modes have no effect when accessing parameters via sit-on-top parameters window when work area is
not interacting.

Main Settings Tab

Angle defines the angle of plain fills in heavy density areas.

Maximum stitch is a longest running stitch in loose density areas. Longer stitches are replaced with jumps. Long running
stitches may not look good, if they cross eyes, mouths or other parts of design. However, too many jumps complicate the
sewing process.

Fidelity parameter affects the stitch count and accuracy of Sfumato object. Higher Fidelity means higher stitch count and
better accuracy. To reduce stitch count and speed-up the sewing process, use lower fidelity (0-40%) on objects like
background, cloths, sky etc.. Higher fidelity (70-80%) is recommended for faces and other areas where accuracy is more
important than the stitch count.

Style of loose density areas defines the stitch style or layout of loose stitches. Use it to give object desired texture.

Styles from top to bottom are:

1. Common Sfumato meanders
2. Contour stitches (default)
3. Contour stitches (higher density)
4. Contour stitches (highest density)

First option, Meanders, produces stitch layout similar to previous Sfumato version, but with less trims and stray stitches.

Default style is Contour stitches, which produces the most efficient stitch layout. The stitches do not follow the contour on
all places. Where not applicable, the meanders are used automatically.

Higher and Highest density options allow to achieve more compact coverage. This means than fabric shows through
stitches less than with other options.

Color Tab

This tab contains color controls and controls closely related to those colors.

Basic Color . This color is used as a base for threads generation. It is also used for displaying of Sfumato object in
Object Inspector and in the work area.

Background is the fabric color. This color is supposed to show through stitches. Density of each thread shade is derived
from the Background color.

Thread Shades . Actual colors of threads that fill the Sfumato object are generated automatically from the Basic Color or
set manually by user. Automatic shades form a monochrome scale. User-defined scale may contain any color. Click right
mouse button on a shade color box to open color mixer window. Individual shades can be turned OFF if you wish to use
lower number of colors within the Sfumato objects. This usefull for small size objects.

Additional Density . Sfumato automatically adjusts density of all parts of the objects. However, user may want to
increase or decrease density of particular color within object.

Shade Threshold . Sfumato automatically splits whole range of color tones within object into 5 thread shades. User can
adjust the shade thresholds with these parameters.

Contrast affects the colors of automatically generated threads. When doing portrait, use lower contrast on child or
woman face to achieve softer thread shades.



Mask Tab

Some photos may contain many small areas of various colors (flowers on the meadow, for example) and it is hard to
trace each of them as a separate Sfumato object. In such case, use Color Mask to fill only part of object with stitches:

Make one large Sfumato object.

Select mask color count .

Pick respective mask colors from image in the Work Area with use of the Pick Tool .

Adjust range of the masks. Use preview mode to check layout of masks.

Activate just one mask (green meadow, for example) and adjust rest of Sfumato parameters.

Close parameters window and generate stitches for the sfumato object.

Copy and paste this Sfumato object and change active mask and color selection so that the rest of the object is stitched
(red flowers, for example).

Density Tab

Stitch Spacing of high density areas . Set this value according to weight of your thread in order to achieve full covering
on the most dense places, where plain fill is used instead of loose meanders. Usual plain fill spacing values are 0.35 -
0.45 mm.

Overall density of low density areas . This scroll track allows user to make loose areas of design even loosier or
heavier.

Overall density of medium density areas . This scroll track allows user to make heavy areas of design loosier or even
heavier.

Carving Tab

Carvings are lines or curves that are drawn after the Sfumato object. They can be used to emphasize edges in the
Sfumato object. User can adjust two carving parameters:

Carvings Color . Carvings may be only of one of the thread shades color. Even if thread shade is disabled, carvings
may be of this color.

Carvings width . Use this parameters to make carvings bolder. Carvings wider than 0.2 mm are composed of short lines
placed at the same angle as plain fill in Sfumato object.

User Guide > ^Settings

Settings

Studio allows access to multiple settings that help user to customize work space and tools. These settings are pinned to
the common Settings panel that can be invoked via ∎ main menu > Options > Settings .



A Category List . Settings are organized to categories. This list allows to select required category.

B Content Tabs . Settings belonging to selected category are displayed in these tabs.

C Splitter . Move splitter to left or to the right to set proportion of list and content as desired.

D Buttons . Buttons change according to selected settings category. Some categories provide additional
actions accessible with these buttons. Common action for all categories is Reset , which sets default value to
all settings in selected category.

Setting Categories
Regional
Rendering
Lettering Preferences
Preferences
Project Switches
Hoop
Recent Files
Predefined Styles

Note: controls marked with this icon are duplicate. They are accessible via other panels or menus too. They
are listed in the common Settings Panel for the sake of completness.

Regional

Language

Units . Metric and imperial system is currently available.



Rendering

Settings in this category are organized into several tabs:

3D Mode

Settings for 3D rendering of design in the work area.

Show Fabric. If disabled, the hoop will be shown beneath the design. Same setting is accessible via ∎ main
menu > View .

Fabric Texture . Choose from pre-defined fabrics.

Fabric Color .

Shadow Intensity . Shadow adds depth to 3D rendering, but may look not good on Sfumato Stitch objects with loose
stitches. If you work on a Sfumato Stitch design and use 3D preview, we suggest to set Shadow Intensity to 0 (zero).

X-Ray

Short Stitches Color . X-ray mode allows to spot stitches that are too short and may not sew well. Short stitches in X-
ray are rendered in this color.

Short Stitches Max. Length . Length threshold for stitches that are considered to be too short.

Long Stitches Color . X-ray mode allows to spot stitches that are too long and may not sew well. Long stitches in X-ray
are rendered in this color.

Long Stitches Min. Length . Length threshold for stitches that are considered to be too long.

Stitch Color Saturation . X-ray mode is almost grayscale, but little amount of color helps to distinguish objects one from
the other. Set amount of color with this control.

Sew Simulator

Mode. Sew simulator allows to choose how stitches are rendered (3D, flat, etc.).

Lettering

These settings allow to define screen rendering colors of controls such as handles, nodes, baseline, etc., used in
interactive lettering mode. It is also possible to define opacity of the lettering fill.

All Modes

Show Jump Stitches. Same setting is accessible via ∎ main menu > View .

Jump Stitches Color .

Jump Stitches Highlight Color . Color of glow around the jump stitches for better visibility on a colored background.
This glow appears only when design is zoomed in sufficiently. It is not used when design is zoomed out.

Control Lines Thickness Use thicker lines to make stitches, vector edges, selection box etc. better visible if you have
high resolution display. The same parameter is also accessible in pop-up menu of Work Area.

Vector Objects Area Opacity . Inside regions of digitized vector objects are rendered on screen as semi-transparent
color areas if they have no stitches generated. When stitches are generated, these stitches are displayed instead of the
semi-transparent color. This setting allows to define opacity of the inside regions.



Tie-up Stitches Color . This settings allows to distinguish tie-up stitches from other types of stitches. It works only when
Show Jumps is turned ON. It has no effect in Density Map display mode.

Thread Rendering Thickness . This value is used for rendering stitches in 3D, flat, X-ray and Density Map
display modes.

Lettering Preferences

All lettering settings are also accessible in main control panel in the lettering mode.

Font

Default Font. This setting affects TrueType and OpenType fonts.

Default Alphabet. This setting affects pre-digitized Embird Alphabets.

Styles. Font settings like Bold, Italic, Vertical lettering, Unicode character set (not applicable to Alphabets). Another
font setting is Flattening. Flattening of composite glyphs allows to convert fonts made from blocks into common curves
for correct conversion into embroidery.

Archives

These settings are for TrueType and OpenType fonts. They are not applicable to Alphabets.

Paths to folders with additional TrueType and OpenType fonts, which are not installed in the operating system. Set
these paths if you want to include these fonts to lettering system of Studio. Appy Find Fonts function in lettering mode to
let Studio include these fonts.

Scan Archive Files too. If this option is turned ON, Studio searches for TrueType and OpenType fonts also inside of
.zip archive files.

Sewing

Fill. The way how letters are filled with stitches. Available options are plain fill, mesh, autocolumn and center line.
Plain fill, mesh and autocolumn may also be outlined. In case of mesh option the lettering must be large enough to make
the mesh visible.

Order. Sewing order of letters and/or words. Sewing from center to sides may reduce push effect when sewing on a
soft fabric.

Connections. Choose if there will be connection stitches or trims between the letters and also between the letter
parts like dots.

Alignment.

Glyph Set

Pre-Defined Set. Text boxes in this tab allow to type-in pre-defined texts or glyph strings. These texts are available in
lettering mode for a quick insertion with shortcut buttons in the Text tab.

Preferences



Edit Mode

Column Mode Preferred mode for creation of column objects. Mode A is separate left and right side of column. Mode
B is alternate left and right side. Mode C is creation of both sides at the same time.

Column Width Width used for column mode C.

Colors Colors of nodes, lines, cursors, lettering controls, etc.

Save

If Auto Save option is ON, design is automatically saved to disc every 5 minutes.

Back-up Files control allows to turn on/off automatic creation of back-up copy when saving file. Back-up copy is stored
in the same folder as design file.

Selection

If Highlight Selected Objects is checked, objects that are selected are outlined with chosen color . This helps to locate
selected objects visually in the work area more easily, especially in case of thin outlines.

Work Space

Background

Background Color is color of empty space in the Work Area. This space is a lowest layer of Work Area and may be
hidden by upper layers like imported raster picture or rendered 3D fabric.

Grid

Grid is set of lines or other objects rendered over the Work Area that helps to position and size digitized objects more
accurately.

Note: some grid lines or even all of them may be visible only when zoomed in sufficiently.

Main Grid . Cell size of main grid measured as fraction of an inch or centimeter, according to chosen regional settings.

Subdivision . Size of subdivision to main grid. Subdivisions define a finer grid, which is visible only when zoomed in.

Secondary Grid . Special additional grid like radial or diagonal grid. It is useful when working on designs requiring
symmetry or specific layout of objects.

Grid Color . Same color is used for the main and secondary grid and for their subdivision. Respective grids are rendered
with different opacity.

Guide Lines

Normal Color of Guide Lines

Color of Selected Guide Lines

General

Object Inspector - Tap Mode. When this mode is turned ON, all items in Object Inspector list have
additional checkbox that allows to select multiple objects with finger tap, stylus or single button mouse.
This setting is intended for devices with touchscreen.



Size of Key Controls . This parameter affect dimensions of some common control like scroll bars, splitter panels, rulers
and tab headers.

Project Switches

These settings are used when starting a new design digitizing in Studio and are stored with this design in its file.
Therefore, loading an existing design overrides these settings with values from the design file.

Snap

Snap function works so that when moving object or node close enough to a target, the object or node being moved is
aligned precisely to the target. Target may be other object, node, grid line, etc. Following switches allow to turn ON or
OFF respective snap options.

Snap Objects to Guide Lines

Snap Objects to Grid

Snap Nodes to Guide Lines

Snap Nodes to Grid

Snap Nodes to Nodes

Snap Nodes to Object Edges

Snap Nodes to Edges of Work Area

Show Objects

Show Fills

Show Sfumato Stitch Objects

Show Carvings

Show Columns

Show Columns with Pattern

Show Appliques

Show Outlines

Show Connections

Show Manual Stitches

Mode

Edge Mode. Straight line or curve elements. This applies to node editing, creating a new element on the edge.

Node Order when Creating New Edge. Normal or midpoint first. This applies to node editing, creating a new
element on the edge.

Object Rotation Mode. Angle or number per revolution. This setting is for Transformations Window.

Object Selection Mode. New selection, add to selection or select subset.

Show Rulers

Show Grid



Show Object Boundaries

Show Object Stitches

Show Single-Pass Outlines as Thick. Outlines are often digitized as double-layered (forward and backward pass).
This option helps to find parts of outlines, that have only one layer, visualy in the Work Area.

Show Guide Lines

Other

Lock Guide Lines. Enable or disable editing of guide lines in the Work Area.

Edit All Nodes. Applies to node editing. When turned OFF, only nodes on the last element of the edge can be edited.
This option is usefull when editing very complex object.

Hoop

Hoop size determines the size of working space in the Work Area. Choose from pre-defined hoops or set your own
custom hoop size.

Predefined Hoop

Brand . Select brand of hoop and then hoop size from the list.

Orientation . Default (in most cases vertical) or rotated.

Custom Hoop

Size

Round

Recent Files

Recent Files contains list of design files recently used in Studio. This panel allows to reopen recent file or to clear the
file list.

Predefined Styles

These settings allow to accomodate embroidery design for various kinds of fabric taking into account fabric ellasticity,
thickness, strength, etc..

Thread Weight . Studio can calculate many style settings from the thread weight. Set the thread weight you are using
and click Apply Thread button to recalculate respective settings.

Style . Select the kind of fabric on which design is going to be embroidered.

List of settings . This list allows to change all settings manually.



Apply Thread . Click this button to recalculate settings related to thread weight automatically. This will replace current
values of these settings.

Use Style . Click this button to apply changed settings and generate stitches for selected objects.

User Guide > Curly Plant Mesh - Essential Guide

Curly Plant Mesh - Essential Guide

How to create various fills, ornaments and monograms with Curly Plant
Mesh tool
Curly Plant mode of the Mesh tool is capable to produce many different results. This tutorial aims to illustrate its features.
It is organized into following sections:

1. Drawing Mesh Object
2. Origin Point
3. Fill from Origin Point
4. Options Tab
5. Span
6. Size Levels
7. Overall Scale
8. Ornaments and Monograms
9. Growth Kind

10. Symmetry
11. Irregular Parent Object
12. Seed
13. Base
14. Core
15. Core from Font Glyph
16. Core from Library Glyph
17. Core from Hole Contours
18. Core from Carving Contours
19. Flowers
20. Leaves

Drawing Mesh Object

Mesh tool
icon

Use mesh tool from the tool bar to draw a mesh object. In this tutorial, many objects were created with ellipse (circle)
shape. Mesh object can have holes and carvings.

Origin Point



Default place from which the plant fill grows inside the mesh object is called Origin Point .

Position of the Origin point is defined during creation or editing of the Mesh object vector contours, i.e. in a node-by-node
vectorization mode. While still in the vectorization mode, use pop-up menu > Place > Place Mesh Origin Here to

place Origin Point at position of the cursor.

Creating mesh
object with vectors.

Mesh object with
Origin Point

If Origin Point is not defined, a geometric center of the object is used as Origin Point. If Origin Point is placed outside of
object or into its hole, the program may decide in some situations to use nearest point inside the object, instead.

Fill from Origin Point

When vector boundaries of the mesh object are drawn, its parameters can be adjusted. Default mesh mode is
Stippling . Select Plant mode instead, then select Curly Branching instead of default Plain Branching . Then
generate stitches for this object leaving the rest of parameters with their default values. The curly plant fill generated with
these parameters starts in the Origin point and consists of sprouts growing one from another.

Plant growing from the Origin
Point

As can be seen on above picture, the default curly plant fill is cropped to the object boundaries and the boundary
contours are stitched too.

Options Tab

Span

The way of how sprouts crossing the object contours are handled is controlled by Span control. Possible values are
Overflow , Cropped and Interior .

Overflow of fill collides with object contours. You may want to switch off stitching of these contours. In such a case, use
common Mesh settings to exclude contours.



Fill overflow,
contours included

Fill overflow,
contours excluded

Interior fill,
contours included

Interior fill, contours
excluded

Size Levels

Curly plant is build with 1-8 size levels of sprouts, where level 1 is the smallest and level 8 is the largest. Sprouts
belonging to same level are not identical in size. They vary in certain range to achieve more organic look. Selection of

size levels affects the homogenity of sprouts layout.

Size levels 1-4 Size levels reduced
to 1

Overall Scale

Overall Scale works like a zoom tool for sprouts. This control allows to increase or decrease the size of all sprouts (all
size levels of sprouts). It affects all sprouts, including leaves and flowers. It does not affect basis and core, which have
their own scale control or their size is fixed. Indirectly, the overall scale increases or decreases also the empty space
between the sprouts.



100% overall scale
of sprouts

200% overall scale
of sprouts

Ornaments and Monograms
Previous examples illustrate the plant growing autonomously from the origin point and resulting in the fill of the entire
mesh object. The term autonomously means that the growth of the plant is not managed. However, the Growth Kind
control allows to select other ways of the plant growth, which are managed in some way or other. They introduce
rotational symmetry and mirroring. Instead of filling the parent mesh object, they produce decorative object or ornament
that uses parent mesh object as a shape template. Also, the plant may grow from vector object, or multiple vector
objects, not just from a single point. If letter glyph is used as a core from which the plant grows, resulting mesh may look
like a monogram.

Growth Kind

The Growth Kind control in the Options Tab allows to choose how the plant grow starts and whether it is managed
(symmetry, mirroring) or not.

1

2

3

4

Sprouts Growth Symbols: 1 from origin
point (autonomous), 2 from core (font

glyph, library glyphs, hole or carving), 3
from origin or from base, rotational

symmetry, 4 from origin or from base,
mirrored and rotated

1 432a 2b



Sprouts Growth Examples: 1 from origin point
(autonomous), 2a from core (library glyph), 2b from core
(font glyph), 3 from base with rotational symmetry, 4 from

base, mirrored and rotated

Symmetry

Grow kinds can be divided into 4 groups as illustarted in above diagram. Let's start with growth #3, which uses
symmetrical sectors. The point of symmetry is identical to the Origin point.

Rotational symmetry with 3 sectors

The sprouts grow in just one sector (bottom-left, marked with red color in above picture) of the mesh object (circle, in this
case) and they are copied around the Origin point to other sectors. The parent mesh object does not need to have
circular shape. Shape of the bottom-left sector is used in all other sectors regardless of the real shape of those sectors.

Curly plant with
rotational

symmetry - 7
sectors

Curly plant with
rotational

symmetry - 5
sectors

To avoid excessive density, the inner sprouts may not meet in the Origin point. In such a case, the sprouts are connected
on other proper nearest-point place.

Rotational symmetry can be combined with mirroring across the side of sector. Again, the source sector is the red one.
The rest of sectors are its rotated and mirrored copies.



Rotational symmetry combined with mirroring

Mirroring. In this example, a base vector object was used to plant sprouts from. Origin point is
intentionally placed below the geometric center of the shape to make base asymmetric with

respect to the horizontal axis.

Rotational symmetry combined with mirroring.

Below are more examples of rotational symmetry and mirroring.

Plant with mirroring,
some sprouts
replaced with

flowers

Plant with mirroring,
leaf kind #2

Plant growing from
base, mirroring and

3x rotational
symmetry

Plant growing from
base, mirroring and

6x rotational
symmetry

Plant growing from
base, mirroring and

4x rotational
symmetry



Irregular Parent Object

As mentioned before, the plants with rotational symmetry and/or mirroring take their shape from just one part of the
parent mesh object. This part is called source sector and it is always a bottom-left sector of the object. The rest of the
plant is rotated or mirrored copies of the source sector. This section illustrates how does it work.

The mesh object on which we are going to demonstrate the symmetry and mirroring is intentionally irregular. The
Growth Kind is Mirror with 3x Rotational Symmetry.

Irregular mesh object with Origin point The source sector (red) of the mesh
object for mirroring and 3x rotational

symmetry

Plant grows only in the source sector and this is also the only place where plant growth respects the parent object
contours. In this example the sprouts grow from two basis (predefined vector objects). The basis are highlighted in dark
and bright blue color. Please notice how basis are deformed as result of the assymetric shape of the source sector.

Source sector with grown plant. Mirroring of source sector across its
side.

Program mirrors the plant from source sector to achieve reflectional symmetry of source sector and its neighbour. Then
copies of both of these sectors are rotated to fill the rest of the sectors. Please notice that contours of the parent objects



are taken into account only when growing the source sector fill and they are ignored in all other sectors.

Rotational symmetry applied Finished fill (ornament)

Seed

Seed is a start value for random generator of the plant. Different seed values result in different size and layout of
sprouts, flowers and leaves, while keeping all settings preserved. Seed value can be set with numerical control or with
up and down arrow buttons. The buttons serve for quick change of the seed and they also apply the new seed value
(generate stitches for the mesh object).

In other words - hit seed arrow button to obtain different variant of the plant fill.

Base Tab

Growth Kind (control in the Options Tab) with symmetry allows to use either the Origin point or vector template called
Base as a platform for sprouts to grow from. Base is a pre-digitized sample projected to each sector of the

symmetrical plant. While sprouts are random, the pre-digitized symmetrical basis bring some kind of order and formality
to the plant ornament.

User can use up to 4 basis in a single curly plant mesh object. If no base is used, the sprouts grow from the Origin point.
If one or more basis are used, the sprouts grow from these basis.

Basis form rings of different size and width around the Origin point. Each base has its own adjustable parameters:
Kind (Sample), Size and Width. Size and Width allow to tweak basis to achieve desired layout. Basis may

intersect each other.

Two basis combined in a
single object.

Three basis combined in
a single object.



Mesh fills (objects) are monochrome, the colors in these illustrations were added only to differentiate basis (red,
orange and green) from leaves (violet).

You can create ornament with just basis and no sprouts if you set the Maximum Sprouts Generations to zero.

Core Tab

Core is another kind of pre-digitized vector platform for growing sprouts from. Unlike base, the core can be
assymetric and even user-defined (with use of holea and carvings of the parent mesh object). There are four types of the
core:

1. from a single font glyph
2. from a single library glyph
3. from holes of the parent mesh object
4. from carvings of the parent mesh object

1. Core from Font Glyph

Core from Font Glyph Core from Font Glyph

Core from font glyph, 1 sprout
generation

Core from font glyph, 2 sprout
generations

2. Core from Library Glyph



Core from Library Glyph Core from Library Glyph

All pre-digitized library core glyphs (type #2) allow mirroring of the sprouts which grow from them. Other core types do
not allow mirroring regardless of their shape.

3. Core from Hole Contours

Core from holes of object

Core from hole contours has fixed size and cannot be scaled.

4. Core from Carving Contours

Core from carvings of object

Core from carving contours has fixed size and cannot be scaled.

Please see detailed tutorial describing advanced techniques of how to use carving cores in curly plant mesh
object .



Flowers Tab

Some sprouts can be converted to flowers. There are two kind of flowers available:

1. flowers generated from font glyphs
2. predefined flowers from library

Although the font glyphs are intended mainly for fonts containing floral clipart, they allow to use any other letters or
symbols instead of flowers as well. Besides common font styles like Bold and Italic, there is also an Rotation
control available, which rotates glyph with respect to the parent sprout. Flowers have their own Scale control for
adjustment of their size. Also, there is a Compression control which allows to make bottom part of the flower
narrower.

Maximum mumber of flowers is roughly controlled with Amount parameter. However, exact number of flowers cannot
be guaranteed as their placements is pseudo-random.

Multiple flowers can be used in a single object.

One flower (library) Two flowers (library)

Two font glyphs Two font glyphs with
compression=100%

Leaves Tab

Some sprouts can be turned to objects resembling leaves. There are several kinds of leaves available, with different
overall shape. Leaves have adjustable Width, Length and Curliness. Curliness is a meassure of how much the
leaves are bent to a spiral shape.



Leaf 1, Leaf width=100% Leaf 2, Leaf width=100%

Leaf 3, Leaf width=100% Leaf 4, Leaf width=100%

Leaf 1, Leaf length=50% Leaf 1, Leaf
curliness=25%

Leaf 1, Leaf
curliness=100%

Leaf 1, Leaf
curliness=100%, Leaf

width=0% (sprouts
instead of leaves)



See Also

Mesh Tool - Curly Plant Parameters
Curly Plant Mesh - Advanced Techniques

User Guide > Curly Plant Mesh - Advanced Techniques

Curly Plant Mesh - Advanced Techniques

Step-by-step Guide
This guide is a follow-up to the Curly Plant Mesh - Essential Guide . It explains how to combine the Mesh tool and other
digitizing tools to create complex embroidery designs.

Chapters

1. Use of the Fractal Fill as Core for the Curly Plant Fill
2. Use of Lettering as Core for the Curly Plant Fill

See Also

Mesh Tool - Plant Parameters
Curly Plant Mesh - Essential Guide

Example #1 - Use of the Fractal Fill as Core for the Curly Plant Fill

Curly Plant with Fractal as a Core

The main principle behind this example is to create fractal lines, convert them to outlines and then to ∎ carvings of
the mesh object. Once the mesh object has carvings, they can be used as a platform (core) to grow the plant fill from.

1. Draw Mesh Object, it must be large enough. 10x10cm (4x4 inches) for example.



Mesh object drawn with vectors
2. Open Parameters window
3. Select Net > Fractal fill
4. Select Fractal Kind (#25, for example)
5. Switch on Smooth option if you wish
6. Set Average Width of Gap to some larger value (20, for example)
7. Select Single Layer
8. Generate Stitches to see layout of stitches

Net > Fractal fill with large
spacing

9. Select this new Mesh object and use ∎ main menu > Convert > Fill, Mesh & Sfumato > Create Separate
Outline Elements command

10. Select the newly created object, which is in fact a group of outlines sitting on top of the original Mesh object.
Ungroup this new outline objects.

11. Delete outline representing outer contour of the object. We will not need carving line of this shape

Delete the contour line item

12. Select remaining outline objects
13. Use ∎ main menu > Convert > Outline > Outline To Carving command. The outline items should disappear

from the Object Inspector panel because they become carvings of the original Mesh object
14. Select the Mesh object and open Parameters window
15. Change mesh mode from Net to Plant > Curly Branching
16. Change the Growth Kind to From Core
17. Switch to Core tab and change Core Kind to Carvings
18. Generate Stitches



Plant sprouts growing from the
fractal core

19. Adjust other parameters (flowers, leaves, etc.) if you wish

Leaf and flower parameters
changed

Note

If you need to edit indiviual sprouts, flowers or other parts of the curly plant mesh fill, convert this fill to single
outline elements with use of ∎ main menu > Convert > Fill, Mesh & Sfumato > Create Separate Outline
Elements command. Then do required editing of these outline elements and when finished, use ∎ main
menu > Build > Outlines > Arrange Outline Parts command to create compact object from these elements.
In such a case, the original mesh object was used only as an intermediate source of outline elements.

Example #2 - Use of Lettering as Core for the Curly Plant Fill

Curly Plant with Lettering as a
Core

The main principle behind this example is to create lettering, convert it to outlines and then to ∎ carvings of the
mesh object. Once the mesh object has carvings, they can be used as a platform (core) to grow the plant fill from.

1. Draw Mesh Object, it must be large enough.



2. Create ∎ lettering (you need to have Font Engine plugin for Embird). Select plain fill mode without utlines for
the lettering.

Lettering

3. Place lettering object on top of the Mesh object. Resize lettering to fit inside of the Mesh object.
4. Use ∎ main menu > Transform > Envelope command to enter the envelope mode. Adjust the lettering object

with envelope. Notice the space left around lettering inside the Mesh object to allow growing of the sprouts.

Lettering adjusted with envelope
placed on the Mesh object

(rectangle)

5. Lettering is now in the form of plain fills. Use ∎ main menu > Convert > Fill, Mesh & Sfumato > Create
Outlines from Fill command to create outlines of the lettering

6. You have 2 lettering objects one on top of the other now. The first is in pain fills, the second is in outlines.
7. Delete the first lettering object (plain fills)
8. Use ∎ main menu > Convert > Outline > Outline To Carving command. The outline items should disappear

from the Object Inspector panel because they become carvings of the original Mesh object

Mesh object with carvings
created from lettering

9. Select the Mesh object and open Parameters window
10. Switch off the Include contours (both outer and inner) in the common mesh settings
11. Change mesh mode from Net to Plant > Curly Branching
12. Change the Growth Kind to From Core
13. Change Span to Inner
14. Change Maximum Sprout Generations to 2
15. Switch to Core tab and change Core Kind to Carvings
16. Generate Stitches



Plant sprouts growing from the
lettering core

17. Because of the limited number of sprout generations the sprouts do not extend to the contour of the mesh object
and they roughly follow the shape of lettering

18. If lettering is thick, the sprouts may appear also inside of the letters. This is not true with above example as letters
are thin and there is no space for the sprouts inside them

Note

Instead of erasing the lettering object (step #7) you may preserve it and fill it with autocolumn

Lettering with autocolumn fill

In such a case you need to re-order objects in the Object Inspector before converting outlines to the
carvings. Move the Mesh object on position just before the outline object in the list. When outlines are
converted to carvings, they become part of the Mesh object before them.
Put the autocolumn lettering under the finished Mesh object so that it matches the carved contours. The
Mesh object is now a fancy border of the autocolumn lettering.

Curly plant mesh on top of the autocolumn
lettering

See Also

Mesh Tool - Plant Parameters
Curly Plant Mesh - Essential Guide



User Guide > ^Sfumato Stitch > ^Portrait

How to Digitize Portrait with Sfumato Stitch

Studio contains a special tool to digitize embroidery design from photos. It is called Sfumato Stitch .

Sfumato generates stitches from picture (photo) imported into background of the work area. User draws boundaries of
areas that will be turned into stitches and assigns proper parameters to each area (object).

Adjustable parameters of sfumato objects are described in Parameters-Sfumato chapter.

1. Import Photo

Use ∎ main menu > Image > Import command to import photo into the Work Area.

Resolution of the raster picture determines size of the finished design. The ratio between picture units (pixels) and
design size is 100 pixels/ 1 centimeter, which is 254 pixels/ 1 inch. This means that design with 10 centimeters (3.94
inches) height should have 1000 pixels. Each time the sfumato stitches are generated, the underlying picture is used.
Therefore, sfumato object cannot be resized without resizing also the underlying raster picture.

Imported photo must have correct resolution 100 pixels per centimer (or 254 pixels per inch) of
required size of design.

2. Digitize Face
Use the Sfumato Tool to draw the area you want to fill with stitches. Each area can have up to 5 shades of the 'basic
color'. In this example, draw the face area as a first object. Make the face object so that there is an overlay into hair.
Face will be filled with shades of 'skin color'.



Sfumato tool

Vector outline of face digitized on top of raster photo.

We want to make mouth in other color. Therefore, use the Opening Tool to cut off the mouth area.

Hole tool

Please note : besides Openings, Sfumato objects can also have Carvings. Sfumato Stitch - carving tool icon
Carvings are lines or curves that are drawn immediately after the Sfumato object. They can be used to
emphasize some hardly visible edges in the Sfumato object.

Carving tool



Face vector Sfumato object with a hole. Stitches are not generated yet.

3. Adjust Parameters
Select the face object in Work Area or in Object Inspector and invoke the pop-up menu. Choose 'Edit' command from
the pop-up menu. Face object switches to node editing and Sfumato parameters are displayed in the main control panel.

Mode combo box at the top of Sfumato parameters panel allows to switch between these working modes:

1. Parameters Mode

2. Pick Color from Image - click work area to pick color from picture in its background. Use
pop-up menu to choose where do you want to use picekd color (basic thread color, mask color, etc).

3. Shades Layout Preview - this preview mode renders Sfumato object in the work area as
color map to let you see layout of shades within the object. Change respective threshold parameters or mask
range to accuratelly adjust the color layout.

Select Pick Color from Image (eye dropper) tool from combo box in Parameters panel and pick 'skin' color from the
photo as so called 'basic color' of the object. Program automatically generates 5 shades of this color.

Please note : The same combo box allows to switch to shades layout preview to see the influence of adjusted
parameters on the Sfumato object in Work Area.



Color tab on Parameters panel contains 5 shades of basic color and their parameters.

Shade parameters are:

A Shade Switch . Allows to switch ON or OFF respective shade.

B Shade Color . These colors are derived automatically from the Basic Color of object, but you can define your
own, custom shades. Click the color box to access the Color Mixer.

C Additional Density . Increase or decrease stitch density of individual shade, if necesarry.

D Shade Threshold . Sfumato automatically splits whole range of color tones within object into 5 thread shades.
User can adjust the shade thresholds with these parameters.

Decrease the contrast of shades with use of the Contrast control.

Click Generate Stitches button or use the same command from pop-up menu. This will finish the editing of face object.

First Sfumato object filled with 5 shades derived from basic color.

4. Digitize Mouth

Select the mouth opening in the Parts Inspector window and use the ∎ main menu > Convert > Fill & Sfumato >
Create Fill from Opening command to create filled mouth object.

Adjust parameters of the mouth object. Because it is a very small object, it is not necessary to use 5 color shades for it.
Disable1 or 2 shades by clicking on respective check marks (A).



Mouth Sfumato object with 4 shades of pink color.

5. Digitize Hair
Create the last area, hair, in the same way as face and pick appropriate color for its fill with use of the

Parameters window. Switch to shade preview mode and adjust Shades Threshold (D) to give the hair better shade
balance.

6. Save Design

Generate stitches for all three objects. The portrait is finished. Save design into Studio *.EOF file. Use the ∎ main
menu > Design > Compile and Put into Embird Editor command to place design into Editor for saving in desired
embroidery format. If you are not registered user of Sfumato Stitch, this command is disabled.



7. Other Examples of Sfumato Designs

Multicolored Design

Multicolored design (6 basic colors, 22 thread shades), height 16.8cm (6.6 inches).

Design contains 6 vector objects. Each object has number of shades chosen according to its size and complexity. For
example, the "mouth" is a small object and required low number of shades.

Background - 4 shades

Face - 5 shades. The face object contains a hole for mouth object.



Mouth - 2 shades

Sweater - 2 shades

Cap - 4 shades

Jacket - 5 shades

Sepia Color Scale

Height 21.8 cm (8.6 inches), 1 basic color (5 thread shades)

Design contains just one vector object - a simple rectangle that covers whole photo. Shades are generated automatically
from its basic color.

Grayscale Design



Height 20.8 cm (8.2 inches), 1 basic color (5 thread shades)

Design contains just one vector object - a simple rectangle that covers whole photo. Shades are generated automatically
from its basic color.

User Guide > ^Sfumato Stitch > ^Color Mask

How to Use Color Mask in Sfumato Stitch

Sfumato Stitch is digitizing tool that creates embroidery design from photo. It is based on digitizing vector boundaries of
individual objects which are filled with stitches according to underlaying photo.

Digitizing of all individual objects works for some photos (like portraits, for example), but is not suitable for photos with
many small objects. Color mask feature is intended for situations where there are too many different color areas in the
photo and it would be hard to draw them all separately.

In such a case, make one large object which includes all color areas and use color mask. Color mask allows to pick a
color range within the object and stitch just this part of object. To stitch also other colors in the object, stack copies of the
same object one upon the other as layers and select different masks (i.e. color ranges) in each layer to cover whole
object with stitches. This approach allows to avoid drawing many small objects.



Photo that we are going to digitize has number of different color areas. These areas have
complex shapes which are hard to digitize individually.

1. Digitize the Edge of Sfumato Object

Sfumato tool

Use the Sfumato Tool to draw the area you want to fill with stitches. As we are going to use masks, it is sufficient to draw
one large rectangle.

Simple Sfumato object of rectangular shape made with just few nodes.

2. Parameters - Set Masks



Adjustable parameters of sfumato objects are described in Parameters-Sfumato chapter.

If you have already finished node editing mode when creating the Sfumato object, switch back to the node editing mode.
In this mode, we see parameters of the object (in the Main Control Panel ) and the object itself in the Work Area.
This is usefull when working with Sfumato objects because it alllows us to use Sfumato preview directly in the Work
Area.

Mask controls are located on a tab with above icon.

There is a green background and orange and yellow flowers in the photo, therefore we will need 3 masks. Set Mask
Count to 3. Use the eye dropper tool to pick orange color from the photo as a Mask Color 1 . Then pick yellow color
from photo as a Mask Color 2 and green color as Mask Color 3 . Order of colors is up to your decision. Because of
thread and fabric physics, it is better to sew from center of design out towards its edges, but the layout of colors in this
picture does not allow it.

Three masks are set. Mask no.1 is activated.

Mask parameters are:

A Mask Color . Pick mask color from image or define it manually.

B Range . Increase or decrease range of the mask to enlarge or shrink the area of image occupied by this mask.
Absolute numeric value of the range is not important. Important is its ratio to ranges of the rest of the masks.

C Switch . Activate mask with this switch. Only one mask can be active in a each Sfumato object.

When picking mask colors from the photo, respective thread shades are generated automatically for each mask. You can
override automatic shades with your own colors, if you wish.

Note : The darkest shade, i.e. shade no.1 - black, is available only for the first mask. Other masks share this
shade.

Adjust balance between all three masks with Range value controls that are.next to the mask color boxes. Utilize the
Shade Preview to see effect of range changes.



Click on the first (orange) mask switch to activate mask no. 1, because we will generate the orange stitches first.

Shade Preview of how all three color ranges (orange, yellow, green) are balanced.
Orange parts are displayed with 5 shades of orange, because mask of orange parts is now

focused. Yellow and green parts are displayed as flat single color, because their masks are not
focused now. Only one mask can be active in the Sfumato object, the rest of masks will be active

on other layers.

3. Parameters - Adjust Other Settings
It is not necessary to use all five available shades for each color range. If color area is small or its colors are uniform, you
may switch off some shades to decrease the number of required thread colors.

Also, decrease the Fidelity value to reduce the stitch count. Fidelity affects design stitch count. Flower design like this
example can look great even with lower fidelity and it will sew faster and better because of lower stitch count and less
short stitches.

Another parameter applicable here is the Style . Different styles produce lighter or heavier stitch coverage in the bright
areas, which means that fabric is visible more or less than with other styles. In this example, style no.3 is used for
orange and yellow flowers to give them richier color because of higher stitch density in bright areas.

4. Create Layers
Click Generate Stitches button or use this command from pop-up menu. Of course, only the orange part of object is
filled with stitches.



First layer contains only the orange color range.

Select the object and Copy and Paste it to create a duplicate objects that lies just on top of the first object. Notice that
there are three identical objects in the Object Inspector window.

5. Activate Layers
Select second object from the Object Inspector list and invoke the pop-up menu. Select Edit command to switch to
node editing mode and to access the parameters panel. In parameters panel, activate mask no. 2 (yellow). Then
generate stitches for this object.

Mask no.2 is activated.



Second layer contains only the yellow color range.

Select third object from the Object Inspector list and invoke the pop-up menu. Select Edit command to switch to node
editing mode and to access the parameters panel. In parameters panel, activate mask no. 3 (green). Then generate
stitches for this object.

Mask no.3 is activated.

Third layer contains only the green color range.



Each layer has properly assigned mask and consequently also the color now.

Three masked Sfumato objects as stacked layers with different colors.

Sfumato objects as icons in Object Inspector.

6. Save Design

Generate stitches for all three objects. The design is finished now. Save design into Studio *.EOF file. Use the ∎
main menu > Design > Compile and Put into Embird Editor command to place design into Editor for saving in
desired embroidery format. If you are not registered user of Sfumato Stitch, this command is disabled.



7. Another Example of Using Sfumato with Mask
Let's digitize below image in Sfumato Stitch.

The mask feature allows us to achieve two goals:

1. Avoid tediuous digitizing of each individual object by making just one common Sfumato object.
2. Eliminate background if we want to.



Original image with white background

Image contains fine lines in black and gray shades, the background is white. We want this design to be stitched in a
single color (black).

Import image into Studio. Adjust its size to fit the hoop or resize it to a proper size. Then create Sfumato object with
Sfumato tool. In the example shown below, Sfumato object is of simple rectangular shape. It includes also the
background area. Select basic color for the object (black). If we use default parameters setting, generated stitches cover
whole area of the Sfumato object (including background) and there are 5 shades of gray thread used in this object.

Design with stitches in 5 gray tones and with background filled with stitches

We need to eliminate the background with use of the Color Mask . However, program cannot distinguish white color
from the scale of gray tones used in the image. Color Mask in Sfumato is based on the chromatic component of the
color. The brightness component is ignored. Therefore, black and white are regarded as just a different shades of gray
and they cannot be separated with use of the Color Mask.

We will use the image Background Filters to change white to some other color and thus allow Color Mask to separate
black details from the colored background.

Yellow-Blue balance of highlighted areas (white areas, in this case) in Background Filters panel was adjusted so that
background is yellow now.

Image with yellow-blue balance moved towards the yellow tones



Now we can easily separate black detail from the yellow background with use of the Color Mask. Set number of masks to
2. Pick black for the mask 1 and yellow for the mask 2. Adjust mask ranges to achieve best foreground/background
balance. Then select the first mask (black). As we want only single color design, disable brighter shades (1-4) and use
only the darkest shade no. 5 for stitching.

Two masks are set. Mask no.1 is activated.

Generate stitches . Finished design has only one color and the background is eliminated.

Finished single-color design.

User Guide > How To? > Freestanding Lace

Freestanding Lace (FSL)
Freestanding lace (FSL) is embroidery design sewn on a water-soluable stabilizer, which is washed away after design is
embroidered. The stitches in such design must be laid so that they support each other because there is no fabric to hold
them (except for appliques which may or may not be part of the FSL design).

Studio NEXT provides loose fill which can be used as a background to secure the rest of the FSL design. It is called FSL
Grid and it is a kind of Mesh > Net object.



FSL Grid

The FSL Grid can fill object of any shape, even with holes. There are several grid patterns with adjustable spacing and
layer count available in the Parameters window.

Typical FSL design has border made of satin stitches to hold the lace together. In Studio NEXT, the satin stitches are
created either with Column tool or with Outline tool > Satin mode.

Other parts of FSL design can be digitized with use of Outline tool > Sample mode, for example.

Remnants of stabilizer make FSL embroidery stiff. If you want more stiffness, spray the finished embroidery with
stabilizer dissolved in the water and let it dry.

User Guide > How To? > Stippling

Stippling
Stippling is a loose fill created with meandering stitch path. In Studio NEXT the stippling fill is created with Mesh Tool
 using modes like Net > Fractal , Stippling and Tiles > Blackwork . These mesh modes allow to create number of
stippling patterns.

Stippling from Mesh > Net > Fractal fill

User Guide > How To? > Overlock

Overlock
Overlock in Studio NEXT imitates straight and zig-zag stitches made by specialised serger machine (overlocker), which
are used to stop fabric from unravelling.



Outline with Overlock mode can be used to create a patch edge, even with corners

Another example of outline with Overlock mode

Use Outline tool in overlock mode to create vector object with overlock stitches.

Overlock Samples

Respective overlock samples can be modified with adjustable parameters .

Outline object in overlock mode can form a closed figure or open path.

User Guide > How To? > Object''s Individual Underlay Parameters



Object's Individual Underlay Parameters
How to Override Global (Overall) Underlay Settings
Underlay stitches generated for solid objects like plain fills, autocolumns, columns, border outlines, etc. are controlled
with set of parameters. Some of these parameters are local, i.e. individual for each vector object. Some are global
(overall). Global parameters can be overriden with use of controls described in the following text.

Both global and local parameters are accessible via Parameters window. Controls which override global underlay
settings are located in Underlay - Advanced Tab. They are arranged into several groups according to type of the
underlay.

1. Center

Inherit from Overall Settings . This switch turns on and off the overriding of global settings with individual settings

Min. Length is approximate length of shortest stitches in the center underlay. Short stitches occur in sharp curved
sections of the underlay path.

Max. Length is approximate length of longest stitches in the center underlay. Long stitches occur in straight sections of
the underlay path.

Center walk underlay is not available for Fill - Plain mode.

2. Edge

Inherit from Overall Settings . This switch turns on and off the overriding of global settings with individual settings

Min. Length is approximate length of shortest stitches in the edge underlay. Short stitches occur in sharp curved
sections of the underlay path.

Max. Length is approximate length of longest stitches in the edge underlay. Long stitches occur in straight sections of
the underlay path.

Offset Mode defines meaning of the next parameter - the Offset. Offset value is either percentual (relative to automatic
optimized value), or absolute.

Offset defines inner gap between object's contour and the edge walk underlay

Edge walk underlay is not available for Column - Multi Layer mode.

3. Zig-Zag

Inherit from Overall Settings . This switch turns on and off the overriding of global settings with individual settings

Min. Length is approximate length of shortest stitches in the zig-zag underlay. Short stitches occur in sharp curved
sections of the underlay path.

Max. Length is approximate length of longest stitches in the zig-zag underlay. Long stitches occur in straight sections of
the underlay path.

Offset Mode defines meaning of the next parameter - the Offset. Offset value is either percentual (relative to automatic
optimized value), or absolute.

Offset defines inner gap between object's contour and the zig-zag underlay

User Guide > ^Helper Tools > ^Guide Lines

Guide Lines



Guide Lines are horizontal, vertical, or slanted lines that can be placed anywhere in the Work Area panel to aid in
object placement and nodes alignment.

To create a new guide line, position cursor on either horizontal (1) or vertical (2) ruler, depress the primary mouse button
and drag cursor to the work area.

New guide lines are created by dragging them from rulers of the Work Area.

Snap nodes to guidelines option is accessible via ∎ main menu (node editing mode) > Edit > Nodes > Snap

Snap objects to guidelines option is accessible via ∎ main menu (select / transform mode) > Options > Snap
Objects

Guide lines can be used for objects splitting. Place the guide line on the object. Select object and then select the guide
line. Click secondary mouse button on the guide line to access pop-up menu. Choose Slice Selected Objects
command.

If you need to cut object with curved shape, please read Split Objects with Mask chapter.

Use ∎ main menu > Options > Guide Lines to lock or erase guide lines or to switch on/off snapping of objects to
the guide lines.

User Guide > ^Helper Tools > ^Lasso

Lasso
Lasso Tool allows to select objects or nodes in the work area with polygon. This tools is useful when there is a large
number of objects in the work area, they are close one to another and it is not possible to use simple rectangular
selection.



Click anywhere in the work area to place the first point. Then repeat clicking to create the polygon. It is not necessary to
close the polygon. Connection from last point to the first point is created automatically. You can adjust the shape of
polygon by clicking on existing point and dragging it to a new position. Arrow indicates orientation of the polygon and it is
displayed on line segment after focused (highlighted) point.

It is possible to insert or delete lasso points with with use of INSERT and DEL keys on the keyboard.
Point is inserted on place where arrow is displayed. Deleting point erases the highlighted point. New
points are also created by clicking on empty area (i.e. not on existing point). New point is created after the
highlighted point, so that segment with arrow is split in two parts.

If your device has no keyboard then insert or delete points with + and - buttons from the menu panel.

All changes to polygon are stored to memory. Therefore, it is possible to use Undo/Redo buttons or CTRL+Z/CTRL+Y
shortcuts.

There are several options how to apply polygonal selection:

1. Select . Clicking on this option selects objects that are entirely or partially inside of polygon. If there was any
previous selection made, it is discarded.

2. Add . Clicking on this option will add objects inside of polygon to existing selection.
3. Subtract . Clicking on this option will deselect objects inside of polygon from existing selection.

User Guide > ^Helper Tools > ^Split Objects with Mask

Use of the Mask to Split Vector Objects
Mask concept allows to adjust one object with use of another object that serves to trim or intersect the first object. The
mask defines which parts of original object will remain and which parts will be deleted.

The mask effect can be achieved by using the Shaping operations Intersection and Difference .



Fig. 1. Ring with multi-color segments.

Imagine that we want to create ring with multi-color segments as illustrated on the figure 1. Instead of digitizing each
segment manually, we will create the whole ring first and then we will split it with use of another object.

Fig. 2

The Yellow Parts
The first step is to create a large ring. We will use a fill object with opening (hole) in this example.

Fig. 3

The next step is to draw object that will serve as a mask for splitting. The ring will be sliced on places where mask run on
top of the ring (highlighted with thick lines). Therefore, the mask edges must be drawn carefully on the intersection with
the ring. On other places, you can draw it with lower accuracy.



In this example we use fill object as a mask. Mask can be any object (sfumato, column) except lines (outline, connection,
manual stitches). The mask will have no stitches, it is only a temporary object. Therefore, it does not matter where is its
start and end point or how its parameters are set. Mask can even have one or several openings (holes).

Fig. 4

Select both objects (the ring and the mask object).

Use the ∎ main menu > Build > Shaping > Difference command to create new objects that are ring area minus
the mask area.

Resulting objects are shown on the figure 5.

Fig. 5

Note: shaping commands do not work with linear objects like outline, connection or manual stitches.

The Red Parts
Now we are going to create complementary objects to fill the empty areas. We will use another shaping command to
produce these objects.

Before doing so, we need to enlarge mask to make new objects larger and overlapping the previously created objects.
This step is very important because if there is no overlay between the objects, the pull effect of thread will cause gaps in
the actual sew out.

Select the mask object and use the ∎ main menu > Transform > Offset > Expand Objects command.



Fig. 6

Now select the original ring and the new, larger mask. Use the ∎ main menu > Build > Shaping > Intersection
command to create areas that are common to both the ring and the mask.

Fig. 7

You should achieve objects that are complementary to above yellow objects. Change their color to red by dragging the
red color from palette to selected objects. Now you should erase the original ring and mask objects, because they are
still in the background. They were only temporary objects and we do not need them anymore.

Result
Resulting design has overlays between adjanced different color areas.

Fig. 8. Complete result.



Fig. 9. Overlays between the adjanced areas.

Respective segments are separate objects and it is useful to connect some objects (not shown in this example) with
connection tool to reduce thread trimming. As the yellow color is sewn first in this case, connections between the

yellow objects can be hidden beneath the red objects.

Note: objects in Studio can be sliced also with guide lines. However, this approach produces only straight-line
cut.

User Guide > ^Helper Tools > ^Measurement Tool

Measurement Tool
Measurement Tool measures distances and angles in design. It allows to create one or two measuring lines. If there are
two lines, tool measures also the angle between the two lines. Measured values are displayed on main control panel.

Use the measurement tool

to measure distance or angle between objects in design.

Place first point anywhere in the Work Area. Then place the second point. Points can be selected and moved in the
same way as nodes in the creation/editing mode.

Main control panel displays measured distance and angles.



1 is distance between the points.

2 is horizontal part of the distance (distance along the horizontal axis).

3 is vertical part of the distance (distance along the vertical axis).

4 is angle between the line connecting points and horizontal axis.

5 is angle between the two measurement lines.

Measurement tool can use three points (two lines) as well. Place the 3rd point on the work area in the same way as
previous points. Three points are use ful for measuring angle between objects. In such a case, (5) is this angle.

Values (1)-(4) refer to the highlighted line. (5) always refers to angle between the two lines

User Guide > ^Helper Tools > ^Sew Simulator

Sew Simulator

Sew Simulator in Studio helps to analyze the stitches order of design. Stitch simulation is animation of stitching process.
Sew Simulator is often used to find unnecessary trims between objects or to analyze underlay or other stitches that are
hardly visible in a static render.

Sew Simulator in Studio can be accessed via ∎ main menu > Gadgets > Sew Simulator or via button in the
splitter panel.



Sew Simulator can run only if one or more objects are selected in the Work Area and these objects have generated
stitches.

Simulation can be cancelled by pressing ESC button or clicking the Stop button.

Rendering mode can be changed during the simulation by clicking respective button. Currently available are Flat, 3D,
X-ray and Normal mode.

Meaning of controls in the panel is as follows:

1. Buttons for change of sewing speed (in stitches per second).
2. Slider for continuous change of sewing speed.
3. Pause/Run button. Stops simulation until you click the same button again. Use this button also to run simulation

when it was paused on any condition 4~7.
4. Pause on jump stitch.
5. Pause on color change.
6. Pause on outline backward path.
7. Pause on connection object.

Note that controls 1 and 2 allow to set negative speed, which means that stitches gradually disappear. Moving
the slider 2 up and down allows to run simulation forward and backward. This control is intended for close look
up on how certain parts of design are sewn.

Buttons 4~7 define conditions to pause simulation. If button is depressed, respective condition is active. For example, if
you want to pause simulation whenever it runs to color change or connection object, depress button 5 and 7. Condition 6
is useful when checking the double-layered outlines. When simulation stops on pause, you can run it further by clicking
the button 3.

Zoom and scroll bars of the Work Area can be used during the simulation to focus area of interest.

Color bar at top of the screen helps to 'rewind' simulation forward and backward. Colored rectangles depict respective
stitches color and small black ticks mark end of respective objects. Place cursor on the color bar, depress primary mouse
button and move the slider to the left (backward) or to the right (forward) to rewind the simulation. Watch design in the
work area to see effect of rewinding. Release the mouse button to let simulation run further.



Meaning of controls in the bar is as follows:

A - actual stitch.
B - total stitch count.
C - color bar.
D - cursor, actual position.
E - line marking the beginning of another object.
F - indicator of jump (trim).

User Guide > ^Helper Tools > ^Corner Tool

Corner Tool
This tool is accessible via ∎ main menu > Build in selection / transformation mode.

Corner ... command opens panel with options to copy selected objects symmetrically into the hoop corners.



Corner options are:

1. Place - copy objects as they are,
2. Mirror - each corner is mirrored,
3. Rotate CW - each corner is rotated clockwise with respect to the previous corner.
4. Rotate CCW - each corner is rotated counter-clockwise with respect to the previous corner. Please note: if Apply

Rotation to Fill Stitches option in the ∎ main menu > Transform > Flip & Rotate is checked, stitches angle
is adjusted when object is rotated.

User Guide > ^Helper Tools > ^Auto Repeat Tool

Auto Repeat Tool
This tool is accessible via ∎ main menu > Build in selection / transformation mode.

Auto Repeat ... command opens window with options to duplicate selected objects along line, around the circle or
rectangle, or to fill rectangular area. It is possible to set distance (gap) between the objects.

When using a line, it is also possible to set angle of this line.

You can also choose if you want to preserve orientation of the objects or if you want to mirror them vertically and
horizontally and rotate them to be parallel to the baseline.

In this example the triangle at top was auto-repeated 8 times around the circle. Duplicates were
transformed to be parallel to the baseline (i.e. circle).

User Guide > ^Helper Tools > ^Stitch Analysis



Stitch Analysis
This tool is accessible via ∎ main menu > Gadgets in selection / transformation mode.

Stitch analysis provides insight into characterics that are crucial for quality of design.

With this tool you can make a quick check if there are too long stitches in the whole design or in individually selected
objects, for example.

Histogram
Length histogram is a graphical display of stitch lengths using bars of different heights. The height of each bar shows
how many stitches fall into each length range.

9.04.5
18.0 mm

A

B

Histogram of stitch lengths.

Blue curve (A) is histogram of ideal design, which would contain only stitches with length close to optimum length
(approx. 4 millimeters, i.e. 1/6 of inch). This is not possible in a real world. It serves just as a reference.

The actual histogram of the real design (B) is colored from red (too short or too long stitches) through yellow to green
(optimum-length stitches). Histogram allows you to compare your design to the ideal one. Histogram in above example
reveals that we have lot of short stitches (red color) in the design, which may be critical to actual sew-out of the design.

Histogram shows stitches with length up to 18 millimeters (3/4 inch). Longer stitches are converted to jumps (floating
stitches).

Numerical Stitch Characteristics
Besides graphical histogram, there are also other important data available through stitch analysis in a numerical form:

Stitches (count)
Trims (count)
Overlong stitches (count)
Upper thread (length)
Bobbin (length)
Minimum Stitch (length)
Maximum Stitch (length)
Average Stitch (length)

User Guide > ^Helper Tools > ^Tune Colors

Tune Colors
This tool is accessible via ∎ main menu > Objects > Color in selection / transformation mode.



Tune Colors allows to adjust colors of all selected objects, or even whole design at once. Tune Colors command opens
window with Brightness, Contrast, Gamma, Saturation and color balance controls (Cyan-Red, Magenta-Green, Yellow-
Blue). These controls work with color of vector objects and stitches (thread), not with the image colors.

Left: original colors before tunning. Right: brightness increased for all objects at once.

User Guide > ^Helper Tools > ^Expand / Shrink Objects

Expand or Shrink Objects
These commands work on objects selected with the Transform Tool (arrow) or in Objects Inspector.

These commnands are accessible via ∎ main menu > Transform > Offset in selection / transformation mode.

Expand Objects enlarges selected objects by offsetting the object contours. It is intended for creation of overlay of
constant width between adjacent objects. Expand Objects command does not provide the same result as normal
enlargement.

Shrink Objects reduces size of selected objects by offsetting the object contours. Shrink Objects command does not
provide the same result as normal size reduction. You can use it for fill opening to make it smaller, in order to create
overlay between opening and another object that covers the opening.

User Guide > ^Helper Tools > ^Reduce Nodes Number

Reduce Nodes Number
This command is accessible via ∎ main menu > Transform  in selection / transformation mode or via

pop-up menu in node editing mode.



Reduce Nodes Number removes nodes from selected objects according to chosen "Simplicity" parameter. This function
is intended mainly to smooth lettering with distorted edges and large number of nodes, which is hard to edit node-by-
node.

Left: high number of nodes on the edge. Right: nodes after reduction of their number while
preserving the edge shape.

User Guide > ^Helper Tools > ^Change Column Width

Change Column Width
This command works on column and appliqué objects selected with the Transform Tool (arrow) in Work Area or in

Object Inspector.

This command is accessible via ∎ main menu > Transform > Columns in selection / transformation mode.

Change Column Width allows user to make selected column objects wider or narrower.

User Guide > ^Helper Tools > ^Image Color Reduction

Image Color Reduction Tool
Studio provides tool for reduction of color count in the image. It is accessible via ∎ main menu > Image > Tools >
Reduce Colors command.

Image Preprocessing
Raster image placed into to background of the Work Area is typically used as a template to digitize embroidery

design from. Preprocessing of the image may save a lot of time on digitizing, especially for complex designs with many
colors.

One possible approach is to convert image from the full color scale to a limited palette of colors and thus get a clear idea
of final threads count and their layout.



Original raster image - full color scale. We have to decide how many thread colors to use and
how to place them

Preprocessed raster image - reduced color scale. If we are happy with this layout, we can
digitize it with use of 7 thread colors (the background is left empty)

Color Palette
Color Reduction process uses palette from which it takes respective pixel colors.

Palette is a vertical column of color cells. Default palette has only two colors: 1. white and 2. black.

There are several ways of how to create a custom palette. The first step is to set number of colors in the palette. Use the
control with a tube icon to set desired number of colors. This control can be used anytime to increase or decrease the
color number in the palette.

When number of colors is chosen, the colors themselves can be either automatically generated from the image (all at
once), manually mixed or picked one-by-one from the image. These methods can be combined one with another.

1. Automatic Generation of Palette Colors



Hit the button with Automatic caption to generate all palette colors at once automatically. Program choses colors from
the image and places them into the palette. This is a good start point to create the palette but often not a final step.
Manual tweaking of individual colors is usually needed.

2. Manual Creation of Palette Colors

Each color can be manually defined or adjusted. Select color cell and hit the Mixer button or double click the palette
color cell to invoke Color Mixer window.

Color Mixer window

3. Picking Palette Colors from Image

To pick palette color from the image, select some palette cell first. The cell will be highlighted. Then click the image in the
Work Area with primary mouse button. Color from the click spot will be copied into the palette.

It is worth time and effor spent to play with palette colors and tweak them to achieve good color layout after
reduction while keeping the color count low. Digitizing on top of such image is much easier when doing a
complex embroidery design.

Dither
Dithering is replacement of a smooth color gradient with scattered pixels of palette colors. Amount of dithering can be
set with a Dither control . When set to zero, no dithering is used. Dithering is usefull when you want to digitize objects
with color blending. In such a case, dithered zones serve as a guide to create the blending.

Dithering

Preview
Hit the Preview button to check how reduction with the current palette will look like. Preview will appear on a secondary
work area on the main control panel . Preview area allows to zoom-in an out and scroll or pan the preview.



Preview area displays mask until the Preview button is clicked for the first time. Mask is a black-and-white
picture generated from selected vector objects. Black means areas to be processed. White means excluded
areas.

Mask
It is not necessarry to convert whole image at once. This may lead to unwanted interleaving of colors. Studio allows to
use common fill vector objects as a mask to mark areas of image for color reduction. If you want to convert only part of
the image to paletted colors, first draw fill or column objects on top of the image and select them. Then start color
reduction tool. Image will be converted only underneath the selected objects, which serve as a temporary mask and may
be deleted after the image conversion.

For example, when preprocessing photo of a tri-colored dog for embroidery digitizing, it is possible to mask each color
range and repeat the color reduction to convert photo to the paletted colors separatelly.

Advantage of such approach is that you get cleaner reduced image by using different palette in each pass, for example:
1. black and dark gray palette, 2. brown palette, 3. white and cream palette, 4. pink palette (for tongue). These palettes
are applied only to respective masked areas and do not affect the rest of the image.

Pink palette used to reduce colors inside area masked by vector object. Rest of the image is
untouched

Note: you can use a Trace Tool to create complex mask objects easily.

Note: another way to simplify image colors is to use a Posterization tool.

User Guide > ^Helper Tools > ^Image Posterization

Image Posterization Tool
Studio provides tool for posterization of the raster image. It is accessible via ∎ main menu > Image > Tools >
Posterize command.

Image Preprocessing
Raster image placed into to background of the Work Area is typically used as a template to digitize embroidery

design from. Preprocessing of the image may save a lot of time on digitizing, especially for complex designs with many
colors.



One possible approach is to flatten image colors by so called posterization and thus get a clear idea of final threads
count and their layout.

Posterization merges adjanced pixels of similar color, which results in simplification of the image. Amount of posterization
can be adjusted with Amount control.

Original raster image - full color scale. We have to decide how many thread colors to use and
how to place them

Preprocessed raster image - posterized areas of similar colors

Preview
Hit the Preview button to check how posterization with current settings will look like. Preview will appear on a secondary
work area on the main control panel . Preview area allows to zoom-in an out and scroll or pan the preview.

Preview area displays mask until the Preview button is clicked for the first time. Mask is a black-and-white
picture generated from selected vector objects. Black means areas to be processed. White means excluded
areas.

Mask



It is not necessarry to convert whole image at once. Studio allows to use common fill vector objects as a mask to mark
areas of image for posterization. If you want to convert only part of the image, first draw fill or column objects on top of
the image and select them. Then launch the posterization tool. Image will be converted only underneath the selected
objects, which serve as a temporary mask and may be deleted after the image conversion.

Posterization applied inside area masked by vector object. Rest of the image is untouched

Note: you can use a Trace Tool to create complex mask objects easily.

Note: another way to simplify image colors is to use a Color Reduction tool.

User Guide > ^Advanced Tools > ^Styles

Styles
Studio provides predefined styles (sets of chosen parameters) for adjustment of designs for sewing on materials like
jeans, satin, silk, towels and other.Style includes values of basic parameters like density, pull compensation and type of
underlay. Table of styles is accessible via ∎ main menu > Gadgets > Styles Editor . User can modify predefined
styles (except their names).

To use style, select objects to which you want to apply the style, invoke Styles table with ∎ main menu > Gadgets >
Styles Editor , select desired style and click Use Style button.

User Guide > ^Advanced Tools > ^Vector Graphics

Import of Vector Graphics
The ∎ main menu > Design > Export/Import > Import Vector File function opens the vector graphic file and
converts it into the embroidery design automatically. It is intended to avoid redrawing of design (logo or clipart) in Studio
if it is already available in a vector file. This function is available only if user has registered Font Engine plug-in.

There are many graphic programs that produce various vector file formats and most of them can export vector graphics
into SVG format.

Vector file can contain various objects (raster bitmap, fonts, shapes, curves, polygons, etc.) or links to these objects.
However, Studio can import only the curves, all other objects are ignored. To achieve best results, please convert all
objects like fonts and shapes to curves before attempting to import the SVG file into Studio.



If there is a bitmap picture in the file, Studio ignores it. It does not auto digitize the picture. Only the vector (curves)
objects are transformed into embroidery objects.

Note : not all vector files can be converted into good quality embroidery designs. Some vector files may be auto-
traced from scanned pictures and resulting vector file can have thousands of tiny objects instead of low number
of solid fills or smooth lines. Such vector files are not proper for conversion into embroidery designs.

Left-side picture is poor quality vector graphics composed of thousands of small objects auto-
traced from scanned picture. Right-side picture is good quality vector graphics with low number

of large solid areas.

Stitching Parameters
Design imported from vector file usually needs some adjustments of stitching parameters and/or object layout.

Design imported from SVG vector file. Stitches are not generated yet.

After importing of design, select all objects and use Generate Stitches command. Studio analyzes the shape and size of
individual objects and fills them appropriate fill type. However, it cannot identify the meaning of vector objects like human
digitizer. For example, program cannot identify objects that belong to the lettering and it may fill each letter with other
style, according to this letter size or width. Thin elongated objects are filled with auto-column (wider objects have
pattern). Large objects use plain fill, either vertical or horizontal, according to their shape.

Design with auto-generated stitches. All objects are filled with auto-column, but some have also
a pattern texture (letters m and r). The pattern is applied to wider objects to split too long

stitches. White fill of bird would look better with plain fill instead of auto-column.



User may need to adjust the fill type parameters. In this case, the length of stitches is near the threshold that turns on the
pattern. This is the reason why some letters have pattern and some do not. We should either turn-on or turn-off the
pattern for all letters. For later option, select the letters m and r and open the Parameters window. For letters m and r,
switch OFF the pattern option of auto-column fill in the Parameters window. For white fill of bird, select the plain fill mode
instead of auto-column mode in the Parameters window.

New parameters applied to stitches. All letters use satin auto-column stitches without pattern.
White fill of bird is now a plain fill, not auto-column.

Overlays in Vector Graphic and Embroidery
It is important to pay attention to layers and overlays of objects imported from vector files. Unlike graphic, embroidery is
very sensitive to use of layers. On places with multiple layers (overlays), the stitches are sewn on top of the previous
stitches and may spoil the embroidery if density becomes to high.

You should visually check the overlapped areas for too many layers. The largest part of design should be single layer
only. Where different objects overlap, try to keep 2 layers overlay on most places, or 3 layers overlay maximum if it is not
possible to avoid it.

Layers in this case mean dense cover stitching, not underlays or connection paths. Underlay is loose stitching that helps
to stabilize the design against thread pull and push effect, but it does not contribute to overall density very much.

Connections are stitch paths (often hidden beneath the other objects) used to avoid trims between objects. Both
underlays and connections can be regarded as layers, but they are usually not significant when investigating density of
cover layers.

Illustration of overlays in imported design.
Left: white fill (highlighted) sticks out under the black, orange and blue objects.

Center: orange and blue objects (highlighted) overlap the white fill and stick out under the black.
Right: black objects (highlighted) overlap the white fill and on a very small area also the blue and

orange objects.

Missing or very small overlay is an error just as the too heavy overlay. Pull of the thread causes gaps between objects on
places with insufficient overlay.



If there are too many layers or too large overlays in the design, they should be removed or edited to achieve good sew-
out of design. Studio provides a quick way to check the density of stitches. Use display mode tabs at bottom of the
Studio screen to switch to D-map (density map) or X-ray view mode to analyze the density layout. Stitches must be
generated first, otherwise these view modes do not work.

The X-ray view mode allows to detect areas of critical (too high) density.

Note : it is also possible to export design from Studio to graphic vector format to avoid redrawing of design in
graphic software. Please use ∎ main menu > Design > Export / Import > Export command.

User Guide > ^Advanced Tools > ^Automatic Outlines

Auto Outliner

Automatic outlines are the most convenient outlining method. Other methods are described in the Outlines Overview
chapter.

The Auto Outliner command allows to create a double-layered outlines for single object or multiple objects (fig. 1.).
Objects may overlap or intersect one another and program creates outlines only for the visible parts . It is useful for
creation of outlines like shown on the figure 2.

Auto Outliner is accessible via ∎ main menu > Build > Auto-Outliner

Fig. 1. Overlapping objects to be outlined.



Fig. 2. Double layered outline.

Fig. 3. Logo with double layered outline.

Select objects you want to outline and use ∎ main menu > Build > Auto Outliner command. This will create a
number of small outline elements. Program will ask you whether it should arrange all elements into a single outline or
not. If you select yes, program will also ask you if you wish to add connection if there are separate outline parts.

New outline has the same color as the first object from those that were chosen for outlining. Select new color from the
palette and drag-and-drop it to the selection (which is the newly created outline) to change color of the outline

elements.

Fig. 4. Outline of hole connected to the main outline.



Fig. 5. Hidden parts are ignored.

On places where one object lays on top of the other, automatic outlines are created only for those parts that are on top of
the others. Program automatically ignores hidden parts (fig. 5. , marked by arrows)

Note : auto outliner may fail to work properly on places where edge of one object runs (almost) on top of edge of
other object, i.e. parts of their edges are almost identical. On such places, outliner may generate large amount of
small outlines, because nearly identical edges intersect each other on many places. Common designs have
either separate or overlapped areas and such situation does not occur. In most cases the problem occurs when

vector graphics (SVG files) is used, because graphic files are created in a different way (no overlays, many
identical edges).

User Guide > ^Advanced Tools > ^Freehand Tool

Freehand Tool

This is a special way to create embroidery design by simple drawing rather than common node-by-node digitizing. It
is much faster, the Freehand tool allows to create a sketch drawings with mouse or digitizing tablet within a few
minutes.



It works like a painting tool. Result, however, is an embroidery design that can include various embroidery styles like fills,
columns, sfumato objects and outlines as well as some new stitch styles like pressure-sensitive columns.

Unlike the other Studio tools, which are based on the precise manual placement of the nodes, curves and lines,
Freehand tool allows to draw most of the Studio objects with a free hand. Strokes are automatically converted to
chosen embroidery style. After conversion, strokes can be edited as other vector objects in Studio (node by node). When
creating embroidery design, the Freehand tool can be combined with any other tools in the Studio. 

Like other creation tools in Studio, Freehand tool can be used with various
display modes (Normal, Vector, 3D, Flat ...) to display imported raster image behind the digitized design as a

template for digitizing, or preview created design in 3D.

Freehand tool can work with any Microsoft Windows compatible mouse or digitizing tablet*. Its use is not restricted to
any specific brand of tablet.

*Tablet pen pressure can be used in Studio only if tablet uses Wintab32.dll driver and this driver must be located
in the Windows\System32 folder.

Freehand Styles
Before you start actual drawing with the Freehand tool, you should choose embroidery style you want to use. Click
secondary mouse button or corresponding tablet pen button depressed on the Freehand icon (in the Tool Bar).

Panel with freehand styles will appear. This panel can be invoked also by holding the primary mouse button or tablet pen
tip depressed about 1 second on the Freehand icon.

Pop-up Panel with Freehand Styles

Manual Stitches

Connection

Outline

Sketch Outline

Column

Pressure-sensitive Column



Fill

Hole for Fill or Sfumato object

Sfumato object. Sfumato is an optional part of the Studio.

Carving

Each style is represented by its icon. Click icon of desired style and the freehand tool will be activated with selected
style. You can also change active style later, between drawing the freehand strokes, with use of combo box in the main
control panel.

Styles used in above example are:

1. Fill. Leaves do also have Carving texture lines, but they are visible only on 3D render
2. Column with simulated pressure-sensitive width
3. Sketch Outline
4. Manual Stitches

Options
When the Freehand tool is active, specific parameters of respective style are displayed on main control panel at the side
of the Studio window. Some parameters like color of objects being drawn and After Stroke options are common to all
styles.

Common Options

Color is parameter that is used by all styles. It defines color of objects created by drawing of the freehand strokes.



After Stroke options allow to choose the way of how the Freehand tool behaves after each stroke. It is possible to define
whether to generate stitches of each stroke immediately or not, whether to finish freehand mode after single stroke or
reactivate the tool, whether to create connection to the previous stroke or let jumps between the strokes.

Meaning of the After Stroke options is as follows:

Finish Object - converts stroke into nodes and finishes creation/editing immediately
Generate Stitches - same as Finish object, but it also generates stitches for the stroke object
Another stroke - converts stroke into nodes and allows to add another strokes. When finished, single vector object
contains several strokes.

Only one of above options can be active at once.

Pop-up menu accessible via button in splitter panel contains Connect to previous object option. When this setting is
turned ON, each new object (stroke) is connected to the previous one with a connection object.

Style-Specific Options

Manual Stitches

Manual Stitches are used to create realistic fur, shading or other texture. Parameters that are adjustable during the use
of the Freehand tool are: Minimum Length of Stitch and Maximum Length of Stitch.

There are several ways of how to change value of the stitch length controls. They are used in the same way as those in
the Parameters window.

Outlines and Connection

Outline-type styles include : Outline, Sketch Outline and Connection.

Parameters that are adjustable during the use of the Freehand tool are: Minimum Length of Stitch,Maximum Length of
Stitch, Width of the Outline (not available for Connection) and Outline Sample (not available for Sketch Outline and
Connection).

Columns

Column-type styles include : Column and Pressure-sensitive width column.

Parameters that are adjustable during the use of the Freehand tool are: Minimum Width of Column, Maximum Width of
Column, Tablet pressure option to switch on/off tablet, and Simulated Width combo box.

If tablet is present, width of the pressure-sensitive column varies from minimum to maximum column width value,
according to the real pen pressure. Simulated width combo box is disabled.

If tablet is not present (mouse is used for the drawing) or if tablet pen pressure is disabled by un-checking the Tablet
pressure option, Width of the pressure-sensitive column is defined by selected stroke sample from the Simulated Width
combo box.

Example of column with simulated pressure effect on its width.

Fill and Sfumato

Fill-type styles include : Fill, Sfumato and Opening. There is also Carving style, which is created like outline, but it serves
to add texture lines to fill or sfumato objects. Both opening and carving objects must follow after the fill or sfumato
objects. They are not a stand-alone objects.

The only parameter of Fill that are adjustable during the use of the Freehand tool is Angle . The rest of parameters can
be accessed only after finishing the freehand mode, using the common Parameters window.

Note: When freehand drawing is finished, strokes are no longer available as a 'freehand objects'. They are
automatically converted into respective vector objects like manual stitches, fill or column and their parameters
are accessible via respective tabs in the Parameters window.



User Guide > ^Advanced Tools > ^Trace Tool

Trace Tool
Studio includes Trace Tool for fast conversion of raster image into vector embroidery design.

Trace tool works in a similar way as selection tool - a magic wand - in graphic programs.

Using Trace tool means doing these operations:

1. Clicking a consistently colored area (pixels of raster image), this selects the area
2. Turning selected raster areas into vector objects
3. Filling vector objects with stitches

How to Use it

This chapter is focused mostly on describtion of the trace tool controls. More detailed chapter with a step-by-step
tutorial on how to use the Trace Tool is available further.

User specifies the color "tolerance threshold" for selection of raster pixels and "simplicity" of created vector object.

Selection is performed by clicking the picture.

When selection of one or more raster objects is complete and all parameters and options are set, click Apply or
Generate Stitches button from button bar at top side of the Studio screen, or click secondary mouse button on the
work area to open a pop-up menu with the same options. Raster objects are converted to vector objects and

optionally filled with stitches.

Result is an embroidery design that can include various embroidery styles like outlines, fills, columns and sfumato
objects.

After conversion, traced objects can be edited as other vector objects in Studio (node by node). When creating
embroidery design, the Trace tool can be combined with any other tool in the Studio.

Like other creation tools in Studio, the Trace tool can be used with various display modes (Normal, 3D, Flat, etc.) to
display imported raster image behind the digitized design as a template for digitizing, or preview created design in 3D.

High image resolution and low gradation of colors are required to create quality design with the trace tool.

Main Features
Automatic vectorization of individual objects from raster image
Select one or several objects from raster image, convert them into vector objects and fill with stitches
Selection modes are: New, Add, Add Similar, Subtract and Intersect.
Auto-vectorize outline, column, fill, sfumato and carving objects from raster image
Vector simplicity / fidelity adjustment
'Ignore Openings' option for Fill objects, to create just outer boundary without holes
Automatic color of new objects from the picture
Option to select curve or straight line edges
Undo / redo functions applicable to selection

Trace Tool Styles
Before you start using the Trace tool, you should choose embroidery style you want to use. Click secondary mouse
button on the Trace icon (in the Tool Bar).



Panel with Trace styles will appear. This panel can be invoked also by holding the primary mouse button depressed for
about 1 second on the Trace icon.

If you do not need to switch the style, just click primary mouse button on the Trace tool icon to start the Trace
mode.

Pop-up Panel with Trace Tool Styles

Outline

Column

Fill

Sfumato object. Sfumato is an optional part of the Studio.

Carving

Each style in the panel is represented by its icon. Clik icon of the desired Trace style and tool will be activated.

Carving objects must follow after the fill or sfumato object, as they serve to add texture to those objects.
Carvings are not a stand-alone objects. The icon of Carving style (in Trace tool panel) is grayed out if there is no
fill or sfumato object in the work area.

Common Options and Parameters
Most of options and parameters like color, tolerance, simplicity, edge type and selection options are common to all styles.

First step is to select color areas (objects) from the raster image in the work area of Studio. Click the primary mouse
button to select an object.

Selection options allow to change the way of how the Trace tool behaves by each selection. It is possible to define
whether to make new selection and discard any existing selection or add objects of different color to selection, select
non-contiguous areas of the same color at once (add similar option), subtract object from selection or intersect the object
from selection.

Meaning of the Selection options is as follows:



New - make new selection and discard existing selection.

Add - add selected area to existing selection.

Add Similar - select all areas of the same color (including non-contiguous areas) at once.

Subtract - subtract area from selection.

Intersect - select subset of existing selection.

(Only one of above options can be active at once)

Automatic Color - if turned ON, the color of created vector object(s) is picked from the raster image automatically.
Uncheck this option and click the color box to choose the color from palette or define your own color of vector object(s).

Tolerance - defines the color similarity range used for selection of pixels from the raster image. The value of tolerance is
ranging from 0 to 100. Set a low value to select only pixels of a very similar color or set a higher value to select pixels
with more different colors.

Left side: selection made with lower color Tolerance. Right side: selection made with higher color
Tolerance.

Simplicity - defines the complexity/fidelity ratio of object(s) created with the Trace tool. The value of simplicity is ranging
from 0 to 15. Set a lower value to get object with high number of nodes and better accuracy. Such object, however, is
harder to edit. For easier editing, set a higher value to obtain object with a lower accuracy and low number of nodes.
Default value of simplicity is 7.

Left side: object vectorized with Simplicity=3. Right side: object vectorized with Simplicity=12.

Edges - the type of edges of created vector object(s), either straight lines or curves.



Style-Specific Options
When the Trace tool is active, specific parameters of respective style are displayed on the main control panel at the side
of the Studio window.

Fill, Sfumato and Column Parameters

Ignore Openings - if the check box "Ignore Opening" is checked, openings (holes) are ignored in the created vector
object(s). This option is useful to create overall vector object without holes, assuming that there will be another objects
digitized on top of this one, instead of holes. Uncheck the option to retain openings in objects.

Expand Objects - Overlay - enlargement of objects to prevent gaps between the adjanced objects caused by pull effect
of the thread.

Outline Parameters

Besides common parameters and options, outline objects have several specific parameters. They are identical to
parameters accessible via Outline Parameters window, but are duplicated here for easier access.

Minimum Length of Stitch - measured in millimeters, defines the shortest stitches generated when compiling Outline
object into actual stitches.

Maximum Length of Stitch - measured in millimeters, defines the longest stitches generated when compiling Outline
object into actual stitches.

Width of the Outline Sample - measured in millimeters, is the width of reference cells along the outline to which the
stitches are projected. It is not necessarily the width of finished outline, because projected stitch sample can be wider or
narrower than reference cells.

Outline Sample - outline samples are stitch patterns repeated along the outline. It is possible to set the Single stitch,
Triple stitch, Redwork outline or choose from several samples listed in combo box. User can even create and save with
design up to five "User Defined" samples.

Other Parameters
Other parameters of vector objects created with Trace tool, like density, angle of stitches, gradient, etc. can be accessed
only after finishing the Trace mode, using the common Parameters window.

User Guide > ^Advanced Tools > ^Trace Tool - Tutorial

Trace Tool
Step-by-Step Guide
This tutorial demonstrates the use of trace tool to produce embroidery design from a raster image.

To achieve a good quality result design, input image must be sufficiently clean. The image can be in any file format
supported by Studio. The most important factor is that edges of color areas are smooth, i.e. not jagged, which may be a
side-effect of enlarging the raster image.

1. Import Raster Image

Use ∎ main menu > Image > Import command to import raster image to Studio. Do not scale image to fit into the
hoop, because if image is enlarged, it becomes more pixelated and the auto-tracing will not work well. It is recommended
to resize the finished vector design, instead. In contrast to rasters, resizing of vectors does not affect the quality.



2. Choose the Trace Style

Let's start to digitize the design. Large filled areas should be digitized first. Select the Trace tool (the magic wand icon)
from the tool box at the side of the screen with secondary mouse button or long press with primary button.

Then select the Fill style from the trace tool style panel.

3. Switch to Trace Mode

We are going to trace the large yellow area. The main control panel at the side of the screen contains trace controls and
selection options. As this is fairly simple object, set Simplicity to 10 to achieve lower number of nodes.

Each filled area with outline or neighboring area of other color should have some overlay to compensate gaps between
adjanced areas of different colors and also pull effect of the fabric. However, the yellow area of Smiley is somewhat
specific because of the thin black lines on the eyes and mouth. While leaving holes for main parts of eyes and mouth, we
will not leave holes under all thin black lines, because it would split the yellow circle into too many regions and
complicate the sewing. Moreover, overlay would completely cover the holes under the thin lines anyway. Therefore, we
will leave Overlay=0 for now.

Selection is set to New . As we are going to select just one area now (yellow), it doesn't matter whether Selection is set
to New or Add. Color Tolerance for selection is default 30 .

4. Select and Trace First Area

Click anywhere on the yellow area. Selection is indicated by flashing dots.



Click Apply button on the button bar at top of the screen to convert selected raster object into vector objects. 5
vector objects are created: main fill and 4 holes.

If Ignore Openings option is checked, program would create just the main fill. This option is useful for creation of overall
filled area when small holes are not wanted or the fill is used as an overall underlay. This is not our case, so this option is
unchecked.

5. New Objects in Object Inspector List

Newly traced vector objects are added to the Object Inspector list. If they contain holes, they will appear also in the
Parts Inspector list .

In this case Parts Object Inspector (the one beneath the main Object Inspector ) contains list of the 5 new vector
objects - one fill and 4 holes.

Because of reasons mentioned above, we will eliminate some holes that are too thin. Select object no. 5 (the hole under
the chin) and simply delete it. The holes under eyes and mouth are more complicated because they contain both thin
and thick parts. We want to preserve thick parts and erase the thin ones.

6. Select Object for Editing

Select mouth hole in Parts Object Inspector and open a pop-up menu. Select Edit from the pop-up menu to switch into
editing mode.

It is necessary to use Parts Object Inspector to select mouth objects, because openings (holes) cannot be selected
directly in the work area.

7. Edit Vector Objects



Delete nodes on the thin parts of the mouth to simplify the object. Select respective nodes one-by-one and delete each
of them.

You can also select multiple nodes at once by holding SHIFT key depressed and dragging selection box
around the nodes.

Repeat steps 6 and 7 for eyes. When finished, all three holes should contain only the thick parts and all thin parts should
be deleted.

Remember, we have not used any overlay margin for the yellow fill and its holes. We can add it now so that we will
shrink the hole objects with use of ∎ main menu > Transform > Offset > Expand Object . Expand command will
actually shrink the holes so that the yellow fill will stick out a little under the mouth and eye areas.

8. Select Multiple Areas for Tracing

Now trace all gray and white areas on the hat. Use the trace tool as in step 2 with few changes: set Overlay to 0.3 mm
(for example) and Selection options to Add .

Add selected area to existing selection.

Then select one-by-one all three gray areas and three white areas on the hat by clicking on them.

It doesn't matter that selected areas are of different colors because Auto Color options is set on. Therefore, each vector
object will get proper color from the underlying raster.

If you happen to select wrong area, use Undo/Redo commands from the main menu > Edit or CTRL+Z/CTRL+Y
shortcuts.



9. Trace Multiple Areas at Once

Use Apply button or Generate Stitches button to convert all selected objects to vector objects at once.

All 6 new objects are simple objects and do not need any editing unless you want to change the stitches direction or
pattern. In such a case, use the Parameters window to set new parameters to the vector objects.

Note: all 6 objects were extpanded with overlay margin. This overlay covers part of the black outline areas. It
serves to embroider design without gaps between adjanced objects.

10. Choose Another Trace Style

Next step is to trace the white and red areas on eyes and mouth. We have intentionally omitted white area on eyes in
step 8, because they will look better as columns than fills. Click with right mouse button on the Trace tool icon. Then
select the Column style

11. Trace Next Objects

Select white areas on eyes and mouth. Then select also the red area on the mouth.

Use the Add selection option all the time to add respective areas to selection. Click Generate Stitches button to
create vector objects and to fill them with stitches.



Notice that new objects are columns and they also have an overlay.

12. Trace All Objects of the Same Color at Once

Trace all black outlines at once.

Select Add Similar selection option to allow program select all areas of the same (similar) color at once.

Add Similar

Then click anywhere on the black outline in the work area. Click Generate Stitches button to create vector objects. As
the column style was selected in step 10, new objects are all of the column style. Actually, they are fill objects with
Autocolumn option set on.

Thin outlines expanded with overlay may need little editing on some places. In this case, few nodes in the right corner of
the mouth were edited to remove intersecting edges.

13. Result of Tracing

Design is finished. Notice the difference between the the plain yellow fill and the column-style of eyes and mouth.
Previously made steps allowed us to create objects with an overlay and appropriate openings (holes) where needed.

One more thing that needs to be checked is sewing order of the objects to minimize the color changes. When making
gray, white and red objects, it is possible that newly created vector objects are not sorted by color. Therefore, re-order



these objects in the Object Inspector window to minimize the color changes, while leaving black outlines at the very
top and yellow fill at the very bottom of the design.

As all objects in our example are separate areas, we do not need to insert connections between the objects. Trims
are automatically added between all objects. In other cases, however, it might be suitable to insert connections between
some objects (letters, for example) to reduce the trims.

User Guide > ^Advanced Tools > ^Lettering

Lettering - Text Tools
Embroidery lettering has special requirements if compared to graphic applications. Besides filling letters with stitches, it
should also allow a nearest-point connections, sewing from center out, adjustment for very small text and number of
other features.

Studio includes such lettering tool with multiline text support.

Multiline text

Main Features
Interactive lettering directly in the Work Area
Multiple lines text support
Vertical text support
Support of TrueType, OpenType and pre-digitized Embird Alphabets
Paragraph alignment
Sewing from center out option
Node-by-node adjustment of text baseline
Characters, words and lines spacing
Nearest-point connection
Unicode characters support
'Place on the other side' function
Possibility to edit previously created text
Support of non-installed fonts and font archives

Alphabets versus Font Engine

There are two different font kinds supported by Studio:

1. Alphabets system : Embird's proprietary pre-digitized embroidery fonts
2. Font Engine system : common TrueType and OpenType fonts widely used in various text and graphic programs.

In further text they will be referred to as system fonts

Alphabets are manually pre-digitized scalable embroidery fonts. They are optional plug-in modules for Embird software.
Most Embird alphabets are digitized with satin (column) stitches, the rest are in center outline (redwork type) form.

Studio also allows to use system TrueType and OpenType fonts. These fonts are automatically converted into vector
format of Studio and can be filled with plain fill, motif fill or auto-column stitches and/or outlined with all types of outlines
available in Studio.

Both font kinds are converted to embroidery objects and stitches and become part of digitized design.



Support of TrueType and OpenType fonts in Studio requires registered Font Engine, which is an optional plug-in
for Embird software.

How to Use Lettering

To start lettering mode, use ∎ main menu > Text and select whether you want to create Text (Alphabets), Font
Engine Text (system fonts) or if you want to edit some existing text.

Selection of existing text for editing works only with text created in Studio version 6.0, build 8.8 or later. It does
not work with files from older versions of Studio.

If you create a new text, click the Work Area on a place where you want to place the new text. Lettering tool allows to
insert and edit text directly in the work area of Studio, on top of the background image (template) and the rest of
embroidery design.

In case of the system fonts, if you install new fonts or add fonts to archive folders, use ∎ main menu (Lettering
mode) > Font > Find Fonts command to load installed system fonts and also optional folders with font archives.

Icon of Find Fonts command

Lettering supports multiline text and adjustable baselines. Predefined text baselines include circle, lines and spirals.
All baselines can be transformed (moved, scaled, rotated and slanted) as well as edited node-by-node. Baseline scaling
allows to create ellipse from circle. Baseline transformations can be done either with 'spider' control on the work area, or
with controls on the main control panel at the side of the screen.

Lettering Working Modes
As mentioned above, lettering allows to modify the text baseline. It also allows to modify individual letters. Therefore,
there are three different lettering working modes available:

1. Baseline transformations
2. Baseline node-by-node editing
3. Characters transformations

Use the pop-up menu or mode buttons to switch between baseline and characters working modes.

Mode 1 - Baseline Transformations



Mode 1: baseline transformations: move, scale, rotate, slant. The spider control allows to make
transformations with its handle nodes.

This mode allows to modify (especially move, scale and rotate) whole baseline at once. When moving the baseline, the
text moves as well. Scaling baseline does not scale the text. Text scaling must be performed separately either with
characters spiders or via controls on the main control panel. Baseline transformations are performed with spider control
similar to the spider controls of individual characters (see Mode 3 below), with exception of missing slider 2.

Mode 2 - Baseline Node-by-Node Editing

Mode 2: baseline nodes editing. Baseline is a vector path composed from curves and straight
lines. In this mode the baseline can be modified with control nodes.

Baseline is composed from straight lines and bezier curves. User can add and delete baseline elements in a similar way
as when digitizing objects in Studio. In case of multiline text, all text lines use the same shape of baseline which is
copied from the top line.

Shortcuts available in this mode:

ALT + new node creates a new straight line on a baseline
CTRL + new node creates a new straight line on a baseline, aligned to multiplication of 45 degrees
CTRL + movement of the main node aligns this node to multiplication of 45 degrees with respect to
previous node

Mode 3 - Characters Transformations

Mode 3: characters transformations: move, scale, rotate, slant and baseline offset of individual
characters. Select respective letter and make transformations with its spider handle nodes.

Studio allows to transform individual characters or all characters at once (see below shortcuts). Transformations are
accessible via nodes of the spider control. Spider control serves to transform characters in two axes (horizontal and
vertical). As the text is placed on the baseline and baseline can be curved in any direction, below definitions refer to
direction 'along' and 'perpendicular' to the baseline, rather than horizontal and vertical.



Nodes of the spider control are numbered 1-8.

Moving of nodes transforms character in a following way:

1. Select character, move character (adjust spacing)
2. Slider to shift character above (below) baseline (ALT+click=reset position to baseline)
3. Rotate (with CTRL depressed=change by 15 degrees, ALT+click=reset angle to 0 degrees)
4. Scale along the baseline (with CTRL depressed=constrained proportions, ALT+click=reset character width)
5. Scale perpendicularly to the baseline (with CTRL depressed=constrained proportions, ALT+click=reset character

height)
6. Scale in both axis (with CTRL depressed=constrained proportions, ALT+click=reset character size)
7. Slant along the baseline (CTRL+click=flip character horizontally, ALT+click=reset slanting) Slant perpendicularly

to the baseline (CTRL+click=flip character vertically, ALT+click=reset slanting)
8. Slant perpendicularly to the baseline (CTRL+click=flip character vertically, ALT+click=reset slanting)

Shortcuts

Following shortcuts can be applied simultaneously with spider nodes movement:

SHIFT + movement of spider leg adjusts the same spider legs on all characters at once
CTRL + scale node (4,5 or 6) changes size of character proportionally
SHIFT+CTRL can be combined

Controls
Lettering Tool provides number of controls located on several panels:

1. Main menu on the top of the screen
2. Horizontal button bar on the top of the screen
3. Vertical button bar on the splitter panel
4. Vertical tool box
5. Main control panel with tabs

1. Main menu

Main menu contains commands and switches. Commands include: load, save, copy, paste text. Switches include: bold,
italic, vertical text, placing lettering on opposite side of the baseline. There are also commands for baseline nodes like
insert, delete, smooth.

Load and Save commands work with lettering project files, which allow to store lettering session and open it in another
design, i.e. copy lettering from one design to another.



Please see respective Menu chapters for more detail:

∎ Main Menu - Lettering Mode - Tools

∎ Main Menu - Lettering Mode - Font

∎ Main Menu - Lettering Mode - Nodes

Example of vertical text

Unicode glyph set option is available for system fonts only (not for Alphabets). It allows to use wider range of
characters. It has effect on cell count in the characters table.

2. Horizontal Button Bar

Horizontal button bar is just next to the main menu. Its buttons allow to Cancel lettering mode, Finish and apply lettering
to the design or Generate Stitches , which is same as Finish command but it also creates stitches.

There are also several combo boxes in this bar, which allow to modify the paragraph alignment , sewing order , stitch
kind , outline kind and connection options .

Text Paragraph Alignment

Left

Center

Right

Justify

Sewing Order of Text



From left to right

From center out

From center out (without splitting words)

From right to left

Stitch Kind

Columns

Plain Fill / Auto-Column / Motif Fill

Center-Line (double-layered center path)

Mesh Fill

Note : mesh fill is working only on large lettering.

Outline Kind

No Outline

Single-Pass Outline

Double-Pass Outline

A double-pass outline is thin outline composed of simple stitches which run forward and backward into each leg of the
outline. This kind of outline allows seamless connection of all outline parts without any trim.



A single-pass outline does not have second (backward) layer and therefore allows to use samples, borders or other
fancy outline stiches. This kind of outline requires trims or connection stitches between separate outline parts.

Example of center outline lettering.

Connection Options

Learn about connection in Connections chapter.

Nearest point connections between all objects

Nearest point connections only inside characters (example: between dot on "i" and main part of "i"), but
not between respective characters

Separate objects (no connection objects)

3. Splitter Panel

Some buttons on the splitter panel duplicate functions from the main menu.

However, there are also some buttons important for use with the touch screen, i.e. without mouse. These buttons are:
pop-up menu button, zoom-in and zoom-out buttons and undo / redo buttons.

4. Tool Box

Tool Box at the side of the screen contains combo box with list of pre-defined baselines and mode buttons for
switching the lettering working mode .

Switch to baseline transformation mode

Switch to baseline nodes editing mode

Switch to individual letters transformation mode



5. Tabs on Main Control Panel

Main Control Panel at the side of the screen contains those lettering controls that require more space. Controls are
organized into several tabs.

Font / Alphabet Tab
- combo box to select the font and character table to insert character with click or tap instead of key strokes.

Baseline Tab
- baseline rotation angle, scale and skewing angle controls.

Folders Tab
- optional paths to folders with non-installed font files or archives. Use Scan Archive Files Too option to
include/exclude compressed archives from scanning process.

Spacing Tab
- character, word and line distance controls.

Scale Tab
- lettering size, either absolute or relative to default size.

Transform Tab
- controls to modify individual letters: angle, size, horizontal slant, vertical slant, mirroring, distance from baseline
(shift). These controls allow to define transformation with exact numerical value in contrast to the 'spider' control,
which is used for a freehand transformation.

Text Tab
- an alternative way to enter or edit text - a text box. Below the text box are buttons for deleting the whole text and
for inserting useful pre-defined sets of glyphs.

When you click the font combo box, the list of fonts will drop down. To get to required font faster, you can
press key (on keyboard) representing the first letter of the font's name. List will scroll to section with font
names beginning with selected letter.

Click or tap the character table to insert character that is difficult to type with keyboard.

Folders Tab is available only for TrueType and OpenType fonts (i.e. not for pre-digitized alphabets). Controls on this tab
allow to specify paths to folders with non-installed fonts. Lettering tool normally scans only fonts installed in operating
system. If you have other fonts stored on your device, specify paths to folders with these fonts and use Find Fonts
command from the main menu. Scanning process will include these folders. Besides font files, these folders may contain
also font archives (zipped files).

Baseline Tab is available only in mode 1 (baseline transformation).

Transform Tab is available only in mode 3 (characters transformation). When "All Letters" option is selected,
transformations are performed on all characters in the text. Below example shows rotation performed on all characters at
once.



Please note : current version of program does not work well if center outline style is used for a very thick font.
We recommend to use it only for thin fonts. Center outline style can be combined with the 'Nearest Points'
option.

User Guide > ^Advanced Tools > ^Custom Fill Patterns

Custom Fill Patterns
Patterns are pictures that define splitting of fill stitches. The split points are visible on the actual embroidery as a texture.
It is possible to draw a template for the split points and this template is called fill pattern in the Studio.

Besides many pre-defined fill patterns, Studio provides also an pattern editor tool to create your own, custom patterns.

Pattern Editor

Use ∎ main menu > Gadgets > Fragment Editors command to open window with available editors. Switch to
Pattern Editor.

The meaning of controls in this window is following:

A Editor list. Pattern editor is one of the custom editors available in Studio.

B Buttons to Reset , Cancel or Apply changes made to the pattern



C Combo box to select Pattern for editing

D Work Area . Draw your custom pattern here.

E Pattern Parameters : Width , Height , Name , Layer Count , Active Layer

F Information Area : Cursor coordinates, warning messages, etc.

G Scroll Pattern Buttons Click any of these buttons to scroll pattern by 1 pixel.

H
Pop-Up Menu Button . Click this button to access pop-up menu with additional commands: Load and Save
Pattern, Undo / Redo Changes, Import backgroung image , Clear Pattern , Skew Pattern , Show / Hide
background image

I List Splitter

J Splitter with Tools : Brush / Eraser Tool, Dots / Lines Mode, Undo or Redo changes, Zoom-in and Zoom-
out buttons

How to Draw New Pattern
Plain fill is typically used for larger objects, which means long rows inside the fill. If each row would contain just 1 stitch
(which is the case of column object), the stitches would be very long, loose and they would not create a compact fill.
Therefore, the rows are split into number of shorter stitches. Optimum length of the stitches is approximatelly 4
millimeters.

The easiest way of how to learn making of your own patterns is to examine pre-defined Studio patterns. Use ∎ main
menu > Gadgets > Fragment Editors to open Editor tool, select Patterns tab and open any pattern from PATTERNS
folder.

The colored dots or lines define place, where the fill stitch will be split.
Use primary mouse button to draw the dots and lines (with Shift key on hardware keyboard depressed).
Use primary mouse button with Ctrl key on hardware keyboard depressed to erase dots .

Note: if there is no hardware keyboard on your device, switch brush / eraser mode with button on the
splitter panel (J).

Position of cursor in the drawing area is indicated by small cross in the preview at the right side of the window. This
indicator helps to draw contiguous patterns.

Layers are used to create interleaved pattern. If there are 4 layers in the pattern, for example, each layer applies only to
the each 4th line of stitches. Consequently, final pattern looks like if there are all 4 layers interleaved.

Pattern with 4 layers. Each column of pixels belongs to different layer. The layer that is currently
edited is highlighted.



Pattern with 4 layers applied to rows of stitches. Needle points appear on places where stitches
cross the pattern pixels. Each layer (column in this case) applies only to the each 4th line of

stitches.

3D preview of stitches with pattern. The fill with interleaved pattern is flat.

Interleaved pattern produces a flat fill texture. For patterns with more puffy texture use single layer of pixels (no
interleaving).

Controls
Save Pattern . Use this command from pop-up menu to save pattern to disc. Patterns are automatically stored with
design with which they were created, so you need to save pattern only if you want to use it in other design.

Open Pattern . Use this command from pop-up menu to load some previously stored pattern into your design.

Clear Pattern . Use this command from pop-up menu to reset selected pattern.

Import Background image into background. Use this command from pop-up menu to open an image and use it as the
template when drawing the pattern.

Skew left and Skew right . Use any of these command from pop-up menu to modify the pattern. Sometimes a nice new
pattern can be created from existing one by just clicking any of these buttons.
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Custom Fill Motifs
Motifs are used to create fancy fill. They are aligned in a continuous formation so that they allow seamless, continuous
sewing.

Two motifs used as a fancy fill.

There is a number of pre-defined motifs included with Studio, but user can also create up to five custom fill motifs that
are saved with the design. Studio contains built-in editor of fill motifs that facilitates this task.

Motif Editor

Use ∎ main menu > Gadgets > Fragment Editors command to open window with available editors. Switch to
Motif Editor .

The meaning of controls in this window is following:

A Editor list. Motif editor is one of the custom editors available in Studio.



B Buttons Reset , Cancel or Apply changes made to the motif

C Combo box to select any of 5 custom motifs for editing

D Work Area . Draw your custom motif here.

E Motif Parameters : Width , Height , Shift

F Information Area : Cursor coordinates, warning messages, etc.

G Name of the Motif

H
Pop-Up Menu Button . Click this button to access pop-up menu with additional commands: Open and Save
Motif, Undo / Redo Changes, Import backgroung image , Clear Motif , Show / Hide background image ,
Snap to Grid , Flip Vertically , Start / Stop simulation of motif stitches

I List Splitter

J Splitter with Tools : Undo or Redo changes, Zoom-in and Zoom-out buttons, Insert Node and Delete Node
buttons

K Splitter

Controls
While meaning of many controls in editor window is self-explanatory, some require further clarification:

Start Simulation . Use this command from pop-up menu to run slow simulation of how motif stitches will be sewn.

Save Motif . Use this command from pop-up menu to store motif to the disc in order to transfer it to other design.

Open Motif . Use this command from pop-up menu to load motif saved previously from other design.

Clear . Use this command from pop-up menu to reset selected custom motif to a single stitch.

Import Background Image . Use this command from pop-up menu to open an image and use it as the template when
drawing the motif.

How to Draw New Motif
Motifs are small formations of stitches. They are made from single stitch by inserting nodes (needle points) between the
first and last point and moving them on the work area.

To examine predefined Studio motifs Open motif from PATTERNS folder.

To make a new motif, use combo box (C) to select some custom motif to edit. Initial form of custom motif is a single
stitch.

Preserving position of the first (S) and last (E) points ensures seamless connection of samples.

Let's create a new star-shaped motif:



New motif - initial stitch.

Insert 4 new nodes between the start (S) and end (E) point.

Four new nodes 1,2,3 and 4.

Move these nodes as depicted on below picture.

Nodes 1,2,3 and 4 moved in the work area.

Insert another 4 new nodes (X),(Y),(Z) and (W).



New nodes (X),(Y),(Z) and (W).

Move nodes (X),(Y),(Z) and (W) as shown on below picture.

Final layout of nodes.

Move overlap area node down.

Finished motif with overlap area.



Overlapped motif rows

Parameters
Motifs are applied by Studio so that they are projected into virtual cells windows inside the fill object. Proportion of these
windows is defined by Width and Height parameters.

Adjustable gray area on top and bottom of work area allows to define how much rows of motifs overlap each other.

Shift defines the mutual shift of motif rows when projected to a fill.

Motif rows with shift equal to half of the motif width
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Custom Outline Samples
Samples are used to create fancy outlines. They are aligned along the outline in a continuous sewing.

Samples are made so that they allow seamless, continuous connection.

Sample aligned continuously along the outline.

There is a number of pre-defined samples included with Studio, but user can also create up to five custom outline
samples that are saved with the design. Studio contains a built-in editor of samples that facilitates this task.



Sample Editor

Use ∎ main menu > Gadgets > Fragment Editors command to open window with available editors. Switch to
Sample Editor.

The meaning of controls in this window is following:

A Editor list. Sample editor is one of the custom editors available in Studio.

B Buttons :Reset,CancelorApplychanges made to the sample

C Combo box to select any of 5 custom samples for editing

D Work Area . Draw your custom sample here.

E Sample Parameters : Width , Length , Minimum Length , Transformation necesarry to Project sample
along outline

F Information Area : Cursor coordinates, warning messages, etc.

G Name of the Sample

H
Pop-Up Menu Button . Click this button to access pop-up menu with additional commands: Open and Save
Sample, Undo / Redo Changes, Import backgroung image , Clear Sample , Show / Hide background
image , Snap to Grid , Flip Vertically , Start / Stop simulation of sample stitches

I List Splitter

J Splitter with Tools : Undo or Redo changes, Zoom-in and Zoom-out buttons, Insert Node and Delete Node
buttons

K Splitter

Controls



While meaning of many controls in editor window is self-explanatory, some require further clarification:

Start Simulation . Use this command from pop-up menu to run slow simulation of how sample stitches will be sewn.

Save Sample . Use this command from pop-up menu to store sample to the disc in order to transfer it to other design.

Open Sample . Use this command from pop-up menu to load sample saved previously from other design.

Clear . Use this command from pop-up menu to reset selected custom sample to a single stitch.

Import Background Image . Use this command from pop-up menu to open an image and use it as the template when
drawing the sample.

Snap to Grid . Switch ON this option in pop-up menu if you want to nudge nodes and align them to the grid when
moving them in the work area.

How to Draw New Sample
Samples are small formations of stitches. They are made from single stitch by inserting nodes (needle points) between
the first and last point and moving them on the work area.

To examine pre-defined Studio samples Open sample from PATTERNS folder.

To make a new sample, use combo box (C) to select some custom sample to edit. Initial form of custom sample is a
single stitch.

Preserving position of the first (S) and last (E) points ensures seamless connection of samples.

New sample - initial stitch.

Insert new node by clicking the work area.



A node inserted between first and last point.

Insert another new node by clicking the work area. New node is added after the focused node.

Another node inserted. Sample is finished.

The new sample is finished. When you close the editor window, new sample will appear in the list of available samples in
parameters window for outlines . It will look like shown on picture below.

Continuous formation of samples projected along the line.

This sample is saved with current design. If you need to copy it to another design, use Save Sample command from the
pop-up menu to store it and when you open another design in Studio, load this sample from the storage.

Parameters
Samples are used by Studio so that they are projected into virtual cells along the outline or inside the fill. The size of
these cells is defined by Min. Length , Length and Width parameters.



Samples are projected into virtual cells of constant width and constant or variable length.
Variable length allows better fit to curve of outline.

Length is normal length of sample.

Min. Length defines the smallest cell length in curves. Set min. length to the same value as Length if you want constant
length of samples.

Width is width of sample.

Projection . When Studio projects samples into virtual cells, the sample is adjusted to place the first and last sample
point exactly onto the cell front and back edge. There are multiple ways of how to do this adjustment. User can select
which method will be used:

1. Stretch - whole sample is deformed (stretched) to fit into cell.
2. Add Jump - sample is not deformed, but jump stitch is added to its end.
3. Add Stitch - sample is not deformed, but running stitch is added to its end.

Stretch , Add Jump and Add Stitch methods to fit sample into cell.

Most of outline samples use Stretch method. Special outlines like "Candlewick" that should be composed of some not
deformed objects connected by jumps or running stitches use Add Jump or Add Stitch methods.
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Custom Outline Borders
Border is an outline object which is composed of pre-digitized objects (border fragments) instead of common single
stitches. Border can have outline of a separate color. There are several pre-defined border fragments available in Studio
and user can also define his/her own border fragments. This tutorial will guide you through process of creation of your
own border fragments and their use in your embroidery designs.



Various borders: simple border with 1 column object, complex leaf border with columns and
connections, rope border with outline.

How to Digitize Border Sample
Border elements (fragments) are small designs, which are like any other designs created in Studio. Therefore, we will
use Studio's main Work Area for creation of border fragments and not some editor window as it is in case of fill pattern or
motif creation. Border fragments have some limitations, though, and some Studio controls are disabled during creation of
border fragment, therefore.

To start creation of a new border fragment, click on ∎ main menu > Design > Border > New Border . Special
template for borders will appear in the Work Area and some Studio controls will be disabled.

Please note that border fragment can contain only Column, Column with Pattern, Outline and Connection
objects. Tools for creation of other objects are disabled.

Example 1 - Single Column Object

The first border example contains only one column object. Note that object fits into Border Cell window and it begins on
left side and ends on right side of the cell. Parallel direction of stitches on beginning and end of fragment ensures
contiguous stitching of border and connections between border fragments are not needed in this case.

Template for digitizing of border fragment

A Border Strip . Border fragment may exceed edges of Border Cell (B) left or right into the strip area. In such a
case, border fragments will overlap.

B Border Cell . The main body of border fragment is draw here.



C Start side of border . Exact place of start point or edge of the border fragment. Important to ensure
contiguous sewing.

D End side of border . Exact place of end point or edge of the border fragment. Important to ensure contiguous
sewing.

E Preview of how border fragments fit together

Border fragment in Object Inspector - single column object

To set name and default width and height of border fragment, select any object in the Work Area and then use
secondary mouse button click to access Parameters Window. Set Comment , Reference Width and Reference Height
parameters on the Whole Design Parameters tab.

When creation of border fragment is finished, use ∎ main menu > Design > Border > Save Border As to save
border to disc. Border is saved as a normal EOF file in compact format without image. If you want to edit border, use
∎ main menu > Design > Border > Open Border . Do not use common ∎ Design > Open command, because

there will be no template for border drawing.

Example 2 - Column Object with Outline

This border fragment contains column object and outline of another color. When compiling to stitches, Studio reorders
border objects so that outlines are sewn after all columns and connections. Therefore, it is useful to draw border
fragment so that columns sew without a trim and outlines sew without a trim too. Of course, there will be a trim between
columns and outlines, because outlines are of different color.

Short rope border.



Elements of rope border in Object Inspector. Colors are sorted. There is a trim before outlines.

Column object is drawn so that it exceeds the boundaries of the cell on left and right side. This is because the elements
of rope should overlap to prevent gaps in stitching. Because of the overlap, there must be connection object before
column object to ensure contiguous stitching of columns. Place beginning of connection anywhere, Studio will align it to
previous column when compiling all border fragments. End of connection must be connected to column object.

Rope fragment is composed of connection, column and outline

Rope fragment in Object Inspector

Contour is drawn so that its beginning is aligned to end of previous border fragment contour, if you imagine several
border fragments lined up one after another. See below picture how the the contour is drawn to make two or three layers
of stitches and to position beginning and end properly.



Contour of rope fragment allows contiguous connection. Start point is (S) and end point is (E).

Part of contour has 3 layers of stitches and the rest has 2 layers.

Example 3 - Column Objects with Connections

In this example the border fragment contains columns and connections. The most important is placement of first and
last connection, because they allow contiguous stitching of border. First connection begins on left side of the cell and last
connection ends on the opposite side of the cell. The rest of connections serve only for normal connection of column
objects within the fragment.



How to Utilize Border Samples

If Studio is still in creation of border fragment mode, save border to disc and start a normal new design with use of ∎
main menu > Design > New or open any of your existing designs.

To make custom border fragments available in Parameters window when digitizing design, you have to assign them
to User Borders list in Fragment Editors window.

Use ∎ main menu > Gadgets > Fragment Editors command and select User Borders . Click to focus any of 5
user defined border samples and load your own sample from the disc. Close the Fragment Editors window .

A List of Editors . Select User Borders Item

B Buttons to Reset, Cancel or Apply changes.

C Focused Border . Open Border and Reset Border commands from pop-up menu are applied to the focused
border.

D Pop-up Menu Button . Use pop-up menu to access Load Border and Reset Border commands.



E Splitter

Now your border fragments are linked to design file and they are available in borders list of
Outline Parameters window. You can use them for Outline objects in your design.
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Stitch Count Estimation
Commercial embroidery digitizers may need to estimate approximate stitch count of design they are going to digitize,
because price of the custom digitizing is often based on the design stitch count.

When artwork supplied for digitizing is a crisp raster image or photo, Studio allows to estimate the stitch count quickly
with use of the trace tool.

The idea behind using the trace tool for embroidery stitch count estimation is to auto-vectorize a rough probe design with
just a few clicks, generate the stitches and use their number as an estimation.

1. Import Raster Image
Import the raster image with artwork into Studio just as in the case of a genuine digitizing. You may resize the artwork to
the real size now or you may resize traced vector objects to the real size later. Anyway, the estimation makes sense only
when working with the real-size design.

To resize the raster image please use Edit Image window , which is accessible via ∎ main menu > Image > Tools >
Edit Image Window .

Artwork on a raster image

2. Trace the Design
Use the Trace tool (the magic wand) to pick individual artwork areas and convert them into objects filled with stitches.
Repeat this step until all areas are stitched.

The trace tool is located in the Tool Box panel.



Trace tool icon

Choose among available tracing styles like plain fill or column to trace respective areas in a similar manner as you
would digitize the genuine design.

Note : there is no need to produce perfect embroidery design with all small detail as this is only the estimation.

Traced vector objects filled with stitches

Note : when tracing overall fills under a small lettering or other small objects, use Ignore Openings setting to
make fill compact.



Traced vector objects filled with the stitches. Objects (A) and (B) are traced as plain fills with
'Ignore Openings' option. Objects (C) and (D) are traced as columns.

3. Set the Real Size
If you have not resized the image to the required size before the tracing, resize the traced vector objects now. Otherwise
the estimation will be wrong.

4. Generate the Stitches
Select all finished objects and generate the stitches .

The total stitch count of the design is displayed in the status bar of Studio. This value can be considered to be
estimated stitch count we are looking for.

Objects must be selected (1). The total stitch count of selected objects is displayed in the status
bar (2)

Note: where appropriate, an Auto Outliner tool can be used to add thin double-layered stitch outline to the
selected objects for better accuracy of the estimation process.


